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Introduction to the first edition

This is a book about embedded systems, introduced primarily through the application of three
PIC microcontrollers. Starting from an introductory level, the book aims to make the reader
into a competent and independent practitioner in the field of embedded systems, to a level
whereby he or she has the skills necessary to gain entry to professional practice in the
embedded world.

The book achieves its aims by developing the underlying knowledge and skills appropriate to
today’s embedded systems, in both hardware and software development. On the hardware side,
it includes in-depth study both of microcontroller design, and of the circuits and transducers to
which the microcontroller must interface. On the software side, programming in both
Assembler and C is covered. This culminates in the study and application of a Real Time
Operating System, representing the most elegant way that an embedded system can be
programmed.

The book is divided into introductory and concluding sections and three main parts, and
develops its themes primarily around three example PIC microcontrollers, which form the
basis of each part. These are the 16F84A, the 16F873A and the 18F242. It works through these
in turn, using each to develop the sophistication of the ideas introduced. Nevertheless, the book
should not be viewed just as a manual on PIC microcontrollers. Using these as the medium of
study, the main issues of embedded design are explored. The skills and knowledge acquired
through the study of this set of microcontrollers can readily be transferred to others.

A distinctive feature of the book is its combination of practical and theoretical. The vast
majority of topics are directly illustrated by practical application, in hardware or in program
simulation. Thus, at no point is there abstract theory presented without application. The main
project in the book is the Derbot AGV (Autonomous Guided Vehicle). This is a customisable
design, which can be used as a self-contained development platform. As an AGV it can be
developed into many different forms. It can also be adapted into plenty of other things as well,
for example a waveform generator, an electronic tape measure or a light meter. Before the
Derbot is introduced, use is made of a very simple project, the electronic ping-pong game. The
example projects can be built by the reader, with design information being given on the book’s
companion website. Alternatively, projects can simply be used as theoretical case studies.
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xxiv  Introduction to the first edition

This book is aimed primarily at second- or third-year undergraduate engineering or technology
students. It will also be of interest to the informed hobbyist, and parts to the practising
professional. Readers are expected to have a reasonable knowledge of electronics, equivalent
to, say, a first-year undergraduate course. This will include an understanding of the operation
of transistors and diodes, and simple analog and digital electronic subsystems. It is also
beneficial to have some knowledge of computer architecture, for example gained by an
introductory course on microprocessors.

Because the book moves in three distinct stages from the introductory to the advanced, it will
in general provide material for more than one course or module. The first six chapters can be
used for a short and self-contained one-semester course, covering an introduction to
microcontrollers and their programming in Assembler. The 16F84A is chosen as the example
for these chapters. It is an excellent introductory microcontroller, due to its simplicity.
Chapters 7-11 can form an intermediate course, using Assembler to program more complex
systems. This leads to a detailed knowledge of microcontroller peripherals and their use, as
exemplified by the 16F873A. Chapters 12-20 can then be used to form an advanced course,
working with C and the 18F242, and leading up to use of the RTOS. Alternatively, lecturers
may wish to ‘pick and choose’ in Chapters 7-20, depending on their preference for C or
Assembler, and their preference for the microcontroller used. Having worked through
Chapters 1-6, it is just possible to go directly to Chapter 12, thereby apparently skipping
Chapters 7-11. The detail of the middle chapters is missed, but this approach can also work.
Using C demands less detailed knowledge of the peripherals than is required if using
Assembler, and cross-reference is made to the middle chapters where it is needed.

Whatever sequence of reading is chosen, the reader is expected as a minimum to have ready
access to the Microchip MPLAB Integrated Development Environment, which is available on
the book’s companion website. This allows the example programs in the book to be simulated
and then modified and developed. Almost inevitably the book starts with some study of
hardware, so that the reader has a basic knowledge of the system that the software will run on.
To some extent the first few chapters, on PIC microcontroller architecture, represent a steep
learning curve for the beginner. The fun then starts in Chapter 4, when programming and
simulation can begin. From here, with the foundations laid, hardware and software run more or
less in parallel, each gaining in sophistication and complementing the other. For the final third
of the book, the Microchip C18 C compiler should be used. The student version of this is also
available on the book’s companion website. For Chapter 19, the ‘Lite’ version of the Salvo
RTOS can be installed, again from the book’s companion website.

Beyond program simulation, it is hoped that the reader has access to electronic build and test
facilities, whether at home, college, university or workplace. With these, it is possible to build
up some of the example project material or work on equivalent systems. By so doing, the

satisfaction of actually implementing real embedded systems will be achieved. When working
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through the middle or later chapters, the best thing a lecturer or instructor can do is to get

a Derbot printed circuit board into the hands of every student on the course, along with a basic
set of components. Guide them through initial development and then give them suggestions for
further customisation. It is wonderful what ideas they then come up with. Design details are on
the book’s companion website.

An essential skill of any professional designer in this field is the ability to work with the
manufacturer’s data sheets. These are the main source of information when designing with
microcontrollers and the ultimate point of reference in the professional world. It is in general
not desirable to work from intermediate drawings by a third party, even if these are meant to
simplify the information. Therefore, this book unashamedly uses (with permission) a large
number of diagrams straight from the Microchip data sheets. Many are made more accessible
by the inclusion of supplementary labelling. The reader is encouraged to download the full
version of the data sheet in use and to refer directly to it.

A complete knowledge of the field of embedded systems requires both breadth and depth. This
is particularly true of embedded systems, which combine elements of hardware and software,
semiconductor technology, analog and digital electronics, computer architecture, sensors and
actuators, and more. With its focus on the PIC microcontroller this book cannot cover all these
areas. For the wider contextual background, the author’s earlier book. An Introduction to the
Design of Small-Scale Embedded Systems, is recommended. With whole chapters on memory
technology, power supply, numerical algorithms, interfacing to tranducers and the design
process, it provides a ready complement to this book.

I hope that you enjoy working through this book. In particular I hope you go on to enjoy the
challenge and pleasure of designing and building embedded systems.

Tim Wilmshurst
University of Derby,UK
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It was not so long after the first edition that the need for a second edition began to be felt.
Embedded technology was moving fast, and Microchip had come up with a whole set of new
16- and 32-bit microcontrollers, just as the first edition was being finalised. Big developments
were meanwhile taking place in the 8-bit field, for example with the increasing application of
nanoWatt technology and more advanced peripherals.

This edition has the same starting point as the first edition, but aims to include some

recent developments. The awkward question arises: what microcontrollers do we use as
examples — the newest or the easiest to grasp? I took the choice to stick with the old favourite,
the 16F84 A, as the first example device. This makes such a good and simple starting point that it
is hard to beat, even with a more recent product. From here the path moves to the larger but still
well-established 16 Series microcontroller, the 16F873A. This launches us into larger
microcontrollers and the many interesting issues surrounding their peripherals. So far, things
are similar to the first edition, though with more detail on introductory programming. The book
then takes in advances seen in two rather recent 16 Series microcontrollers, the 16F88 and
16F883. These are used to introduce, among other things, the important topics of low-power
technology and more advanced oscillator design. The chapters using the C programming
language are then based on the 18F2420, replacing the 18F242 of the earlier edition. The final
chapter is new, giving an introduction to the Microchip 16- and 32-bit microcontrollers.

Much of the book continues to use the Derbot Autonomous Guided Vehicle as its main design
example. As before, the book can be read with complete benefit whether or not a build is
completed. In the past few years at Derby University we have seen several generations of the
Derbot spring to life, and kits have been sent to different parts of the world. A host of variations
and refinements have thus appeared, many reported on the book’s companion web site:
www.elsevierdirect.com/companions/9781856177504.

To conclude, I simply repeat the end of the introduction to the first edition: I hope that you
enjoy working through this book. In particular I hope you go on to enjoy the challenge
and pleasure of designing and building embedded systems.

Tim Wilmshurst
University of Derby.
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Note to Instructors

End of chapter questions are included for chapters 1-3, 6-13, and 21.

Chapters 4, 5 and 14-20 include programming exercises and tutorials within the chapter and
no further questions are set for these chapters.
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Section 1
Getting Started with Embedded Systems

This preliminary chapter introduces embedded systems and the microcontroller,
leading to a survey of the Microchip range of PIC microcontrollers.



Tiny computers, hidden control

We are living in an age of information revolution, with computers of astonishing power
available for our use. Computers find their way into every realm of activity. Some are de-
veloped to be as powerful as possible, without concern for price, for high-powered applications
in industry and research. Others are designed for the home and office, less powerful but also
less costly. Another category of computer is little recognised, partly because it is little seen.
This is the type of computer that is designed into a product, in order to provide its control. This
computer is hidden from view, such that the user often doesn’t know it’s even there. This sort of
product is called an embedded system, and it is what this book is about. These little computers
we generally call microcontrollers; it is one extended family of these that this book studies.

In this chapter you will learn about:
e The meaning of the term ‘embedded system’.
e The microcontroller which lies at the heart of the embedded system.

e The Microchip PIC family.

An early PIC microcontroller, the 12F508.

1.1 The main idea - embedded systems in today’s world

1.1.1 What is an embedded system?

The basic idea of an embedded system is a simple one. If we take any engineering product that
needs control, and if a computer is incorporated within that product to undertake the control,
then we have an embedded system. An embedded system can be defined as [Ref. 1.1]:

A system whose principal function is not computational, but which is controlled by a computer
embedded within it.

These days embedded systems are everywhere, appearing in the home, office, factory, car or
hospital. Table 1.1 lists some example products that are likely to be embedded systems, all
chosen for their familiarity. While many of these examples seem very different from each other,
they all draw on the same principles as far as their characteristics as embedded systems are
concerned.

Designing Embedded Systems with PIC Microcontrollers; ISBN: 9781856177504
Copyright © 2010 Tim Wilmshurst. All rights of reproduction, in any form, reserved.
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4  Chapter 1

TABLE 1.1 Some familiar examples of embedded systems

Home Office and commerce Motor car

Washing machine Photocopier Door mechanism
Fridge Checkout machine Climate control
Burglar alarm Printer Brakes

Microwave Scanner Engine control
Central heating controller In car entertainment

Toys and games

The vast majority of users will not recognise that what they are using is controlled by one or
more embedded computers. Indeed, if they ever saw the controlling computer they would
barely recognise it as such. Most people, after all, recognise computers by their screen,
keyboard, disc drives and so on. These embedded computers would have none of those.

1.2 Some example embedded systems

Let’s take a look at some example embedded systems, first from everyday life and then from
the projects used to illustrate this book.

1.2.1 The domestic refrigerator

A simple domestic refrigerator is shown in Figure 1.1. It needs to maintain a moderately
stable, low internal temperature. It does this by sensing its internal temperature and comparing
it with the temperature required. It lowers the temperature by switching on a compressor. The
temperature measurement requires one or more sensors, and then whatever signal conditioning
and data acquisition circuitry that is needed. Some sort of data processing is required

to compare the signal representing the measured temperature to that representing the required
temperature and deduce an output. Controlling the compressor requires some form of

Compressor control 4_\‘

Alarm

Display Human
The interaction
embedded
computer
Networked
K > interaction

Actual temperature (maybe!)

Required temperature

Figure 1.1: Embedded system example 1: the refrigerator
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electronic interface, which accepts a low-level input control signal and then converts this to the
electrical drive necessary to switch the compressor power.

This process of control can be done by a conventional electronic circuit or it can be done by
a small embedded computer. If used, the embedded computer could be designed simply to
replicate the minimalist control process described above. Once a little computer is in place,
however, there is tremendous opportunity for ‘added value’. With the signal in digital form and
processing power now readily available, it is an easy step to add features like intelligent
displays, more advanced control features, a better user control mechanism and so on.

Taking the idea of added value one step further, once an embedded computer is in place it is
possible to network it to other computers, embedded or otherwise. This opens up wide new
horizons, allowing a small system to become a subset of a much larger system and to share
information with that system. This is now happening with domestic products, like the
refrigerator, as well as much more complex items.

The diagram of Figure 1.1, while specific to a fridge, actually represents very well the overall
concept of an embedded system. There is an embedded computer, engaged in reading internal
variables, and outputting signals to control the performance of the system. It may have human
interaction (but in general terms does not have to) and it may have networked interaction.
Generally, the user has no idea that there’s a computer inside the fridge!

1.2.2 A car door mechanism

A very different example of an embedded system is the car door, as shown in Figure 1.2.
Once again there are some sensors, some human interaction and a set of actuators that must
respond to the requirements of the system. One set of sensors relates to the door lock and
another to the window. There are two actuators, the window motor and the lock actuator.

_ Window control buttons
Window stall sensor

1
ol

Open door sensor

Window motor

Lock control
Lock actuator

Figure 1.2: Embedded system example 2: the car door
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It might appear that a car door could be designed as a self-contained embedded system, in
a similar way to the fridge. Initially, one might even question whether it is worthy of any form
of computer control whatsoever, as the functions seem so simple. Once again, by creating it as
an embedded system, we see the opportunity to enhance functionality. Now we have the door
status and actuators under electronic control, they can be integrated with the rest of the car.
Central locking can be introduced or an alarm sounded if the door is not locked when the driver
tries to pull away. There is therefore considerable advantage in having a network which links
the humble actions of the door control to other functions of the car. We will see in later
chapters that networked interaction is an important feature of the embedded system.

1.2.3 The electronic ‘ping-pong’ game

This little game, shown in Figure 1.3, is one of several projects used to illustrate the material of
this book. It is a game for two players, who each have a push-button ‘paddle’. Either player can
start the game by pressing his/her paddle. The ball, represented by the row of eight LEDs

(light-emitting diodes), then flies through the air to the opposing player, who must press his
paddle only when the ball is at the end LED and at no other time. The ball continues in play
until either player violates this rule. Once this happens, the non-violating player scores and the
associated LED is briefly lit up. When the ball is out of play, an ‘out-of-play’ LED is lit.

All the above action is controlled by a tiny embedded computer, a microcontroller, made by
a company called Microchip [Ref. 1.2]. It takes the form of an 18-pin integrated circuit (IC), and
has none of the visible features that one would normally associate with a computer. Never-
theless, electronic technology is now so advanced that inside that little IC there are a Central
Processing Unit (CPU), a complex array of memories, and a set of timing and interface circuits.
One of the memories contains a stored program, which it executes to run the game. It is able to
read in as inputs the positions of the switches (the player paddles) and calculate the required
LED positions. It then has the output capability to actually power the LEDs to which it is
connected. All of this computing action is powered from only two AAA cells!

The embedded computer,
a Microchip 16LF84A

On/off m[tﬁ

switch ) Jf .
‘ - -@ : : -

Player 1 paddle ‘ Player 2
‘Score’ LED]  |Ball flight LEDs|  [‘Out of play’ LED| paddle

Figure 1.3: The electronic ‘ping-pong’ game
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Figure 1.4: A Derbot Autonomous Guided Vehicle

1.2.4 The Derbot Autonomous Guided Vehicle

Another project used later in this book is the Derbot Autonomous Guided Vehicle (AGV),
pictured in Figure 1.4. How do its features compare with the examples seen thus far?
Looking at the photograph, we can see from the front that it bristles with sensors and ac-
tuators. Two microswitch bump detectors sense if the Derbot hits an obstacle. An ultrasound
detector, mounted on a servo actuator, is there with the aim of ensuring that the Derbot never
has an unexpected collision! Two light sensors on either side of the servo are used for light
tracking applications; a third, not seen in the photo, is mounted at the rear. A further
navigational option is a compass, so that direction can be determined from the earth’s
magnetic field. Locomotion is provided by two geared DC motors, while a sensor on each
(again not seen in this picture) counts wheel revolutions to calculate actual distance moved.
Steering is achieved by driving the wheels at different speeds. A piezo-electric sounder is
included for the AGV to alert its human user. The Derbot is powered from six AA alkaline
cells, which it carries on a power pack almost directly above its wheels. Its block diagram is
shown in Figure 1.5.

As with earlier examples, the Derbot operates as an embedded system, reading in values from
its diverse sensors and computing outputs to its actuators. It is controlled by another Microchip
microcontroller, hidden from view in the picture by the battery pack. This microcontroller is
seemingly more powerful than the one in the ping-pong game, as it needs to interface with far
more inputs and drive its outputs in a more complex way.
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Bump Sensor

Pulse

Ultrasound
Ranging

Module

Echo

5V

Left
Light Sensor
Left
Light Sensor
Rear
__’|__— Power
| Regulation &
— Management
T |
WV
Alkaline

Interestingly, as we shall see, the CPU of each microcontroller is the same. They are differ-
entiated primarily by their interface capabilities. It is this difference that gives the Derbot

WV

Analog to Digital
Converter

PIC

Microcontroller

Bump Sensor

Motor
Left

Motor Drive
Interface

Right
Light Sensor
Right
Ultrasound
Servo
Serial Data
Compass
Serial
Clock
o

Serial Extension Bus

Stream x2

Motor
Right

Figure 1.5: The Derbot block diagram

microcontroller its far greater power.

1.3 Some computer essentials

When designing embedded systems we usually need to understand in some detail the features
of the embedded computer that we are working with. This is quite unlike working with

a desktop computer used for word processing or computer-aided design, where the internal
workings are skilfully hidden from the user. As a preliminary to developing our knowledge, let

us undertake a rapid survey of some important computer features.

Pulse Width Modulation
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The Central
outside ” Processing
world Unit (CPU)
Program
memory

-/

Figure 1.6: Essentials of a computer
1.3.1 Elements of a computer

Figure 1.6 shows the essential elements of any computer system. Fundamentally, it must be
able to perform arithmetic or logical calculations. This function is provided by the Central
Processing Unit (CPU). It operates by working through a series of instructions, called a pro-
gram, which is held in its memory. Any one of these instructions performs a very simple
function. However, because the typical computer runs so incredibly fast, the overall effect is
one of very great computational power. Many instructions cause mathematical and logical
operations to occur. These take place in a part of the CPU called the ALU, the Arithmetic
Logic Unit.

To be of any use the computer must be able to communicate with the outside world, and it does
this through its input/output. On a personal computer this implies human interaction, through
the keyboard, VDU (Visual Display Unit) and printer. In an embedded system the commu-
nication is likely to be primarily with the physical world around it, through sensors and
actuators.

The computer revolution that is taking place is due not only to the incredible processing power
now at our disposal, but also to the equally incredible ability that we now have to store and
access data. Broadly speaking there are two main applications for memory in a computer, as
shown in Figure 1.6. One type of memory holds the program that the computer will execute.
This memory needs to be permanent. If it is, then the program is retained indefinitely, whether
power is applied or not, and it is ready to run as soon as power is applied. The other type of
memory is used for holding temporary data, which the program works on as it runs. This
memory type need not be permanent, although there is no harm if it is.

Finally, there must be data paths between each of these main blocks, as shown by the block

arrows in the diagram.

1.3.2 Instruction sets — the Complex Instruction Set Computer and the Reduced
Instruction Set Computer

Any CPU has a set of instructions that it recognises and responds to; all programs are built up
in one way or another from this instruction set. We want computers to execute code as fast as
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possible, but how to achieve this aim is not always an obvious matter. One approach is to build
sophisticated CPUs with vast instruction sets, with an instruction ready for every foreseeable
operation. This leads to the CISC, the Complex Instruction Set Computer. A CISC has many
instructions and considerable sophistication. Yet the complexity of the design needed to
achieve this tends to lead to slow operation. One characteristic of the CISC approach is that
instructions have different levels of complexity. Simple ones can be expressed in a short in-
struction code, say one byte of data, and execute quickly. Complex ones may need several
bytes of code to define them and take a long time to execute.

Another approach is to keep the CPU very simple and have a limited instruction set. This
leads to the RISC approach — the Reduced Instruction Set Computer. The instruction set, and
hence overall design, is kept simple. This leads to fast operation. One characteristic of the
RISC approach is that each instruction is contained within a single binary word. That word
must hold all information necessary, including the instruction code itself, as well as any
address or data information also needed. A further characteristic, an outcome of the sim-
plicity of the approach, is that every instruction normally takes the same amount of time to
execute.

1.3.3 Memory types
Traditionally, memory technology has been divided into two categories:

e Volatile. This is memory that only works as long as it is powered. It loses its stored value
when power is removed, but can be used as memory for temporary data storage. Gen-
erally, this type of memory uses simple semiconductor technology and is easier to write
to from an electrical point of view. For historical reasons it has commonly been called
RAM (Random Access Memory). A slightly more descriptive name is simply ‘data
memory’.

e Non-volatile. This is memory that retains its stored value even when power is removed.
On a desktop computer this function is achieved primarily via the hard disk, a huge
non-volatile store of data. In an embedded system it is achieved using non-volatile
semiconductor memory. It is a greater challenge to make non-volatile memory, and
sophisticated semiconductor technology is applied. Generally, this type of memory has
been more difficult to write to electrically, for example in terms of time or power taken,
or complexity of the writing process. Non-volatile memory is used for holding the
computer program and for historical reasons has commonly been called ROM
(Read-Only Memory). A more descriptive name is ‘program memory’.

With the very sophisticated memory technology that is now available, we will see that the
division of function between these two memory categories is becoming increasingly blurred.
We return to the issue of memory technology and its applications in Chapter 2.
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Figure 1.7: Organising memory access. (a) The Von Neumann way. (b) The Harvard way

1.3.4 Organising memory

To interact with memory, there must be two types of number moved around: the address of the
memory location required and the actual data that belongs in the location. These are connected
in two sets of interconnections, called the address bus and the data bus. We must ensure that
the data bus and address bus (or a subset of it) reach every memory area.

A simple way of meeting the need just described is shown in Figure 1.7(a). It is called the Von
Neumann structure or architecture, after its inventor. The computer has just one address bus
and one data bus, and the same address and data buses serve both program and data memories.
The input/output may also be interconnected in this way and made to behave like memory as
far as the CPU is concerned.

An alternative to the Von Neumann structure is seen in Figure 1.7(b). Every memory area gets
its own address bus and its own data bus. Because this structure was invented in the university
of the same name, this is called a Harvard structure.

The Von Neumann structure is simple and logical, and gives a certain type of flexibility. The
addressable memory area can be divided up in any way between program memory and data
memory. However, it suffers from two disadvantages. One is that it is a ‘one size fits all’
approach. It uses the same data bus for all areas of memory, even if one area deals with large
words and another deals with small. It also has the problem of all things that are shared. If one
person is using it, another can’t. Therefore, if the CPU is accessing program memory, then data
memory must be idle and vice versa.

In the Harvard approach we get greater flexibility in bus size, but pay for it with a little more
complexity. With program memory and data memory each having their own address and data
buses, each can be a different size, appropriate to their needs, and data and program can be
accessed simultaneously. On the minus side, the Harvard structure reinforces the distinction
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between program and data memory, even when this distinction is not wanted. This disad-
vantage may be experienced, for example, when data is stored in program memory as a table,
but is actually needed in the data domain.

1.4 Microprocessors and microcontrollers

1.4.1 Microprocessors

The first microprocessors appeared in the 1970s. These were amazing devices, which for the
first time put a computer CPU onto a single IC. For the first time, significant processing power
was available at rather low cost, in a comparatively small space. At first, all other functions,
like memory and input/output interfacing, were outside the microprocessor, and a working
system still had to be made of a good number of ICs. Gradually, the microprocessor became
more self-contained, with the possibility, for example, of including different memory types on
the same chip as the CPU. At the same time, the CPU was becoming more powerful and faster,
and moved rapidly from 8-bit to 16- and 32-bit devices. The development of the micropro-
cessor led very directly to applications like the personal computer.

1.4.2 Microcontrollers

While people quickly recognised and exploited the computing power of the microprocessor,
they also saw another use for them, and that was in control. Designers started putting micro-
processors into all sorts of products that had nothing to do with computing, like the fridge or the
car door that we have just seen. Here the need was not necessarily for high computational power,
huge quantities of memory, or very high speed. A special category of microprocessor emerged
that was intended for control activities, not for crunching big numbers. After a while this type of
microprocessor gained an identity of its own, and became called a ‘microcontroller’. The
microcontroller took over the role of the embedded computer in embedded systems.

So what distinguishes a microcontroller from a microprocessor? Like a microprocessor,

a microcontroller needs to be able to compute, although not necessarily with big numbers. But it
has other needs as well. Primarily, it must have excellent input/output capability, for example so
that it can interface directly with the ins and outs of the fridge or the car door. Because many
embedded systems are both size- and cost-conscious, the microcontroller must be small, self-
contained and low cost. Further, it will not sit in the nice controlled environment that a conven-
tional computer might expect. No, the microcontroller may need to put up with the harsh condi-
tions of the industrial or motor car environment, and be able to operate in extremes of temperature.

A generic view of a microcontroller is shown in Figure 1.8. Essentially, it contains a simple
microprocessor core, along with all necessary data and program memory. To this it adds all the
peripherals that allow it to do the interfacing it needs to do. These may include digital and
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Figure 1.8: A generic microcontroller

analog input and output, or counting and timing elements. Other more sophisticated functions
are also available, which you will encounter later in the book. Like any electronic circuit the
microcontroller needs to be powered, and needs a clock signal (which in some controllers is
generated internally) to drive the internal logic circuits.

1.4.3 Microcontroller families

There are thousands of different microcontroller types in the world today, made by numerous
different manufacturers. All reflect in one way or another the block diagram of Figure 1.8.

A manufacturer builds a microcontroller ‘family’ around a fixed microprocessor core. Different
family members are created by using the same core, including with it different combinations of
peripherals and different memory sizes. This is shown symbolically in Figure 1.9. This
manufacturer has three microcontroller families, each with its own core. One core might be
8-bit with limited power, another 16-bit and another a sophisticated 32-bit machine. To each
core are added different combinations of peripherals and memory size, to make a number of
family members. Because the core is fixed for all members of one family, the instruction set is
fixed and users have little difficulty in moving from one family member to another.

While Figure 1.9 suggests only a few members of each family, in practice this is not the case;
there can be more than 100 microcontrollers in any one family, each one with slightly different
capabilities and some targeted at very specific applications.

1.4.4 Microcontroller packaging and appearance

Integrated circuits are made in a number of different forms, usually using plastic or ceramic as
the packaging material. Interconnection with the outside world is provided by the pins on the
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Figure 1.9: A manufacturer’s microcontroller portfolio

package. Where possible microcontrollers should be made as physically small as possible, so it
is worth asking: what determines the size? Interestingly, it is not usually the size of the IC chip
itself, in a conventional microcontroller, which determines the overall size. Instead, this is set
by the number of interconnection pins provided on the IC and their spacing.

It is worth, therefore, pausing to consider what these pins carry in a microcontroller. The point
has been made that a microcontroller is usually input-/output-intensive. It is reasonable then to
assume that a good number of pins will be used for input/output. Power must also be supplied
and an earth connection made. It is reasonable to assume for the sort of systems we will be
looking at that the microcontroller has all the memory it needs on-chip. Therefore, it will not
require the huge number of pins that earlier microprocessors needed, simply for connecting
external data and address buses. It will, however, be necessary to provide pin interconnections
to transfer program information into the memory and possibly provide extra power for the
programming process. There is then usually a need to connect a clock signal, a reset and
possibly some interrupt inputs.

Figure 1.10, which shows a selection of microprocessors and microcontrollers, demonstrates
the stunning diversity of package and size that is available. On the far right, the massive
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Figure 1.10: A collection of microprocessors and microcontrollers - old and new. From left to right:
PIC 12F508, PIC 16F84A, PIC 16C72, Motorola 68HC705B16, PIC 16F877, Motorola 68000

(and far from recent) 64-pin Motorola 68000 dwarfs almost everything else. Its package is
a dual-in-line package (DIP), with its pins arranged in two rows along the longer sides of the
IC, the pin spacing being 0.1 inches. Because the 68000 depends on external memory, many
of its pins are committed to data and address bus functions, which forces the large size.
Second from right is the comparatively recent 40-pin PIC 16F877. While this looks similar to
the 68000, it actually makes very different use of its pins. With its on-chip program and data
memory it has no need for external data or address buses. Its high pin count is now put to
good use, allowing a high number of digital inputs/outputs and other lines. In the middle is
the 52-pin Motorola 68HC705. This is in a square ceramic package, windowed to allow the
on-chip EPROM (Erasable Programmable Read-Only Memory) to be erased. The pin spacing
here is 0.05 inches, so the overall IC size is considerably more compact than the 68000, even
though the pin count is still high. To the left of this is a 28-pin PIC 16C72. Again, this has
EPROM program memory and thus is also in a windowed ceramic DIP package. On the far
left is the tiny 8-pin surface-mounted PIC 12F508 and to the right of this is an 18-pin PIC
16F84A.

1.5 Microchip and the PIC microcontroller

1.5.1 Background

The PIC was originally a design of the company General Instruments. It was intended for
simple control applications, hence the name — Peripheral Interface Controller. In the late 1970s
General Instruments produced the PIC 1650 and 1655 processors. Although the design was
comparatively crude and unorthodox, it was completely stand-alone, and contained some
important and forward-looking features. The simple CPU was a RISC structure, with a single
Working register and just 30 instructions. The output pins could source or sink much more
current than most other microprocessors of the time. Already the trademark characteristics of
the PIC were emerging — simplicity, stand-alone, high speed and low cost.
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General Instruments sold off its semiconductor division to a group of venture capitalists, who
must have realised the immense potential of these odd little devices. Throughout the 1990s the
range of available PIC microcontrollers grew, and as they did they gradually overtook many of
their better-established competitors. In many cases PIC microcontrollers could run faster,
needed a simpler chip-set and were quicker to prototype with than their competitors. Despite
the huge advances that were made, however, it was still possible to see features of the old
General Instruments microcontroller. Unlike many competitors, Microchip made their de-
velopment tools simple and low-cost or free. Moreover, Microchip stayed for a long while
firmly entrenched in the 8-bit world. It has only been in the past few years that they have
branched out beyond 8-bit devices. This book remains primarily concerned with the 8-bit PIC
devices, as these provide such a useful entry into the world of embedded systems. The 16- and
32-bit Microchip devices will, however, be surveyed in Chapter 21.

1.5.2 PIC 8-bit microcontrollers today

Without looking any wider than the range of 8-bit PIC microcontrollers today, anyone can be
forgiven for a sense of bewilderment. There are hundreds of different devices, offered in
different packages, for different applications. Let us therefore try to identify the characteristics
that all of these have in common. At the time of writing, all 8-bit PIC microcontrollers are low-
cost, self-contained, pipelined, RISC, use the Harvard structure, have a single accumulator (the
Working, or W, register), with a fixed reset vector.

Today, Microchip offer 8-bit microcontrollers with four different prefixes, 10-, 12-, 16-, and
18-, for example 10F200, or 18F242. In this book we shall call each of these a ‘Series’, for
example ‘12 Series’, ‘16 Series’, ‘18 Series’. A 17 Series has been discontinued; a few are still
sold, but most will only be found in legacy systems. Each Series is identified by the first two
digits of the device code. The alphabetic character that follows gives some indication of the
technology used. The ‘C’ insert implies CMOS technology, where CMOS stands for Com-
plementary Metal Oxide Semiconductor, the leading semiconductor technology for imple-
menting low-power logic systems. The ‘F’ insert indicates incorporation of Flash memory
technology (still using CMOS as the core technology). An ‘A’ after the number indicates a tech-
nological upgrade on the first issue device. An ‘X’ indicates that a certain digit can take a number
of values, the one taken being unimportant to the overall number quoted. For example, the 16C84
was the first of its kind. It was later reissued as the 16F84, incorporating Flash memory technology.
It was then reissued as the 16F84A, with certain further technological upgrades.

While it is reasonable to expect that each Series defines a distinct architecture, in fact it is more
useful to classify them into three distinct groups, using Microchip terminology, as shown in
Table 1.2. In this book we shall refer to each of these groups as ‘families’. What complicates
the picture, as the table shows, is that in some cases microcontrollers of one Series can fall into
more than one family. For example some 12 Series microcontrollers are baseline, others are
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TABLE 1.2 Comparison of 8-bit PIC families

Instruction Stack size Number of

Family Example devices word size (words) instructions Interrupt vectors
Baseline 10F200, 12F508, 12 bit 2 33 None

16F57
Mid range 12F609, 16F84A, 14 bit 8 35 1

16F631, 16F873A
High 18F242, 18F2420 16 bit 32 75, including 2 (prioritised)
Performance hardware multiply

mid-range. This is a complexity we must learn to live with, and which actually will cause us
little difficulty.

Following the pattern of Figure 1.9, every member of any one family shares the same core
architecture and instruction set. The processing power is defined to some extent by the
parameters quoted, for example the instruction word size, and the number of instructions. It is
possible to see clear evolution from one family to the next, so knowledge of one readily leads
to knowledge of another. The families will be described in further detail below.

The baseline family of PIC microcontrollers

The baseline PIC microcontroller family represents the most direct descendant of the General
Instruments ancestors, and displays the core features of the original PIC design. The first
Microchip baseline microcontrollers were coded 16C5X, following the General Instruments
1650 and 1655 numbering. Now, however, there are also 10 and 12 Series microcontrollers
which fall into this category. With only a two-level stack and no interrupts, there are real limits
to the program and hardware complexity that can be developed. For example, without in-
terrupts there is restriction on the type of on-chip peripheral that can be included, as most
peripherals use interrupts to enhance their interface with the CPU.

Baseline devices are ideal for really tiny applications, being packaged in small ICs (right down
to only six pins, for example). Despite their small size and simple architecture, baseline
microcontrollers carry some interesting peripherals, including analog-to-digital converters and
EEPROM (Electrically Erasable Programmable Read-Only Memory) data memory.

Baseline devices include all of the 10 Series, and some of the 12 Series. There is strong interest
in this end of the size range, and further additions to the family can be expected.

The PIC mid-range family

The mid-range family contains several simple but important developments, when compared to
the baseline devices. Interrupts (albeit with a single interrupt vector) are introduced and
the stack size is increased. The instruction set is a slight extension of the baseline set.
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The introduction of interrupts allows interfacing both with more sophisticated peripherals and
with larger numbers of peripherals.

Mid-range devices include all of the 16 Series except those coded 16C5XX or 16F5XX, and
some of the 12 Series. A very wide range has been developed, with many different peripherals
and technical enhancements. The larger devices, with multiple peripherals and significant
on-chip memory, are both powerful and versatile.

The high-performance family

In this family Microchip has come to grips with some of the issues of sophisticated processors.
The instruction set is significantly increased, now to 75 instructions, and is designed to
facilitate use of the C programming language. In certain versions there is also an ‘extended’
instruction set, with a further small set of instructions. There are two interrupt vectors, which
can be prioritised.

The high-performance family is made up only of 18 Series microcontrollers. It is a powerful
family and new members are continuously being added to the range.

1.6 An introduction to PIC microcontrollers
using the Baseline Series

As the simplest of the PIC microcontroller types, this is a useful family with which to in-
troduce the range. The features identified here will be recognisable in the more advanced PIC
microcontrollers, where they appear alongside the more advanced features that have been
added.

We will look at the PIC 12F508/509, the pin connection diagram of which is shown in
Figure 1.11. The only difference between the 508 and 509 is that the latter has slightly larger

Voo —={1 g 8 [ J— vVss
GP5/0SC1/CLKIN <a—»-[]2 § 7[J<e—~ GPO/ICSPDAT
GP4/0SC2<e—»{|3 [P 6[]<e—» GP1/ICSPCLK
e—— N
GP3MCLRVPP —{|4 & 5[}« GP2/TOCKI
[
Key
Vop: Power supply Vg Ground
Vpp: Programming voltage input MCLR: Master clear
OSC1, OSC2: Oscillator pins CLKIN: External clock input

GPO to GP5: General Purpose input/output

pins (bidirectional except GP3)
CSPDAT: In Circuit Serial Programming™ data pin.
CSPCLK: In Circuit Serial Programming™ clock pin.

Figure 1.11: PIC 12F508/509 pin connection diagram
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Figure 1.12: How small is a 12F508?!

program and data memories. Most (if not all) labels on the pins in the diagram may initially
make no sense — don’t worry; their meanings will emerge.

The staggeringly small size of this microcontroller is reinforced in Figure 1.12. While the
12F508 has been chosen as a simple microcontroller for introductory purposes, we also
need to recognise that we are also almost looking at a conjuring trick. Remember that it
has been said earlier that a microcontroller should be input-/output-intensive. Then con-
sider: how can a microcontroller be useful if it has only eight pins interconnecting with the
outside world? We will attempt to answer this question as we look at the microcontroller’s
architecture.

1.6.1 The architecture of the 12F508

The annotated block diagram of the 12F508 appears in Figure 1.13. This may be the first
Microchip diagram that you have ever looked at. Don’t worry if it initially appears complex —
we will aim to break it into digestible pieces.

Let’s start by finding the microcontroller essentials identified in Figure 1.8: the core
(containing the CPU), program memory, data memory (or RAM), data paths and any
peripherals. We should be able to relate some of these features to the microcontroller pins of
Figure 1.11.

The CPU, enclosed in a dotted line bottom right, is made up essentially of the ALU, the
Working register (W Reg) and the Status register. This register carries a number of bits that
give information on the outcome of the instruction most recently carried out. A multiplexer
(MUX) selects from two sources which data is presented to the ALU.

The data memory is just 25 bytes for the 508 or 41 for the 509. Notice that Microchip call the
RAM memory locations ‘file registers’ or elsewhere just ‘registers’. Program memory appears
top left, with 512 12-bit words for the 12F508 or 1024 for the 509.

A distinctive feature of the PIC architecture is that it is Harvard structure, as discussed above.
We should therefore be able to find fwo address buses (one for program memory, and the other
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Figure 1.13: PIC12F508/509 block diagram (supplementary labels in shaded boxes added by the
author). The 12F508 has the smaller Program Memory and RAM

for data memory and all peripherals) and two data buses (again, one for program memory, and
one for data memory and peripherals). The easiest to find is the data bus for data memory and
peripherals. This is simply labelled ‘data bus’ and is seen to the right of the diagram. It is 8-bit,
and primarily serves the data memory, the General-Purpose Input/Output (GPIO) and the
“Timer O’ peripheral. The address bus for data memory is labelled ‘RAM Addr’ and feeds into
the RAM data memory. It is derived from the address multiplexer (‘Addr MUX”), which
selects the address from one of two sources.

The program address bus arises from the Program Counter and goes only to the program
memory, as shown. It is 12-bit, and hence can address 212 memory locations, or 4096 locations.
As the program memory itself is given as only 512 or 1024 words, we recognise that the
address bus is larger than necessary for this memory size. Coming from the program memory
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we see the 12-bit ‘Program bus’. This carries the instruction words from the memory to the
‘Instruction register’.

It is interesting to track the way the instruction word from the program memory is divided up.
As this microcontroller is a RISC computer, each instruction word must carry not only the
instruction code itself, but also any address or data information needed. In the diagram the
Instruction register receives the instruction word and then starts the process of dividing this up
into its component parts. Depending on the instruction itself, five bits of the instruction word
may carry address information and hence be sent down the ‘Direct Addr’ bus to the address
multiplexer (‘Addr MUX). Eight bits of the instruction word may carry a data byte that is to be
used as literal data for the execution of that instruction. This goes to the multiplexer (‘MUX’),
which feeds into the ALU. Finally, there is the instruction data itself, which feeds into the
‘Instruction Decode and Control’ unit.

This microcontroller has only two on-chip peripheral devices, a Timer (‘Timer 0’) and the
General-Purpose Input/Output port, with pins GPO to GP5. The IC pins themselves appear in
the block diagram as squares with crosses inside. Each of these pins is dual or triple function,
so each has a second function identified in the diagram. We do not need to understand now,
what each of these is, but we soon will.

Towards the bottom left of the diagram are a number of functions relating to the clock os-
cillator, power supply and reset. Power supply and ground are connected via pins Vpp and Vgg
respectively. A ‘Power-on Reset’ function detects when power is applied and holds the
microcontroller in a Reset condition while the power supply stabilises. The MCLR input can
be used to place the CPU in a Reset condition and to force the program to start again. An
internal clock oscillator (‘Internal RC OSC’) is provided so that no external pins whatsoever
need be committed to this function. External oscillator connections can, however, be made,
using input/output pins GP4 and GP5. The oscillator signal is conditioned for use through the
microcontroller in the ‘Timing Generation’ unit. The ‘Watchdog Timer’ is a safety feature,
used to force a reset in the processor if it crashes.

Having worked through this section, it should be possible for you to appreciate that the dia-
gram of Figure 1.13 is a direct embodiment of the generic microcontroller shown in Figure 1.8.
While the detail at this stage is incomplete, it will fall into place in the coming chapters.

Summary

e An embedded system is a product that has one or more computers embedded within it,
which primarily exercise a control function.

o The embedded computer is usually a microcontroller: a microprocessor adapted for
embedded control applications.
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e Microcontrollers are designed according to accepted electronic and computer principles,
and are fundamentally made up of microprocessor core, memory and peripherals; it is
important to be able to recognise their principal features.

e Microchip offers a wide range of microcontrollers, divided into a number of different
families. Each family has identical (or very similar) central architecture and instruction
sets. However, common features also appear across all their microcontrollers, and
knowledge of one family can lead with ease to knowledge of another.

e The Microchip 12F508 is a good microcontroller with which to introduce a range of
features of microcontrollers in general and of PIC microcontrollers in particular.
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Questions and exercises

1.

List five possible embedded systems in each of the following: a child’s bedroom/playroom,
the kitchen, and the office.

Consider a domestic washing machine. Sketch its control system as a block diagram in a
similar manner to Fig. 1.5, identifying as best you can its sensors and actuators. Assume
it is controlled by a single microcontroller. (Note: the main point of this exercise is to
visualise a product in terms of an embedded system, not to achieve technical accuracy.)

Repeat exercise 2 for a desktop printer.

An application is to use either the 12F508 or the 12F509. It must retain a scratchpad area of
memory of 12 bytes, and also be able to store in RAM three variables of 4 bytes each, and
36 single bits of data. How many bytes does this amount to, and can the smaller device be
used?

Access the 12F508/9 data sheet from the Microchip web site (Ref. 1.2), and by reading the
first few pages answer the following questions for the 12F508:

(a) What is the clock frequency range?
(b) What is the frequency of the internal oscillator?
(c) What is the operating voltage range?

(d) What is the technology of the program memory?
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(e) What support tools are available for program development?
(f) What types of operation is the ALU capable of?
(g) What are claimed to be the key advantages of this microcontroller?

(h) What bits in the Status register may be affected by the execution of an instruction?



Section 2
Minimum Systems and the PIC 16F84A

This section of five chapters develops the main concepts of a microcontroller, using a ‘small’
mid-range PIC microcontroller. Emphasis is placed on understanding the core architecture and
using simple digital peripherals. Programming is in Assembler, as this allows the closest
possible contact with the underlying hardware.



Introducing the PIC mid-range
family and the 16F84A

In Chapter 1 we introduced embedded systems and surveyed the different PIC microcontroller
families that are available, using the 12F508 as an introductory device. We are now going to
step up a gear and begin to look at the detail of the PIC ‘mid-range’ family. As an example
device we will mainly use the 16F84A. We chose this because compared to most micro-
controllers it is small and simple and therefore easy to learn from, even though it is not the
most recent device. Six chapters later the focus of study will change to the 16F873A, a larger
member of the same family. Note carefully that the ’F84A is an almost direct subset of the
"F873A. Therefore, don’t worry if you are more interested in the latter device. Everything you
learn about the smaller microcontroller is directly applicable to the larger, and forms part of it.
Indeed, just about everything we meet in the following chapters applies to all of the mid-range
family of microcontrollers, and to all microcontrollers in general.

We will explore the overall architecture of the device and take time to go into some detail
about its memory — both the technology and the memory maps.

In this chapter you will therefore learn about:
e The PIC mid-range family, in overview.

e The overall architecture of the 16F84A.

The 16F84A memory system, along with a review of memory technologies.

Other hardware features of the 16F84A, including the reset system.

2.1 The main idea - the PIC mid-range family

2.1.1 A family overview

The PIC mid-range family is growing rapidly, with a huge and almost bewildering diversity of
members. Therefore, when we talk of ‘family’ here, we are applying the concept of ‘extended
family’, and a very large one at that. Nevertheless, the mid-range group stays true to the

concept that all family members have identical core and instruction sets, with the difference
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arising from different peripherals and other features being implemented and different package
sizes. Hence, the pattern of Figure 1.9 is followed.

A good example of Figure 1.9 is Table 2.1, which summarises those members of the mid-range
family that we meet, in one place or another, in this book. Even with a limited number of
microcontrollers, it is a formidable table. Let’s begin to make some sense of it.

Within the listing shown, we find four groupings of closely related controllers: the 16F84A and
its clones; the 16F87 with its near-twin, the *88; the 16F87XA cluster; and the 16F88X. What
is a little less obvious is that two of these groups are somewhat older, and two newer.

The 16F84A is listed first, with features we are about to explore in detail. Table 2.1 shows the
number of pins, a modest 18, and clock frequency range. Like all the other microcontrollers in
the list, it has three types of memory. The underlying technology of these will be outlined in
the next few pages. In the final column we have the peripherals, a listing that is modest in the
extreme — two input/output ports and a timer. The sheer simplicity of this little fellow makes it
a compelling choice as an introductory device to work with. A variant is the 16LF84A, whose
extended supply voltage range allows operation at lower voltages, attractive indeed for
battery-powered products. Either of these controllers is available in different packages,
different operating temperature ranges and different clock speed ranges. For example, the
16F84A is available in 4 and 20 MHz versions.

Coming in with the same package size as the 16F84A is the ’F87/88 duo. These have a very
similar internal structure to the ’F84A, and are pin-for-pin compatible. Nevertheless they carry
a number of extra peripherals, as the final column of the table shows. The fact that they are
more recent is hinted by the ‘software selectable oscillator block’, and ‘nanoWatt technology’.
The latter is a collection of features which allow these two to operate in extremely power-
conscious applications. We return to these in Chapter 12.

The 16F87XA is a diverse grouping, as can be seen. There are two package sizes and two
memory sizes. It is easy to see that package size is linked directly to the number of input/
outputs that are available. The 40-pin versions have five parallel ports (which translates to 33
lines of parallel digital input/output), as well as more analog input, compared with their 28-pin
relatives. There is otherwise not much difference. Each package size, however, comes with
two different memory sizes. The bigger memory of course gives the opportunity for longer
programs and more data storage, but also costs a little more.

The 16F88X is effectively an upgrade of the 16F87XA group. There is the same pattern of two
package sizes, with input/output matching the greater or lesser number of pins. Each package
size also has several memory size options. There are again the new technology features that
were mentioned with the 16F87/88 duo. This group carries very similar peripherals to the
16F87XA clan. Several of these appear in an ‘enhanced’ version, adding further capability to
already powerful extras.
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TABLE 2.1 Some members of the PIC mid-range family (shading applied to highlight groups and aid
readability)
Device Number Memory (K = Kbytes,
number of pins” Clock speed i.e. 1024 bytes) Peripherals/special features
16F84A 18 DC to 20 MHz 1K program memory, 1 8 bit timer,
68 bytes RAM, 1 5 bit parallel port,
64 bytes EEPROM 1 8 bit parallel port,
ICSP
16LF84A 18 DC to 20 MHz as above as above, with extended
supply voltage range
16F84A 04 18 DC to 4 MHz as above as above
16F87 18 DC to 20 MHz 4K program memory, 2 parallel ports,
368 bytes RAM, 3 counters/timers,
256 bytes EEPROM 2 capture/compare/PWM
modules,
2 serial communication
modules,
2 analog comparators,
nanoWatt technology,
software selectable oscillator
block,
ICSP
16F88 18 DC to 20 MHz as above as above, and
7 10 bit ADC channels
16F873A 28 DC to 20 MHz 4K program memory, 3 parallel ports, 3 counters/
192 bytes RAM, timers,
128 bytes EEPROM 2 capture/compare/PWM
modules,
2 serial communication
modules,
16F876A 28 DC to 20 MHz 8K program memory 5 10 bit ADC channels,
368 bytes RAM, 2 analog comparators,
256 bytes EEPROM ICSP
16F874A 40 DC to 20 MHz 4K program memory 5 parallel ports,
192 bytes RAM, 3 counters/timers,
128 bytes EEPROM 2 capture/compare/PWM
modules,
16F877A 40 DC to 20 MHz 8K program memory 2 serial communication

368 bytes RAM,
256 bytes EEPROM

modules,

8 10 bit ADC channels,
2 analog comparators,
ICSP

Continued



30 Chapter 2

TABLE 2.1 Some members of the PIC mid-range family (shading applied to highlight groups and aid
readability) —Cont’d

Device Number Memory (K = Kbytes,
number of pins” Clock speed i.e. 1024 bytes) Peripherals/special features
16F882 28 DC to 20 MHz 2K program memory 3 parallel ports,
128 bytes RAM, plus one bit
128 bytes EEPROM 3 counters/timers,
enhanced capture/compare/
16F883 28 DC to 20 MHz 4K program memory PWM module,
256 bytes RAM, 2 serial communication
256 bytes EEPROM modules,
11 10 bit ADC channels,
16F886 28 DC to 20 MHz 8K program memory 2 analog comparators,
368 bytes RAM, nanoWatt technology, software
256 bytes EEPROM selectable oscillator block,
ICSP
16F884 40 DC to 20 MHz 4K program memory 5 parallel ports,
256 bytes RAM, 3 counter/timers,
256 bytes EEPROM enhanced capture/compare/
PWM module,
16F887 40 DC to 20 MHz 8K program memory 2 serial communication
368 bytes RAM, modules,
256 bytes EEPROM 14 10 bit ADC channels,

2 analog comparators,
nanoWatt technology,
software selectable oscillator
block,

ICSP

ADC, analog to digital converter; PWM, pulse width modulation; ICSP, in circuit serial programming.
“For DIP package only.

As is normal Microchip practice, each member or group of the mid-range family has its own
comprehensive data sheet, available from Microchip’s website. Reference 2.1 is the data sheet
for the 16F84A. As well as this, there is a manual covering the features that are common to all
members of the family [Ref. 2.2]. While it is not necessary to refer to these while reading this
chapter, it is worth knowing they are there, and they are extremely useful for looking up the
finer details of a microcontroller’s design and use.

If the last group described, the 16F88X, is the biggest, best and most recent of the list, why
don’t we immediately use its members as our introductory examples? The answer is that they
are also pretty complicated. It will be well worth learning basic concepts from smaller and
simpler devices. Once these have been understood, it is easy to make the transfer up the food
chain to the more complex device. Nothing is lost in this approach, and there is less risk of
being overwhelmed with excessive detail.
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2.1.2 The 16F84A

The 16F84 A, along with its direct predecessors, has been one of many PIC success stories. It
first appeared as the 16C84. At a time when most microcontroller manufacturers were trying to
make their products bigger, more sophisticated and more complex, Microchip took the bold
decision to stay small, simple and easy to use. While many microcontrollers of the day did have
on-chip program memory, it was usually EPROM (Erasable Programmable Read-Only
Memory), with the attendant time-consuming EPROM erase cycle. With the 16C84, Microchip
chose to use EEPROM (Electrically Erasable Programmable Read-Only Memory) for program
memory. Thus, it could be programmed rapidly and repeatedly changed. Then, as Flash memory
technology became more accessible, the *C84 was reissued as the 16F84 with the new memory
technology. With further upgrading it became the 16F84A. At the time of writing, this is the
current version. A 16LF84A, intended for low-power applications, is also available.

2.1.3 A caution on upgrades

As technological expertise develops, any microcontroller design is inevitably upgraded. These
upgrades are normally spelled out in documentation published by the manufacturer (e.g.
Ref. 2.3). While each upgrade is generally to be welcomed, the changes introduced need to be
watched with care. Some are of obvious benefit. For example, the ‘A’ version of the 16F84 can
run at a higher speed than before (20 MHz maximum instead of 10 MHz). However, the
technical upgrade sometimes has side-effects. These are of no direct advantage and sometimes
make it difficult to replace a microcontroller in an existing product with its upgraded version.
For example, operating power supply voltages and logic input thresholds are different between
the "F84 and the "F84A.

2.2 An architecture overview of the 16F84A

The pin connection diagram of the 16F84A is shown in Figure 2.1 and its block diagram in
Figure 2.2. A comparison of these figures with the equivalent ones for the PIC 12F508 in
Chapter 1 shows some interesting similarities and differences. With 18 pins in play, there isn’t
the intense pressure to squeeze several functions onto each pin. Separate and dedicated pins
are now provided, for example, for clock oscillator (pins 15 and 16) and Reset (pin 4 —
MCLR). Nevertheless, compared to most, the ’F84A remains a small microcontroller.

Architecturally there is clear similarity between the 12F508 and the 16F84A. In fact, the
former is a direct subset of the ’F84A, with near identical CPU, memory, bus structure and
counter/timer (TMRO) peripheral. Notice first, however, that the address bus sizes have been
increased to meet the needs of the whole PIC mid-range family. As a smaller member of that
family, the "F84A doesn’t fully exploit all these developments. The program address bus is
now 13-bit and the instruction word size is 14-bit. Therefore, 213 (i.e. 8192) memory locations
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N

Port A, bit 2 RA2 O 1 18 o RA1 Port A, bit 1

Port A, bit 3 RA3 O 0 RAO Port A, bit 0
*Port A, bit 4 RA4/TOCKI O 0 OSC1/CLKIN Oscillator connections

Reset MCLR O 0 OSC2/CLKOUT
Ground VgsO O Vpp Supply voltage

**Port B, bit 0 RBO/INT O O RB7 Port B, bit 7

Port B, bit 1 RB1 O O RB6 Port B, bit 6

Port B, bit 2 RB2 O 0 RB5 Port B, bit 5

PortB,bit3 RB3 9 10p RB4 Port B, bit 4

*also counter/timer clock input
**also external interrupt input

Figure 2.1: The PIC 16F84A pin connection diagram

Data Bus 8
EEPROM Data Memory
FLASH
F;Arogram
o 8 Level Stack RAM EEDATA Data Moo
evel Cl B 2 — < al emory
1K x 14 (13-bit) File Registers 64x8
68 x 8
Program
Instruction Register
” 5 Direct Addr TMRO Counter/Timer
«— | ‘Timer®
RA4/TOCKI)
8
Port A
Power-up >A/
) Timer 1/0 Ports
Instruction Oscillator —
Decode & [<—=>{| Start-up Timer
Control 5
ower-on A3:
Reart RA3:RA0 J
Timing Watchdog RB7:RB1
Generation [ Timer
o]
I% % % X meont
0OSC2/CLKOUT MCLR  Vobp, Vss
OSC1/CLKIN

For Key, see Figures 1.11 and 1.13

Figure 2.2: Block diagram of the 16F84A (supplementary labels in shaded boxes added by the
author)
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could be addressed. Program memory size, at 1K, is however only one eighth of this. The
larger bus size will prove to be useful in the larger mid-range devices, as can be seen in the
program memory size of the 16F876A and 16F877A (Table 2.1). RAM size has crept up
cautiously to 68 locations and the stack to 8 locations.

A number of important new additions have appeared. The inclusion of an EEPROM memory
gives the valuable capability of being able to store data values even when the chip is powered
down. There are now two digital input/output ports. These are Port A, with five pins, and Port
B, with eight. Importantly, there is the addition of an interrupt capability (which we explore in
detail in Chapter 6). This can be seen externally on pin 6, where bit O of Port B is shared with
the external interrupt input. We will also see that there are three further internal interrupt
sources, generated by the peripherals.

Overall, we have a microcontroller that, while only modestly more complex than the 12F508,
has proved incredibly diverse and useful in small applications.

2.2.1 The Status register

The result of any CPU operation is held in the Working register, but this does not necessarily
tell everything about the operation that has just occurred. What if, for example, the 8-bit range
has been exceeded in an addition instruction, for example by adding binary numbers 1000
0000 and 1111 1101? The Working register has no way of indicating this and would simply
hold an incorrect result. Therefore, a set of logic bits, sometimes called ‘condition code’ flags,
is built into any computer CPU. These are used to carry extra information about the result of
the instruction most recently executed, for example whether the result is zero, negative or
positive. For the 16F84 A, these flags are held in the Status register, shown in Figure 2.3. Only
three of these Status register bits genuinely fall into the category of condition codes. These are
bits 0 to 2, i.e. bits C, DC and Z. As the key to the figure shows, these indicate respectively
whether a Carry or Digit Carry has been generated, or if the result is Zero. Their use is ex-
plored further in Chapters 4 and 5.

2.3 A review of memory technologies

In order to examine the memory capabilities of the 16F84A, and to work with embedded
systems in general, it is important to have some knowledge of the characteristics of the
memory technologies in use. A detailed survey can be found in Chapter 4 of Ref. 1.1. The
following section gives just a brief overview of the different memory technologies currently
used by Microchip.

An ideal memory reads and writes in negligible time, retains its stored value indefinitely,
occupies negligible space and consumes negligible power. In practice no memory tech-
nology meets all these happy ideals! In general, different technologies are strong in one or
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RW-0  RW-0  RW-0 R-1 R-1 RW-x  RW-x_ RM-x
[ rP [ RP1 RPO TO PD z DC c
bit 7 bit 0

bit 7-6  Unimplemented: Maintain as ‘0’

bit 5 RPO: Register Bank Select bits (used for direct addressing)
01 = Bank 1 (80h - FFh)
00 = Bank 0 (00h - 7Fh)

bit4  TO: Time-out bit

1 = After power-up, CLRWDT instruction, or SLEEP instruction
0= A WDT time-out occurred

bit 3 PD: Power-down bit
1 = After power-up or by the CLRWDT instruction
0 = By execution of the SLEEP instruction

bit 2 Z: Zero bit
1 = The result of an arithmetic or logic operation is zero
0 = The result of an arithmetic or logic operation is not zero

bit 1 DC: Digit Carry/borrow bit (ADDWF, ADDLW, SUBLW, SUBWF instructions) (for borrow, the polarity
is reversed)
1 = A carry-out from the 4th low order bit of the result occurred
0 = No carry-out from the 4th low order bit of the result

bit 0 C: Carry/borrow bit (ADDWF, ADDLW, SUBLW, SUBWF instructions) (for borrow, the polarity is
reversed)
1 = A carry-out from the Most Significant Bit of the result occurred
0 = No carry-out from the Most Significant Bit of the result occurred

Note: A subtraction is executed by adding the twos complement of the second operand.
For rotate (RRF, RLF) instructions, this bit is loaded with either the high or low order
bit of the source register.

Figure 2.3: The 16F84A Status register

more of these characteristics and weaker in others. There is not one best memory tech-
nology, and different technologies are therefore applied for different applications, according
to their needs.

Any memory is made up of an ‘array’ of memory ‘cells’, where each cell holds one bit of data.
The characteristics of the single cell reflect the characteristics of the overall array; therefore,
each technology is described here simply in terms of its cell design.

2.3.1 Static RAM (SRAM)

Here each memory cell is designed as a simple flip-flop, using two pairs of transistors
connected back-to-back. Two further transistors allow the cell to connect into the main array.
Data is held only as long as power is supplied. Hence the SRAM technology is volatile. With
each cell taking six transistors, SRAM is not a high-density technology. However, if made
from CMOS (Complementary Metal Oxide Semiconductor) it can be made to consume very
little power, and can retain its data down to a low voltage (around 2 V). It has thus been
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a popular technology in battery-powered systems. SRAM is mainly used for data memory
(RAM) in a microcontroller.

2.3.2 EPROM (Erasable Programmable Read-Only Memory)

In this technology each memory cell is made of a single MOS transistor — but with a difference.
Within the transistor there is embedded a ‘floating gate’. Using a technique known as hot
electron injection (HEI), the floating gate can be charged. When it is not charged, the transistor
behaves normally and the cell output takes one logic state when activated. When it is charged,
the transistor no longer works properly and it no longer responds when it is activated. The
charge placed on the floating gate is totally trapped by the surrounding insulator. Hence
EPROM technology is non-volatile. EPROM can, however, be erased by exposing it to intense
ultraviolet light. This gives the trapped electrons the energy to leave the floating gate.

A special version of EPROM is OTP (One Time Programmable). Here the EPROM is pack-
aged in plastic, without a window. Therefore, OTP can be programmed only once and never
erased.

With a single transistor for a cell, EPROM is very high density and robust. Its requirement of
a quartz window and ceramic packaging, to enable erasing, raises its price and reduces its
flexibility. EPROM used to be integrated onto many microcontrollers for program memory,
forcing the whole microcontroller to be ceramic-packaged with a quartz window (as seen in
Figure 1.10). As a technology, EPROM has now almost completely given way to Flash, which
follows shortly, but you may come across it in older systems.

2.3.3 EEPROM (Electrically Erasable Programmable Read-Only Memory)

EEPROM also uses floating gate technology. Its dimensions are finer, so that it can exploit
another means of charging its floating gate. This is known as Nordheim—Fowler tunnelling
(NFT). With NFT, it is possible to electrically erase the memory cell as well as write to it.
To allow this to happen, a number of switching transistors need to be included around the

memory element itself, so the high density of EPROM is lost.

Generally, EEPROM can be written to and erased on a byte-by-byte basis. This makes it
especially useful for storing single items of data, like television settings or mobile phone
numbers. Both writing and erasing take finite time, up to several milliseconds, although a read
can be accomplished at normal semiconductor memory access times, i.e. within microseconds
or less. Again, like EPROM, because the charge on the floating gate is totally trapped by the
surrounding insulator, EEPROM is non-volatile. Because the EEPROM structure is now so
fine, it suffers from certain wear-out mechanisms. Manufacturers usually therefore define

a guaranteed minimum number of erase/write cycles that their memory can successfully
undergo.
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2.3.4 Flash

Flash represents a further evolution of floating-gate technology. With a single transistor per
memory cell, it uses both HEI and NFT to allow electrical writing and erasing. It does not
include the extra switch transistors that EEPROM has, so can only erase in blocks. It therefore
returns to the exceptionally high density of EPROM. Like EEPROM, it has wear-out mech-
anisms, so cannot be written and erased indefinitely.

Apart from its inability to erase byte-by-byte, Flash is an incredibly powerful technology. It is
now a central feature of a huge range of products, including digital cameras, ‘memory sticks’,
laptop computers and microcontroller program memory.

2.4 The 16F84A memory

As Figure 2.2 shows, there are no less than four areas of memory in the 16F84A, as
summarised in Table 2.2. Each memory has its own distinct function and means of access.

2.4.1 Program memory and the stack

The 16F84A program memory map is shown in Figure 2.4. Looking at this diagram, we can see
that it actually shows three things: the Program Counter, the Stack and the actual program
memory. The three work inextricably together. The program memory is loaded with the pro-
gram code that the microcontroller executes. The program is in the form of a list of instructions
and the Program Counter holds the address of the next instruction that is to be executed by the
microcontroller. Therefore, it acts as a pointer to program memory, as indicated in the diagram.
We can see that the address range of the program memory is from 0000 to 03FFy. With its
13-bit Program Counter, the microcontroller can theoretically address a range from 0000 to
1FFFy. The extra address space is shown (in grey), although it is of no use here.

TABLE 2.2 16F84A memory features

Volatile/ Special
Memory function Technology Size non volatile characteristics”
Program Flash 1K x 14 bits Non volatile 10 000 erase/write
cycles, typically
Data memory SRAM 68 bytes Volatile Retains data down
(file registers) to supply voltage of
1.5V
Data memory EEPROM 64 bytes Non volatile 10 000 000 erase/
(EEPROM) write cycles,
typically
Stack SRAM 8 x 13 bits Volatile

“Information obtained from full 16F84A data sheet [Ref. 2.1].
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A ‘Stack’, in general computing terms, defines a particular type of temporary memory. Its main
feature is that it is structured as a LIFO memory — last in, first out. Think of a pile of dinner
plates in a small restaurant; the person drying the dishes keeps adding to the pile, while the
waiter keeps taking dishes from the pile. Whenever the waiter takes a plate, he takes from the
top, taking the last one that the dish-dryer has put there. This is the basis of a LIFO memory.
Data words can be transferred to it (often called a ‘push’ to stack), and they can be taken from it
(often called a ‘pop’ from stack). Whatever is ‘popped’ is always the last word to have been
pushed there. That word is effectively removed from the stack, and the next most recent one will
be popped next, unless another push occurs. In some microcontrollers the programmer can
control the Stack. In the 16 Series microcontrollers it is under automatic hardware control, only.
Here, the value of the Program Counter can be moved onto the Stack. This occurs when either
a subroutine or an interrupt occurs. The instructions indicated in the diagram, CALL,
RETURN, RETFIE and RETLW, all relate to subroutines and interrupts. We will meet them in
the coming chapters — don’t worry if they have no meaning to you at present!

The very first location in the program memory is labelled the ‘reset vector’. When the program
starts running for the first time, for example on power-up, the Program Counter is set to 0000.
Therefore, the first memory location that it points to is the reset vector. The programmer

PC<120
16 Series L S 3 | —_

. . . CALL, RETURN
instructions which | Y ReTFIE, RETLW IE \| Program Counter
invoke the Stack Stack Level 1
: The program
Stack Level 8 L —
H— must start here
The Interrupt ] RESET Vector 0000h
Service Routine __ [ Peripheral Interrupt Vector | 0004h
must start here Erogram Comlmter.
——__ | points to locations in
" program memory

g N

Eo

o O

=8

3‘0

0

o}

3FFh :
- Unimplemented
< memory space, still
— |

addressable by the
16F84A program

1FFFh

Figure 2.4: The 16F84A - program memory and Stack (supplementary labels in shaded boxes
added by the author)
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must therefore place his/her first instruction at this location. The ‘peripheral interrupt vector’
acts in a similar way for interrupt service routines, as we shall see in Chapter 6.

2.4.2 Data and Special Function register memory (RAM)

The RAM memory map is shown in Figure 2.5. The memory area is ‘banked’, and is divided
into two important areas. The first is the general-purpose data memory, which occupies
locations 0Cy to 4Fy. Above that are the Special Function registers (SFRs). Let us explore
the two concepts just mentioned, as they are likely to be unfamiliar.

File Address File Address
00h | Indirect addr." | Indirect addr.(" | | 80h
01h TMRO OPTION_REG 81h
02h PCL PCL 82h
03h STATUS STATUS 83h
04h FSR FSR 84h
05h PORTA TRISA 85h
06h PORTB TRISB 86h
07h = o 87h
08h EEDATA EECON1 88h
09h EEADR EECON2(" 8gh
OAh PCLATH PCLATH 8Ah v
0Bh INTCON INTCON 8Bh -
oCh &Ch MSB is ‘bank
select bit’
(Status register).
68
General Mapped
Purpose (accesses)
Registers in Bank 0
(SRAM)
4Fh CFh
50h DOh
7Fh ﬁ FFh
Bank 0 Bank 1
[] Unimplemented data memory location, read as 0.
Note 1: Not a physical register.

Figure 2.5: Data memory and Special Function register map of the 16F84A (supplementary labels
in shaded boxes added by the author)
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‘Banked’ addressing

A problem with any memory space is that the larger the memory is, the larger the address bus
must be. One way of avoiding big address buses is to divide the memory into a number of
smaller blocks — called banks — each identical in size. Now a smaller address bus can be used.
It can access all banks in an identical way, with just one of the banks being identified at any one
time as the target of the address specified.

PIC microcontrollers adopt a banked structure for their RAM, with the 16F84A having just
two banks. The address of either bank is the 7-bit RAM address (‘RAM addr’) seen in
Figure 2.2. The active bank is selected by bit 5 in the Status register (Figure 2.3). The pro-
grammer must ensure that the bank bit in the Status register is correctly set before making any
access to memory.

Special Function registers

The SFRs are the gateway to interaction between the CPU and the peripherals, and we will get
to know them very well. To the CPU, an SFR acts more or less like a normal memory location —
you can usually write to it or read from it. What makes it ‘special’ is that the bits of that
memory location have a dual purpose. Each bit is wired across to one or other of the
microcontroller peripherals. Each is then used either to set up the operating mode of the
peripheral or to transfer data between the peripheral and the microcontroller core. As we get to
know the peripherals of the 16F84A, we will get to know each of the SFRs shown in Figure 2.5.
Note that four SFRs appear in Figure 2.2. Can you identify what they are?

RAM addressing

Figure 2.2 shows that there are two possible sources of the RAM address, selected through the
address multiplexer (‘Addr Mux’). One possibility is that the address forms part of the in-
struction and is routed across to the address multiplexer from the Instruction register. This is
called ‘direct’ addressing. Alternatively, the address is taken from the File Select Register, or
FSR, which can be found as one of the SFRs in Figure 2.5. If the user loads an address into the
FSR, that can then be used as an address to data memory, a technique known as ‘indirect’
addressing. This will be described in Chapter 5.

The actual memory addresses are shown in Figure 2.5, labelled as ‘file address’. These
addresses, at least in the right-hand column, appear to be 8-bit. We know, however, from
Figure 2.2, that the RAM address bus is only 7-bit, or only 5 valid bits if direct addressing
is used. It is important to understand that the addresses shown are made up of this 7-bit
RAM address, with the bank select bit from the Status register inserted as the eighth, most
significant, bit. When programming it is necessary to separate the two, ensuring that the
MSB in Figure 2.5 is used for the bank select bit. This will become clear as we start to
program.
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2.4.3 The Configuration Word

A special part of the 16F84A program memory is its ‘Configuration Word’ (Figure 2.6). This
allows the user to define certain configurable features of the microcontroller, at the time of
program download. These are fixed until the next time the microcontroller is programmed.
This is distinct from those many selectable features, like the setting of SFRs, which are under
normal program control. While the Configuration Word is part of program memory, it is not
accessible within the program or in any way while the program is running. The actual features
it controls, which can be read on the diagram, are explained in this and later chapters.

2.4.4 EEPROM

The EEPROM is non-volatile and is particularly useful for holding data variables that can be
changed but are likely to be needed for the medium to long term. Examples include TV tuner
settings, phone numbers stored in a cell phone or calibration settings on a measuring instrument.

In the 16F84A (and indeed any PIC microcontroller), the EEPROM is not placed in the main
data memory map. Instead (as the top right of Figure 2.2 neatly shows) it is addressed through
the EEADR register and data is transferred through the EEDATA register. These are both
SFRs, seen in Figure 2.5.

As the earlier review of memory technology suggests, reading from EEPROM is a simple
process but writing to it is not. The latter takes significant time in electronic terms (i.e. mil-
liseconds) and care must be taken to avoid accidental writes. A set of controls is therefore

R/P-u R/P-u R/P-u R/P-u R/P-u R/P-u R/P-u R/P-u R/P-u R/P-u R/P-u R/P-u R/P-u R/P-u
| cP | CP | cP [ CcP | cP [ cP [ CP | cP [ CP | CP |PWRTE[WDTE|FOSC1|FOSCOI
bit13 bito

bit 13-4 CP: Code Protection bit
1 = Code protection disabled
0 = All program memory is code protected

bit 3 PWRTE: Power-up Timer Enable bit
1 = Power-up Timer is disabled
0 = Power-up Timer is enabled

bit 2 WDTE: Watchdog Timer Enable bit
1 = WDT enabled
0 = WDT disabled

bit 1-0 FOSC1:FOSCO: Oscillator Selection bits
11 = RC oscillator
10 = HS oscillator
01 = XT oscillator
00 = LP oscillator

Figure 2.6: 16F84A Configuration Word
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required to start the process and (for write) to detect when it is ended. These are found in
the bits of the EECONI1 register; see Figure 2.7. To read an EEPROM location, the required
address must be placed in EEADR and the RD bit set in EECONI1. The data in that memory
location is then copied to the EEDATA register and can be read immediately. To write to
an EEPROM location, the required data and address must be placed in EEDATA and EEADR
respectively. The write process is enabled by the WREN (Write Enable) bit being set high,
followed by the bytes 55y followed by AAy being sent to the EECON2 register. The built-in
requirement for these codes helps to ensure that accidental writes do not take place, for
example on power-up or -down. The WR bit is then set high and writing actually commences.
The write completion is signalled by the setting of bit EEIF in EECONI.

2.5 Some issues of timing

2.5.1 Clock oscillator and instruction cycle

Any microprocessor or microcontroller is a complex electronic circuit, made up of sequential
and combinational logic. At fantastic speed it steps in turn through a series of complex states,

U-0 U-0 U-0 RW-0 RW-x RW-0 RS-0 RS0
— - | — EEIF | WRERR | WREN WR RD
bit 7 bit 0

bit 7-5 Unimplemented: Read as '0'
bit 4 EEIF: EEPROM Write Operation Interrupt Flag bit
1 = The write operation completed (must be cleared in software)
0 = The write operation is not complete or has not been started
bit 3 WRERR: EEPROM Error Flag bit
1 = A write operation is prematurely terminated
(any MCLR Reset or any WDT Reset during normal operation)
0 = The write operation completed
bit 2 WREN: EEPROM Write Enable bit
1 = Allows write cycles
0 = Inhibits write to the EEPROM
bit 1 WR: Write Control bit

1 = Initiates a write cycle. The bit is cleared by hardware once write is complete. The WR bit
can only be set (not cleared) in software.
0 = Write cycle to the EEPROM is complete
bit 0 RD: Read Control bit
1 = Initiates an EEPROM read RD is cleared in hardware. The RD bit can only be set (not
cleared) in software.
0 = Does not initiate an EEPROM read

Figure 2.7: The EECON1 Special Function register (address 88y)
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each state being dependent on the instruction sequence it is executing. While the detail of this
process is invisible to us, it is still necessary to provide the ‘clock’ signal, a continuously
running fixed-frequency logic square wave. The overall speed of the microcontroller operation
is entirely dependent on this clock frequency. It is not just the CPU that is dependent on the
clock. In most microcontrollers many essential timing functions are also derived from it,
ranging from counter/timer functions to serial communications. Furthermore, the overall
power consumption of the microcontroller has a strong dependence on clock frequency, with
high-speed operation being much more power-hungry than low-speed.

As Table 2.1 shows, every microcontroller has a specified range for its clock frequency. It
is up to the designer to determine the clock frequency needed and to select a means of
generating the clock source. With so many things depending on the clock frequency and its
stability, these can be challenging decisions. These are taken further in Chapter 3.

Within any microprocessor, the main clock signal is immediately divided down by a fixed
value into a lower-frequency signal. Each cycle of this slower signal is called either

a ‘machine cycle’ or an ‘instruction cycle’. Microchip use the latter terminology. The in-
struction cycle becomes the primary unit of time in the action of the processor, for example
being used as a measure for how long an instruction takes to execute. The original clock
signal is retained to create phases or time stages within the instruction cycle. In PIC mid-
range microcontrollers the main oscillator signal is divided by four to produce the in-
struction cycle time.

Table 2.3 gives some popular clock frequencies, with their resulting instruction cycle du-
rations. For the fastest clock frequency, 20 MHz, the instruction cycle frequency is 5 MHz,
with a period of 200 ns. The slightly cheaper version of the controller, the 16F84-04, with
maximum clock frequency of 4 MHz, has at this frequency an instruction cycle time of 1 [is.
As we will see, this unsurprisingly is a convenient value for a range of simple timing ap-
plications, using software delay loops and the counter/timer. A popular clock frequency for
very low-power applications, including wristwatches, is 32.768 kHz. This has an instruction
cycle period of 122.07 ps. The result is very low power, but strictly no high-speed
calculations!

2.5.2 Pipelining

The combination of the RISC instruction set and the Harvard memory map used by PIC

microcontrollers has an added advantage: instructions can be ‘pipelined’. Every instruction in
a computer’s program memory has first to be fetched and then executed. In many CPUs these
two steps are done one after the other — first the CPU fetches and then it executes. If, however,
program memory has its own address and data bus, separate from data memory (i.e. a Harvard
structure), then there is no reason why a CPU cannot be designed so that while it is executing
one instruction, it is already fetching the next. This is called ‘pipelining’. Pipelining works best
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TABLE 2.3 PIC mid-range instruction cycle durations for various clock frequencies

Instruction cycle

Clock frequency
Frequency Period
20 MHz 5 MHz 200 ns
4 MHz 1 MHz 1 us
1 MHz 250 kHz 4 us
32.768 kHz 8.192 kHz 122.07 ps

if fetch and execute cycles are always of the same duration, such as a RISC structure gives.
This fairly simple design upgrade gives a doubling in execution speed!

All PIC microcontrollers implement pipelining, which is one of the reasons for their com-
paratively high speed of operation. Each instruction is fetched while the previous one is being
executed. Pipelining fails only for instructions that cause the value in the Program Counter to
be changed, for example a program branch or jump. In this case, the instruction fetched is no
longer the one needed. The pipelining process must then start again, with the consequent loss
of an instruction cycle.

A diagram representing the pipelining process in mid-range microcontrollers is shown in
Figure 2.8. Here we can see that while instruction 1 is being executed, instruction 2 is already
being fetched, the same happening as instruction 2 is executed, and so on. An example se-
quence of instructions is shown to the left of the diagram. It is not, however, necessary to
understand their meaning to understand the diagram, except to know that the CALL in-
struction causes a program branch. The instruction following it, instruction 4, is fetched while
instruction 3 is being executed. Due to the program branch, however, instruction 4 is no longer
needed, and a cycle has to be lost while the new instruction is fetched.

Tevo Tev Teve Tevs Teva Tevs
1. MOVLW 55h [ Fetch 1 Execute 1
2. MOVWF PORTB ‘Fetch2 | Execute 2
3. CALL SUB_1 Fetch 3 Execute 3
4. BSF PORTA, BIT3 (Forced NOP) Fetch 4 Flush
5. Instruction @ address SUB_1 Fetch SUB_1| Execute SUB_1

Fetch SUB_1 + 1

All instructions are single cycle, except for any program branches. These take two cycles, since the fetch
instruction is ‘flushed’ from the pipeline while the new instruction is being fetched and then executed.

Figure 2.8: Instruction pipelining
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2.6 Power-up and Reset

When the microcontroller powers up, it must start running its program from its beginning (i.e.
for the 16F84A from its reset vector, seen in Figure 2.4). This will only happen if explicit
circuitry is built in to detect power-up and force the Program Counter to zero. Along with this,
it is also very useful to set SFRs so that peripherals are initially in a safe and disabled state.
This ‘ready-to-start’ condition is called ‘Reset’. The CPU starts running its program when it
leaves the Reset condition.

In the 16F84A there is a Reset input, MCLR (‘Master Clear’), on pin 4. this can be seen in
Figure 2.1. As long as this is held low, the microcontroller is held in Reset. When it is taken
high, program execution starts. If the pin is taken low while the program is running, then

program execution stops immediately and the microcontroller is forced back into Reset mode.

There remains the question of when program execution should actually be allowed to start.
The moment power is applied is a dangerous one for any embedded system. Both the power
supply and the clock oscillator take a finite amount of time to stabilise, and in a complex
system power to different parts of the circuit may become stable at different times. Clearly, this
situation takes some careful handling. How can the start of program execution be delayed until
power has stabilised?

A simple way to resolve the ‘what do we do as power is applied?’ question is shown in
Figure 2.9(a), illustrated here for any microcontroller which has an active low Reset input. If
a resistor capacitor circuit is connected to the Reset input, then when power is applied the
capacitor voltage rises according to the RC time constant, which can be made as big as is
wanted. For a certain time, because it is rising comparatively slowly, the Reset input is at

Reset Reset Reset

7

Figure 2.9: External Reset circuits — generic microcontroller with Reset input. (a) Power-on Reset,
simplest possible. (b) Power-on Reset, with discharge diode and protective resistor. (c) User Reset
button
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Logic 0. Thus, the microcontroller can be held in Reset while its power supply stabilises and
while the clock oscillator starts up.

A small problem arises with this circuit if the power is switched off and then on again quickly
(a cruel and challenging thing to do to any electronic device). With the circuit of Figure 2.9(a)
the capacitor wouldn’t have time to discharge and the Reset condition might not be properly
applied when power is applied again. More dangerously, the capacitor voltage might exceed
the voltage supplied to the microcontroller and excessive current could then flow from the
capacitor into the Reset input. By adding a simple discharge diode, as shown in the circuit
in Figure 2.9(b), we can ensure that the capacitor discharges more or less at the same rate as
the Vpp supply. The resistor Rg is also included to limit current into the Reset input if the
capacitor voltage does inadvertently exceed the voltage supplied to the microcontroller or
another fault condition occurs.

If the designer wishes to include a Reset button, then the circuit of Figure 2.9(c) can be
applied. This is particularly useful for prototype circuits, where a large amount of testing is
expected. Then it is convenient to be able to reset a program that may have crashed. R is

a pull-up resistor, whose value can be in the range 10—100 k€. In a commercial device it is
usually not desirable to have a Reset button; the aim here is to design the product so that reset
by the user is never needed.

One of Microchip’s goals is to minimise the number of external components needed for their
microcontrollers, and the components of Figure 2.9 fall exactly into this category. Therefore,
the 16F84A includes some clever on-chip reset circuitry, which in many situations makes the
components of Figure 2.9(a) or (b) unnecessary. A Power-up Timer is included on-chip, which
can be enabled by the user with bit 3 of the Configuration Word (Figure 2.6). The 16F84A
detects that power has been applied and the Power-up Timer then holds the controller in Reset
for a fixed time. Once this is over the microcontroller leaves Reset and program execution
begins. Using this Timer, the circuit of Figure 2.9(b) need only be applied if the supply voltage
rises very slowly. The Power-up Timer, and further details of the internal Reset circuit, are
covered in greater detail in Section 2.8.

So what should be done with the 16F84A MCLR input if we don’t want to make use of it? It is
essential to recognise that this input must not just be left unconnected. The simplest thing to do
is to tie it to the supply rail and then forget about it.

2.7 Taking things further — the 16F84A on-chip reset circuit

Let’s take a closer look at the 16F84A on-chip reset circuitry, shown in simplified form in
Figure 2.10. This takes some understanding, but it is worth doing.

The actual reset to the CPU, Chip_Reset, is generated by a flip-flop, which appears to the right
of the diagram. This has two inputs, S (Set) and R (Reset). The CPU enters Reset mode when
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Chip_Reset goes low, which is caused by the S line going high. It stays there until the flip-flop
is cleared, caused by the R line going high.

So what causes a reset? The S input to the flip-flop goes high, via a three-input OR gate, if any
of the following goes high:

e External Reset, from the MCLR line, as we have already seen.

e Time-out Reset, from the Watchdog Timer (WDT); this is designed to occur if a program
crash occurs — the details are given in Chapter 6.

e Power-on Reset, output of the circuit that detects power being applied (‘Vpp Rise
Detect’).

Once any of these occurs, the flip-flop is set, the Chip_Reset line goes low and the PIC
microcontroller is held in Reset.

The Chip_Reset line returns to 1 (and the PIC microcontroller is enabled) if the R input

to the flip-flop is activated. The three requirements to be satisfied here, determined by the
inputs to the associated AND gate, are that both power supply and oscillator have stabilised,
and that any demand for Reset has been cleared. The first two of these requirements are
achieved by two interesting timers, the Power-up Timer (PWRT) and the Oscillator Start-up

& >c External Reset
MCLR
WDT | WDT
Module [ Time-out
Reset
|XI VDD Rise
Detect s
VDD Power-on Reset
OST/PWRT
OST —
XH 10-bit Ripple Counter }‘:):> o < | Cip_Resel
0sc1/
CLKIN :
OnChi PWRT
ncr;‘ oséﬂ)—-{> 10-bit Ripple Counterl»
See Table 6-5
Enable PWRT
Enable OST
Note 1: This is a separate oscillator from the RC oscillator of the CLKIN pin.
2: See Table 6-5.

Table 6 5 of Ref. 2.1 gives example reset delay times for different settings of oscillator, and PWRT and OST enable lines.

Figure 2.10: The 16F84A reset circuitry
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Timer (OST). The Power-up Timer can be enabled by setting its bit in the Configuration
Word (Figure 2.6). The Oscillator Start-up Timer is enabled via the Enable OST line. This is
set automatically by the user oscillator setting in the Configuration Word, which enables it
for all oscillator modes except RC. The Power-up Timer is clocked by its own on-chip

RC oscillator, and when enabled counts 1024 cycles of its oscillator before setting its output to
1. This time duration turns out to be around 72 ms. This is long enough for the average power
supply to have stabilised, though is not enough for a slowly rising supply. Once the Power-up
Timer has completed its count, the Oscillator Start-up Timer is then activated, which in turn
counts 1024 cycles of the main oscillator signal. This tests for a reliably running clock os-
cillator — if the oscillator isn’t running, then of course it can’t count. The outputs of both
counters, and the inverse of the S input to the flip-flop, are ANDed together to form the R input
to the flip-flop. If all lines are high, i.e. both counters have completed their count and there is
no demand for a Reset, then the flip-flop is cleared. The CPU accordingly leaves the Reset
condition and starts running.

The reset sequence just described is shown in Figure 2.11 for the common situation of MCLR
being tied to Vpp. Try to follow this, relating it to Figure 2.10. The application of power is
seen in the rise of the Vpp trace, which brings the MCLR line with it. This change is detected,
as seen in the change of state of the ‘internal POR’ line. This in turn triggers the Power-up
Timer, which runs for a period Tpwrt. When Tpwrr is up, the Oscillator Start-up Timer, whose
time delay is Togr, is activated. Notice that Togt depends on the main oscillator running
successfully and also on its frequency. For a 4 MHz oscillator, it will be 1024 x 250 ns, or
256 |s. When Tog is complete, the R line in Figure 2.11 goes high and the microcontroller
leaves the Reset state.

Voo J
MCLR ———/
INTERNALPOR |

TPWRT

PWRT TIME-OUT 1 «—TOST—>

OST TIME-OUT

INTERNAL RESET

Figure 2.11: Reset sequence on power-up, with MCLR tied to Vpp
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Summary

The PIC mid-range is a diverse and effective family of microcontrollers.

The 16F84A architecture is representative of all mid-range microcontrollers, with
Harvard structure, pipelining and a RISC instruction set.

The PIC 16F84A has a limited set of peripherals, chosen for small and low-cost ap-
plications. It is thus a smaller member of the family, with features that are a subset of any
of the larger ones.

The 16F84A uses three distinct memory technologies for its different memory areas.

A particular type of memory location is the Special Function register, which acts as the
link between the CPU and the peripherals.

Reset mechanisms ensure that the CPU starts running when the appropriate operating
conditions have been met, and can be used to restart the CPU in case of program
failure.
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Questions and exercises

1. From the 16F84A data sheet, Ref. 2.1, find out:

(

(
(

a) how many read/write cycles each of EEPROM and Flash memory can be expected to
undertake in their lifetime;

b) the data retention duration for the EEPROM memory;

c) the value of SFRs STATUS and PCL on power-up.

2. A non-technical friend asks you why his digital camera can ‘remember’ pictures, and
a mobile phone can ‘remember’ numbers and text messages. In a simple way explain
EEPROM and Flash program technology and their differences.
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The pairs of numbers shown below are added in a 16F84A program. What is the result in
each case and the value of the Status register bits Z, DC and C after each addition?
0101 1101 added to 0001 0011; 1110 1001 added to 0001 0111; 0001 0101 added to
0100 1001.

The Configuration Word of a 16F84A is read as 11 1111 1111 0010. Identify and explain
the settings.

For a precise timing application, an instruction cycle time of 1.973 Us is required. What
clock frequency will give this?

In a certain design, based on the 16F84A, the MCLR line is tied to the power supply. The
clock oscillator is 8 MHz. The power supply rises nearly instantaneously. Both Power-up
Timer and Oscillator Start-up Timer are enabled. How long is it before the microcontroller
leaves the reset condition?



Parallel ports, power supply
and the clock oscillator

So far we have looked a little at the theory of microcontroller architecture and its imple-
mentation in PIC microcontrollers. This chapter now begins to move from that theory to the
practice of small-scale hardware design.

As we have seen, the microcontroller core has internal data and address buses. In a way these
are like motorways, or inter-state freeways, carrying large amounts of traffic in both
directions to a variety of different destinations. The microcontroller needs to be provided
with a way of allowing that data flow to connect with the outside world, so that it can read in
external digital values or output other values. In other words, it needs the equivalent of
motorway junctions, where data can leave (or enter) the bus at designated times and loca-
tions. In the microcontroller world these junctions have many forms, as there are many
different ways in which data can be input or output. The most general purpose of these is the
parallel input/output port. This is one of the microcontroller’s most essential peripherals, and
is the opening subject of this chapter.

Given a working car engine, two essentials that it needs to run are fuel and a stream of sparks
from the plugs. A microcontroller has similar needs. Its fuel is the low-level electrical power
supply that it requires and, instead of a flow of sparks, it needs a regular sequence of clock
oscillator pulses. A study of these forms the second half of this chapter.

By putting together our background knowledge already gained, an ability to work with digital
input/output, and an ability to design a power supply and clock oscillator, we will be in the
happy position of being able to start to design real systems.

In this chapter you will learn about:
e Why we need parallel input/output.

e How simple logic circuits can be developed to give a flexible interface between the
microcontroller data bus and the outside world — these are the parallel ports.

e How external devices can be connected to the parallel port.

e The parallel input/output available on the PIC 16F84A.

Designing Embedded Systems with PIC Microcontrollers; ISBN: 9781856177504
Copyright © 2010 Tim Wilmshurst. All rights of reproduction, in any form, reserved.
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e The essential hardware features of the power supply and clock oscillator.
e The Microchip approach to power supply and oscillator, with the 16F84A.

e The hardware design of the electronic ping-pong game.

3.1 The main idea - parallel input/output

Almost any embedded system needs to transfer digital data between its CPU and the outside
world. This transfer falls into a number of categories, which can be summarised as:

e Direct user interface, including switches, keypads, light-emitting diodes (LEDs) and
displays.

o [nput measurement information, from external sensors, possibly being acquired through
an analog-to-digital converter.

o Qutput control information, for example to motors or other actuators.

o Bulk data transfer to or from other systems or subsystems, moving in serial or parallel
form, for example sending serial data to an external memory.

With this plethora of data coming and going, it is likely we will need to have a variety of digital
inputs and/or outputs. These are divided broadly into serial and parallel. In serial data transfer,
the information is transferred one bit at a time. Only a single interconnection is used to carry
the data itself, although other lines are usually included for synchronisation and control. In
parallel data transfer, a set (for example, eight) of interconnections is used. Each of these can
carry 1 bit, and each works in parallel with the others. Data can thus be transferred in groups of
bits, for example in bytes. Parallel input/output (I/O) is the workhorse for all the basic data
interchange of a microcontroller, including interfacing with switches, LEDs, displays and so
on. A group of parallel I/O interconnections, appearing on the pins of the microcontroller, is
called a ‘parallel port’.

3.2 The technical challenge of parallel input/output

Our immediate challenge is how to provide the required interface between the microcontroller
data and address buses and the outside world. As suggested above, we start with the data bus,
a multi-purpose data highway. How can we grab the data we want from the bus, and transfer it
to the outside world, via the parallel port? Alternatively, how can we take external input data
and introduce it onto the data bus, at the right time and place, so that it gets to the right place
within the microcontroller? Finally, given a port that can do these things, how can we make it
really flexible, so that it can be used for input, or output, or a mixture of both, and can transfer
a combination of data with possibly very different end uses?
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3.2.1 Building a parallel interface

It should be simple to create a set of output pins to create an ‘output’ port (Figure 3.1). Let us
assign an address in the memory map to the port. Whenever that address is selected by an
instruction in the program, it activates a line called ‘Port Select’. A further line, ‘Read/Write’,
indicates whether the CPU is undertaking a Read (line is high) or Write (line is low) oper-
ation. This is gated with the Port Select line. Each line of the data bus is connected to

a bistable, and all of these are clocked by the Port Select line. Then the value of the data bus is
latched into the bistable whenever the port memory location is addressed, in Write mode. The
outputs of the bistables are made available for connection to the outside world.

It is equally simple to create a set of input pins (Figure 3.2). All that is needed is a tristate
buffer gate connected between an external pin and a line of the data bus. When the buffer is
enabled, again by a logical combination of Port Select line and Read/Write control, the
logic value of the external pin is briefly connected to the data bus line, and can be read
by the CPU. Note that in this design the external data is not latched by the port; it must be
held at a stable value by the external source.

Two lines of
data bus
Read/Write D Q L] .
o \ External pin
Port Select /
Flip-flop latches data bus value onto
High whenever external pin, when memory location
port address is is selected, AND Write is active
selected

D Q (] |
\ External pin
%

Figure 3.1: Two bits of a possible digital output port
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Two lines of
data bus

Read/Write D .
\ N External pin

J Buffer transfers logic value on external pin
onto data bus line, when memory location
is selected, AND Read is active

Port Select

| { ]
l\ N External pin
my,

Figure 3.2: Two bits of a possible digital input port

These ideas are quite attractive, but the reality is that it is inflexible to limit an external pin of
an IC to just one function, whether input or output. It would be much neater to combine
somehow the two circuits used for input and output, and let the user decide in which direction
he/she wants the data to move. The diagram of Figure 3.3 does just that. It shows

a possible ‘pin driver’ circuit for one bit of a parallel port. It is easy to pick out in it the circuits
of Figures 3.1 and 3.2. What must be added, however, is a further flip-flop (‘Direction’),
which is set to determine whether this microcontroller pin is to act as an input or output. The
state of this flip-flop is set by the program. It controls the ‘Output buffer’, which is enabled
when the port bit is in output mode.

This circuit forms the basis for a very useful bi-directional input/output pin driver, and it is
easy to find versions of it in many popular microcontrollers. Sets of I/O pins are grouped
together to form a parallel I/O port. Each ‘Data’ flip-flop then forms one bit of a ‘Data’ SFR
(Special Function register), and each ‘Direction’ flip-flop forms one bit of a ‘Direction’ SFR,
as seen in Figure 3.3. Each SFR is memory mapped, with its own unique address. Derived from
that address is its select line, which goes high when that location is addressed. ‘Port Select’
selects the Data SFR and ‘Direction Select’ selects the Direction SFR.

By writing to the Direction SFR the user can determine which bits are to be input and which
are to be output. By writing to the Data SFR he/she can set the value of all Data flip-flops,
whether that pin is actually set as an output or not. This value is transferred to the I/O pin
through the buffer for those pins which are enabled as outputs. By reading from the Data SFR
the program can acquire the logical value of the I/O pin. If the pin is set as output, this value is
simply the value held by the Data flip-flop and asserted on the I/O pin through the Output
buffer. If the pin is set as an input, then an external signal should be connected to the pin, and
the controller will read its value.
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Read/Write }
Py ~ Read port
Data bus
- ©
(bit n) Input buffer
\ / ‘Data’ I/O pin
Write Output buffer (bit n of an
port ¢ D Q 8-bit port)
Port Select] —~[Holds bit ‘
output value
“T"[80ofth
; - E?pcz opgsfgrm ’ Buffer, gngbled
Lo K J the ‘Data’ SFR when pin is output
; /" ‘Direction’
Write | / ’
DDR ;~ |D Q
\ ! ~ ;
Direction Select ! Determines whether port
/ , bit is input or output
/ //I \ Alternate Input ‘
; S Function
DawSFR /S 7 N
| | | | | | | I 8 of these ip- ops form
- .7 the ‘Data Direction’ SFR

‘Direction’ SFR

Figure 3.3: A bi-directional port pin driver circuit

Having established this basic design, it is possible to extend it further to add other features. We
will see this when we look at some PIC microcontroller examples. One simple extension is
already indicated in Figure 3.3, however. This is the ‘Alternate Input Function’ line, which
allows an internal peripheral to share the I/O pin.

3.2.2 Port electrical characteristics

Logic gates are designed to interface easily with each other, and if we connect logic gates from
just one family together then we usually don’t need to worry about the electrical details of
what is going on. If, however, we are connecting logic devices (in this case microcontroller
port bits) to non-logic elements (like LEDs or switches) then we do need to understand the
electrical characteristics of the logic. In particular, we need to understand their input and
output characteristics.

The output of a logic gate can be visualised, or ‘modelled’, as in Figure 3.4(a). Purists will
recognise the limitations of this model, but for our purposes it will suffice. If the output is at
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a b

Internal Logic 1 voltage
is the supply voltage

Switch is in this
position when
output is at Logic 1

L

Switch is in this
position when
output is at Logic 0

Internal Logic 0
voltage is ground

Figure 3.4: Modelling a logic gate output. (a) Generalised model. (b) Model of Complementary
Metal Oxide Semiconductor (CMOS) logic gate output

Logic high (or ‘1’), then the internal switch is in the upper position. It is in the lower position for
Logic 0. In either case, the output is modelled as a voltage source in series with a resistor

(in circuit theory this is called a “Thevenin equivalent’ circuit). Vp g is the logic high-output
voltage, with an output resistance of Rgign). VL 18 the logic low-output voltage, with an output
resistance of Rgjow).

In the case of CMOS (Complementary Metal Oxide Semiconductor) the situation is quite
simple, as Vp y is equal to the supply voltage and Vit is equal to O V. This is illustrated in
Figure 3.4(b). Thus, if the supply voltage is 5 V, then Logic 0 and 1 will be 0 and 5 V
respectively, if no current is being drawn from the gate output.

In practice, Rgnigh) and Rs(ow) are not constant, but depend to some extent on the current being
sourced or sunk from the gate output. Therefore, manufacturers frequently publish graphical
information on the output characteristics. We will see this shortly for the 16F84A.

3.2.3 Some special cases

We review now two special types of I/O characteristic, which will be important as we explore
the 16F84A parallel ports.

Schmitt trigger inputs

A Schmitt trigger (Figure 3.5) is a certain type of logic gate input which is designed to ‘clean
up’ a corrupted logic signal. It has two input thresholds, with the ‘positive-going’ higher than
the ‘negative-going’. A signal starting from a low value has to pass the negative-going
threshold (at which point nothing happens) and then cross the ‘positive-going’ threshold, at
which point the output changes state. The output will not reverse until the input (now negative-
going) has returned to the negative-going threshold. Thus, small fluctuations which recross
a threshold just crossed do not cause any change in output.
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a Positive going
threshold \
VI NN
% V. NN
: 0 Negative going /
threshold
Vo

Figure 3.5: Schmitt trigger characteristics. (a) Buffer with Schmitt trigger input. (b) Input/output
characteristic

The ‘Open Drain’ output

The Open Drain output is a flexible style of output that can be adapted either as a standard logic
output, as a direct drive for small loads, or used for a special logic function known as ‘Wired-
OR’. The output itself is as illustrated in Figure 3.6(a). A logic gate drives the gate of

a MOSFET (Metal Oxide Semiconductor Field Effect Transistor), whose unconnected Drain
terminal forms the output. When the MOSFET gate drive is high, the FET conducts and a logic
zero is asserted at the terminal. When the gate is low the FET will not conduct and (with

no other connection) the terminal will be at an undefined voltage. If a pull-up resistor is
connected from the Drain to the supply voltage, then the output acts more or less as a normal
logic output. Without the active pull-up of a normal logic output, however, its rise time will be
a little sluggish and the amount of current it can source will be limited by the resistor value.

The Open Drain output can also be used to drive a simple load, acting as illustrated in
Figure 3.6(b). Usefully, the load does not have to be supplied from the same voltage as the
logic supply, although it would have to be of the same polarity. Therefore, for example,

a microcontroller supplied from 5 V (Vs in the diagram) could drive a load supplied from
12 V (Vs in the diagram), if all operating requirements are met.

Another important application of the Open Drain output is the “Wired-OR’ connection, shown in
Figure 3.6(c). Here several Open Drain outputs are connected together and tied high through
a single pull-up resistor, Rpy. If all outputs are off, then the common line (V) is high. If any one
output goes low, then the common line is pulled low. This is a possible way of achieving the OR
or NOR logic function, and important for certain types of serial link, as we shall see later.

3.3 Connecting to the parallel port

3.3.1 Switches

Switches are extensively used in embedded systems. Our main initial interest is not to switch
directly a voltage or current, but to convert the switch position to a logic level that can be read
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a A b Vs Vs
External
load

—0O
I
H H
K K
| H ] H
ST ST
c Vs
Any output driven low Rpy
pulls this line low
/ Common output line
1 I ¢ 1 Vo =A+B+C
H H H
Kq K Kq
L H __ B H __ ,C H
77 ST 77

Figure 3.6: The Open Drain output and some applications. (a) An Open Drain output. (b) Open
Drain output driving load resistor. (c) The Wired-OR connection

by a microcontroller port bit. Switches are used as a direct user interface in the form of
push-buttons, toggle switches, slide switches, or as thumbwheel or rotary switches. They are
also used, in the form of microswitches, to detect certain types of mechanical movement.

The simplest way of deriving a logic level from a switch is shown in Figure 3.7(a). This
shows a Single-Pole, Double-Throw (SPDT) switch, with one terminal connected to ground
and the other to the supply. The switch wiper simply selects one of these two as the logic
input. Some logic families advise against direct connection of a logic input to the supply
voltage, so a series resistor (shown dotted) might be in order.

There is a slight disadvantage to the connection of Figure 3.7(a) as it requires the SPDT switch.
A simpler option, using just a Single-Pole, Single-Throw (SPST) switch, for example a push-
button, is shown in Figure 3.7(b). Here a pull-up resistor is connected to one terminal of the
switch, with the other terminal connected to ground. If the switch is closed, then the input

to the logic gate, V}, is 0 V and a current V/R flows to ground. If the switch is open then Vg is
equal to Vs. To reduce wasted current when the switch is closed, the value of R should be high.
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Figure 3.7: Connecting switches to logic inputs. (a) SPDT connection. (b) SPST with pull-up
resistor. (c) SPST with pull-down resistor

If it is too high, however, then the Logic 1 level that it is meant to define may not be properly
sustained. To evaluate the upper limit of the pull-up resistor, the input leakage current and logic
thresholds need to be applied (as demonstrated in Chapter 2 of Ref. 1.1). For PIC micro-
controllers, pull-up values in the range 10-100 k€2 are usually appropriate. The circuit of
Figure 3.7(b) is very useful and widely applied, as many simple switches (e.g. PCB (Printed
Circuit Board) mounting slide switches and push-buttons) are only available as SPST.

The switch circuit of Figure 3.7(b) can be reconnected as in Figure 3.7(c). The characteristics of
some logic families (for example, TTL (Transistor—Transistor Logic)) do, however, place re-
strictions on the use of this circuit, as the current sourced from the gate input significantly affects
the action of the pull-down resistor. The circuit can be applied with PIC microcontrollers.

3.3.2 Light-emitting diodes

In certain semiconductor materials light is emitted as current flows across a forward-biased
p—n junction. LEDs exploit this phenomenon. LEDs made of gallium arsenide (GaAs) emit
light in the infrared, and if phosphorus is added in increasing proportions the light moves to
visible red and ultimately to green. LEDs are widely available in red, green and yellow, as
single devices, and as arrays, bargraphs and alphanumeric displays.

Because they are diodes, LEDs display the normal voltage—current relationship of a forward--
biased diode. This means that, to a reasonable approximation, the voltage across an LED is
constant if it is conducting. Note, however, that this forward voltage is considerably higher for
GaAs than it is for silicon. Example LED characteristics, for red and green Kingbright LEDs, are
shown in Figure 3.8. From these graphs it can be seen that the voltage across the red LED
changes from 1.90 to 2.00 V if the current increases from 5 to 20 mA. For the green it changes
from 1.95 to 2.20 V for the same current range. These voltage values are typical for all LEDs of
similar type, with red having a slightly lower forward voltage compared to green or yellow.

The different colours do not give equal intensities for equal drive currents, as shown by the
data in Figure 3.8. Red is the most efficient, which may account for its greater popularity.
For a single LED to be comfortably visible, it typically requires around 10mA of current.
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Figure 3.8: Example Kingbright LED characteristics [Ref. 3.1]. (a) High-efficiency red. (b) Green.
Reproduced with permission of Kingbright Elec. Co. Ltd

Brighter ones may require up to 20 mA, but special low-power devices (such as the high-
efficiency red) need as little as 1 or 2mA to be seen.

An LED can be driven from a logic output, for example a microcontroller port, as long as its
current requirements can be met. Depending on the capabilities of the port output they can be
connected so that the output is sourcing current (Figure 3.9(a)) or sinking current

(Figure 3.9(b)).

CMOS logic families have symmetrical outputs and can source or sink almost equally well,
so either of these circuits can be applied. In contrast, TTL logic can source little current but
can sink a comparatively large amount, and therefore the configuration of Figure 3.9(b) is
preferred in this case.

A current-limiting resistor must normally be included in series with the LED. This is calcu-
lated as shown below by considering the voltages in the circuit. Precise values are not usually
required.

For current source: Vog = RIp + Vp

Vou Vp G.D
Ip

R =

For current sink: Vg = Vor, + RIp + Vp

Vs Vb VoL (3.2)
Ip

R =
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Figure 3.9: Driving LEDs from logic gates. (a) Gate output sourcing current to LED. (b) Gate
output sinking current from LED

An exception to the need for a series resistor, which must be cautiously applied, is when the
logic is powered from a comparatively low voltage, and its internal output resistance itself
forms an appropriate value for the current-limiting resistor.

3.4 The PIC 16F84A parallel ports

We saw in Chapter 2 that the 16F84A has two ports, A and B. A is 5-bit, while B is 8-bit.
Notice from Figure 2.1 that some port bits have more than one function. We will see that the
16F84A adapts the generic pin driver circuit of Figure 3.3 and cleverly weaves in these extra
functions.

The SFRs that relate to the ports are seen in Figure 2.5. In each case the port data itself appears
in the PORTA or PORTB register (i.e. these act as the ‘Data’ SFR of Figure 3.3), while
the data direction is determined by the bit values set in the TRISA or TRISB registers

(i.e. these act as the ‘Direction’ SFR of Figure 3.3).

We will now explore the ports in further detail. Perhaps the most straightforward is Port B,
with which we accordingly start.

3.4.1 16F84A Port B

This is a general-purpose 8-bit bi-directional port, with a pin driver circuit similar to that in
Figure 3.3. The simplest bits, O to 3, are illustrated in Figure 3.10(a). The data latch can be seen
in each circuit, while the “TRIS latch’ in Figure 3.10 replaces the ‘Direction’ latch of the
earlier diagram. It can be seen that if the ‘TRIS latch’ output is set to 0, then the buffer that it
drives is enabled and the port bit is in output mode.
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Figure 3.10: Block diagram of Port B pin driver circuits. (a) Pins RB3 to RBO. (b) Pins RB7 to RB4
(supplementary labels in shaded boxes added by the author)

There are four enhancements to the simple pin driver circuit we saw earlier:

o The incoming data is latched, through the lowest latch in the diagram, rather than just its
instantaneous value being read.

e The state of the “TRIS latch’ can be read via the buffer controlled by the RD TRIS line.
It follows that the TRIS register acts as a normal read/write memory location, and the
program can check if necessary the values previously stored there.

e Bit 0 is also the external interrupt input and has a Schmitt trigger interface.

o ‘Weak pull-up’ resistors can be switched on for all port bits used as inputs. These can be
applied to replace the resistor in circuits like in Figure 3.7(b). The pull-up is imple-
mented with a p-channel MOSFET, seen at the top of the diagram. They are enabled for
all port bits set as input by clearing the bit RBPU in the OPTION register. (This is seen
memory-mapped in Figure 2.5 or in full in Figure 6.9.)

Bits 4 to 7 of Port B are seen in Figure 3.10(b). They have a useful ‘interrupt on change’
facility. As with the lower-numbered bits, the data value is latched as input data is read. On
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Figure 3.11: Block diagram of Port A pin driver circuits. (a) Pins RAO, 1, 2 and 3. (b) Pin RA4/
TOCKI (supplementary labels in shaded boxes added by the author)

these bits, however, the previous input value, from the last time the port was read, is retained
on another latch. Its stored value is compared with the current input value. Any difference is
detected by an Exclusive OR gate, whose output can generate an interrupt. This capability will
be considered in detail in Chapter 6.

3.4.2 16F84A Port A

Like Port B, this can be used as a general-purpose bi-directional digital port. The basic port pin
driver (Figure 3.11(a)) is very similar to the Port B pin. The diagram this time draws out in
full the output tristate buffer. Bit 4 (Figure 3.11(b)) doubles as the Timer 0 clock input. It also
has a Schmitt trigger input characteristic and an Open Drain output, as described in Section
3.2.3. The full device data indicates that the absolute maximum permissible voltage applied to
this Open Drain pin is 8.5 V. Therefore, the ability to drive an external load from a supply higher
than the microcontroller itself can only be applied in a limited way.
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Figure 3.12: 16F84A port output characteristics. (a) Vo, vs. Ion (Vbp 3V, 40 to 125°C).
(b) Vo, vs. Io, (Voo 3V, 40 to 125°C) (dashed lines added by the author)

3.4.3 Port output characteristics

The 16F84 A port output characteristics are shown in Figure 3.12 for a supply voltage of 3.0 V.
In Figure 3.12(a) we see (at 25°C) how the output voltage for Logic 1 is 3 V when the output
current is 0, but falls to around 1.7 V when the output current is 10 mA, flowing out of the
gate. Similarly, in Figure 3.12(b) we see (at 25°C) how the output voltage for Logic O is
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0V when the output current is 0, but rises to around 0.8 V when the output current is 22.5 mA
(flowing into the gate). It is curves like these that can be used to find the Vg, and Vg values
used in equations (3.1) and (3.2) once a value for I is known. Graphs are also given in
the full data for characteristics with a 5 V supply.

Another way of applying these curves is to deduce from them an approximate output
resistance. This can be done by measuring the gradient of the curve at a particular point.

A simple construction to do this has been added to each plot. By dividing vertical (voltage) by
horizontal (current) for each of these, output resistances of approximately 130 {) when at Logic
high and 36 Q when at Logic 0 can be deduced. If we call these two values Roy and Rop.
respectively, equations (3.1) and (3.2) can be written in a different form:

For current source: Vs = (R + Ron)Ip + Vp

Vs V, (3.3)
R="_""0 po
Ip

For current sink: Vs = (R + Rou)Ip + Vb

V. (3.4)
rR=Vs Yo po
Ip

3.5 The clock oscillator

The choice of microcontroller clock source determines some of its fundamental operating
characteristics. While ‘faster is better’ in terms of operating speed and program execution,
faster is definitely worse in terms of power consumption, and also possibly in terms of
electromagnetic interference. All timed elements within the microcontroller almost
invariably depend on the clock characteristics. If stable and accurate timing is required,
then the clock oscillator must be stable and accurate. With these points in mind, the clock
source must be chosen with care and understanding. This section starts with a review of the
clock technologies available, before moving on to looking at the options offered with the
16F84A.

3.5.1 Clock oscillator types

Broadly, there are two types of oscillator circuit in common use in microcontrollers, as
illustrated in Figure 3.13. In the resistor—capacitor (RC) type (Figure 3.13(a)), a capacitor is
charged through a resistor from the supply rail. The capacitor voltage drives the input of
a Schmitt trigger buffer. When the Schmitt trigger threshold is exceeded, its output goes
high, switching on the MOSFET transistor to which it is connected. The capacitor is
quickly discharged, the Schmitt output goes low, the MOSFET is switched off and the
charging process starts again. This continues for as long as power is maintained. The clock
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Figure 3.13: Microcontroller oscillator generator circuits. (a) Resistor-capacitor (RC). (b) Crystal
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or ceramic

signal is taken from the rectangular waveform generated at the Schmitt output. This simple
circuit is integrated onto many larger ICs requiring a clock signal. Users are then usually
required to connect resistor and capacitor externally, choosing these to set the desired
frequency. It is important to note, however, that RC oscillators can be implemented entirely
on-chip. They are very low-cost and produce a clock signal very reliably. As resistor,
capacitor, power supply and Schmitt trigger threshold values all vary with temperature,
their frequency is not very stable. They cannot therefore be used where precise timing is
required.

The crystal oscillator (Figure 3.13(b)) depends on the piezo-electric properties of quartz
crystal. Any mechanical distortion of the material causes a voltage to be produced across
opposite sides of it; similarly, if a voltage is applied to the material, a mechanical distortion
results. Crystals are carefully cut into very thin slices (usually discs), have tiny electrodes
attached and are mounted so that they can vibrate. When connected in the feedback path
across a logic inverter, as the figure shows, the crystal can be forced through piezo-electric
action into mechanical vibration. This translates into electrical oscillation, an oscillation
that is sustained by the action of the logic gate. Small-value capacitors connected from
either side of the crystal to ground optimise the electrical conditions needed for this
oscillation.

Crystal vibration occurs at a fixed and remarkably stable frequency — this is the great
advantage of the crystal oscillator. The crystals themselves tend to be on the expensive side
(although cost continues to fall) and mechanically fragile. An alternative is the ceramic
resonator. This has similar piezo-electric properties to the crystal and is connected in an
identical way. It is, however, both lower in cost and rather less stable in frequency. Crystals
are the only option when precise timing functions, derived from the clock oscillator, are
required.



Parallel ports, power supply and the clock oscillator 67

3.5.2 Practical oscillator considerations

All microcontroller manufacturers go a long way towards making it easy to create a clock
waveform for their microcontrollers. Usually, this is done by including the circuits of Figure 3.13,
possibly in merged form, on-chip. One may be forgiven, therefore, for thinking that setting

up the oscillator on a microcontroller is a straightforward thing — in fact it isn’t, and unreliable or
non-functioning oscillators are a cause of real frustration with novice builders. Oscillator
frequency shows greater or lesser dependence on supply voltage, temperature, humidity, PCB
layout and possibly other factors. Crystals in particular are sensitive to poor PCB layout. It

is important to exclude parasitic resistance, capacitance or inductance by having very short PCB
tracks, therefore locating the crystal close to the body of the microcontroller.

3.5.3 The 16F84A clock oscillator

The 16F84A can be configured to operate in four different oscillator modes, allowing
implementation of RC, crystal or ceramic oscillators. These are detailed below. It can also
accept an external clock source. The user selects which mode is to be used by setting bits in the
Configuration Word (Figure 2.6).

o XT — crystal. This is the standard crystal configuration. It is intended for crystals or
resonators in the range 1-4 MHz.

e HS — high speed. This is a higher drive version of the XT configuration. It recognises that
higher-frequency crystals, and ceramic resonators in general, require a higher drive
current. It is intended for crystal frequencies in the region of 4 MHz or greater, and/or
ceramic resonators. It leads to the highest current consumption of all the oscillator modes.

e LP —low power. This mode is intended for low-frequency crystal applications and gives
the lowest power consumption possible. In many cases this will be 32.768 kHz (i.e. 219),
which is the most popular frequency for low-power, time-sensitive applications, for
example wristwatches. It will, however, operate at any frequency below around 200 kHz.

e RC - resistor—capacitor. For this an external resistor and capacitor must be connected
to pin 16, replicating the circuit of Figure 3.13(a). This is the lowest-cost way of getting
an oscillator, but should not be used when any timing accuracy is required. The nominal
frequency of oscillation can be predicted with limited accuracy only, and even then it
will drift with changing temperature, supply voltage and time. An example of a use of
the RC oscillator appears in the electronic ping-pong game case study at the end of this
chapter.

As seen in Figure 3.1, the 16F84A has two oscillator pins, OSC1 (pin 16) and OSC2 (pin 15).
Between these lies a logic inverter and associated circuitry. Figure 3.14 shows the possible
oscillator configurations that can be connected using these pins. Either a crystal or a ceramic
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Figure 3.14: Ways of supplying a clock waveform to the 16F84A. (a) Crystal or ceramic, HS, XT
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can be connected to create the oscillator circuit of Figure 3.14(a). Any of the three speed
ranges outlined above can be invoked through the Configuration Word. An RC oscillator can
also be used, as shown in Figure 3.14(b). The approximate oscillation frequency can be
selected by consulting graphical information given in the ‘Electrical Characteristics’ section of
the data sheet, for example as seen in Figure 3.15. Finally, an external clock source can simply
be connected to the OSCI1 pin (Figure 3.14(c)). Further guidance on oscillator design for
Microchip microcontrollers can be found in Ref. 3.2.
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Figure 3.15: Average resistor-capacitor oscillator frequency vs. Vpp for variable R, C 100 pF, 25°C
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3.6 Power supply

3.6.1 The need for power, and its sources

Like any electronic circuit, a microcontroller and the overall embedded system need to be
supplied with electrical power. Traditionally, much logic circuitry is supplied at 5 V, arising
from the voltage specified for the TTL family. With the growth in battery-powered equipment
and developments in electronic technology, supply voltages have been pushed down, and 3.3
and 3.0 V supplies are now common.

Operating conditions for electronic components are specified in the manufacturer’s data sheet.
In terms of power supply there are two important issues: the supply voltage required and
the current that the device will then take from the supply. This supply current will be
dependent on operating frequency. Also given are ‘absolute maximum ratings’, which give
voltage and power dissipation levels beyond which the device must not be taken.

3.6.2 16F84A operating conditions

The essential operating conditions of the 16F84A are shown in Figure 3.16. From this it can be
seen that a supply voltage of between 4.0 and 5.5 V is required, unless the HS oscillator mode
is used. In this case the supply voltage must not be below 4.5 V. In ‘Sleep’ mode (when all
program execution is suspended and the oscillator is switched off), the supply voltage can be
dropped right down to 1.5 V and the data in RAM is still retained. If operation from lower
supply voltages is required, then the 16LF84A should be used.

Looking further down the table, we see how much supply current depends on oscillator fre-
quency. A typical supply current of 1.8 mA can be expected when running at 4 MHz with

a supply voltage of 5.5 V. If the oscillator frequency is increased to 20 MHz, then the supply
current rises to 10 mA. It’s worth mentioning that both these values are actually very good, and
compare well with many other, more power-hungry microcontrollers. If we want to operate

at really low currents, however, then look what the 16LLF84A offers at low frequency —

a staggering 15 pA!

You may recognise that, for a battery-powered system, the required supply voltage of the
16F84A makes a three-cell alkaline battery supply a useful option. This gives a supply
of around 4.5 V. Suppose you powered the system with three AA cells, each with a
nominal capacity of 800 mAh. Running at 1.8 mA would give a battery life of 444 hours,
or 18.5 days. Running at 10 mA would give 80 hours, or 3.3 days, while 15 LA con-
sumption would lead to 53 333 hours, equivalent to 2222 days or just over six years! In this
case battery self-discharge would potentially be significant. The above calculations of
course only take account of the consumption of the microcontroller, and not of any other
parts of the circuit.
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PaNr:m Symbol Characteristic Min | Typt| Max |Units Conditions
Vo Supply Voltage
Doo1 16LF84A| 2.0 | — | 55 | V [XT, RC, and LP osc configuration
D001 16F84A 40 | — | 55 V |XT, RC and LP osc configuration
DOO1A 45 | — | 55 | V [HS oscconfiguration
D002 |VDR RAM Data Retention 15| — | — V |Device in SLEEP mode
Voltage (Note 1)
D003 |VPOR VDD Start Voltage toensure | — | Vss | — V |See section on Power-on Reset for details
internal Power-on Reset
signal
D004 |SvbD VoD Rise Rate to ensure 005 — | — |VIms
internal Power-on Reset
signal
IDD Supply Current (Note 2)
D010 16LF84A| — 1 4 mA |RC and XT osc configuration (Note 3)
Fosc = 2.0 MHz, VDD = 5.5V
D010 16F84A| — | 1.8 | 45 | mA [RC and XT osc configuration (Note 3)
Fosc = 4.0 MHz, VDD = 5.5V
DO10A — 3 10 | mA |RC and XT osc configuration (Note 3)
Fosc = 4.0 MHz, Vop = 5.5V
(During FLASH programming)
D013 — | 10 | 20 | mA |HS osc configuration (PIC16F84A-20)
Fosc = 20 MHz, Vbb = 5.5V
D014 16LF84A| — 15 | 45 | pA |LP osc configuration
Fosc = 32 kHz, Vbp = 2.0V, WDT disabled

Note 1: This is the limit to which Vp can be lowered without losing RAM data.
Note 2: Gives further information on factors that influence supply current.
Note 3: Gives guidance on how to calculate current consumed by the external RC network, when this is used.

Figure 3.16: The 16F84A basic operating conditions

An important opportunity for conserving power is through Sleep mode. This is introduced in
Section 6.6 of Chapter 6.

3.7 The hardware design of the electronic ping-pong game

The electronic ping-pong game project was introduced in Chapter 1. Its circuit diagram can be
seen in Appendix 2, Figure A2.1. We are now in a position to understand every detail of its
circuit design, with the exception only of the programming connections, which appear top
right of the diagram. These should be disregarded for now. Power is supplied from two AAA
cells, which are connected to the Vsg and Vpp pins of the microcontroller via an on off switch.
Because the power supply is only 3 V, an LF version of the microcontroller is used. A 100 nF
decoupling capacitor across the power supply smooths voltage spikes which may be induced
as a result of the action of the microcontroller internal circuitry. MCLR is simply tied to the
supply rail, as no Reset function is needed for this simple game.
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It can be seen that an RC oscillator is used. This is reasonable, as it is a cost-conscious
application with no time-critical elements. Figure 3.15 shows that for the values used, and with
a supply voltage of 3.0 V nominal, the oscillator frequency will be 800 kHz.

Let us now look at the use of the parallel ports. It can be seen that the two player paddles,
connected to bits 3 and 4 of Port A, follow the pattern of Figure 3.7(b), with 10-kQ pull-up
resistors. The score and out-of-play LEDs take up the remaining bits of Port A, and the ‘ball
flight’ LEDs are all connected to Port B. All LEDs are high-efficiency types and are connected
according to Figure 3.9(a). Noting the approximate 130 € output resistance derived in Section
3.4.3 of this chapter, the total resistance in series with each LED is (560 + 130) Q. With

a forward voltage across the LED of around 1.8 V, the current is given by applying equation
(3.3), i.e.

I=(3 1.8)/(560+ 130) = 1.7 mA approx.

This current value is just adequate for this type of application and LED, where only close-up
viewing is expected. It would in general be viewed as low.

We will be using the ping-pong hardware in the chapters which follow to develop a number
of programs. It is helpful, though not essential, to have your own ping-pong hardware in
order to run these. If you do this, you will also need access to a programming tool, as de-
scribed in Chapter 4. The ping-pong hardware can be built at low cost by using a prototyping
kit, or on stripboard or PCB. Check the book web site if you want to find a way of building
your own.

Summary

o The parallel port allows ready exchange of digital data between the outside world and the
controller CPU.

e It is important to understand the electrical characteristics of the parallel port and how
they interact with external elements.

e While there is considerable diversity in the logic design of ports, they tend to follow
similar patterns. The internal circuitry is worth understanding, as it leads to effective use
of ports.

o The 16F84A has diverse and flexible parallel ports.

e A microcontroller needs a clock signal in order to operate. The characteristics of the
clock oscillator determine speed of operation and timing stability, and strongly influence
power consumption. Active elements of the oscillator are usually built in to
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a microcontroller, but the designer must select the oscillator type, and its frequency and
configuration.

e A microcontroller needs a power supply in order to operate. The requirements need to be
understood and must be met by a supply of the appropriate type.
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Questions and exercises

Note: The first three questions provide useful insight into the workings of a port driver circuit.
If you have a limited electronics background you may wish to skip them, or seek assistance
from an instructor or colleague.

1. For the logic diagram of Figure 3.1, complete the timing diagram of Figure 3.17.
The bus line indicated is either line of Figure 3.1, and the ext. pin is its corresponding
input/output pin.

2. For the logic diagram of Figure 3.2, complete the timing diagram of Figure 3.18. The bus
line indicated is either line of Figure 3.2, and the ext. pin is its corresponding input/output
pin. The hatched area at the beginning of the bus line trace indicates here that the value
cannot be determined from the information available. You will need to use this symbolism
again later in the same trace.

3. For the logic diagram of Figure 3.3, complete the timing diagram of Figure 3.19. Qp;y,. is
the Q output of the bistable labelled ‘Direction’, and Qpg, is the Q output of the bistable
labelled ‘Data’.

Read/Write | /

Port Select \_/ \_/ _ \_
Bus Line - - \ /

Ext. Pin

Figure 3.17: Timing diagram for Question 1
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Read/Write \ /o N\ / -
| |
Port Select i \ / \

Ext. Pin

Bus Line ““
|

Figure 3.18: Timing diagram for Question 2

Read/Write / \

Port Select

Direction
Select

Data Bus
(bit n)

Read port

Write port

Write DDR

QDim.

Q Data

I/O Pin

Figure 3.19: Timing diagram for Question 3

A CMOS port output is modelled as shown in Figure 3.4(b). It is powered from 5V. The
value of Rgn;gn) 1S estimated to be 120 Q and the value of Rg(jow) 70 (. One port pin will light
an LED when it is at Logic 1, and another will light an LED when it is at Logic 0. An
LED current of 4 mA is required; for this the LEDs have a forward voltage of 1.8 V. Sketch
a circuit showing how each LED is connected and calculate appropriate resistor values.

Looking at the ping-pong circuit diagram in Figure A2.1, determine what words should
be placed in each of TRISA and TRISB in order for each port bit to act correctly as
input or output.
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o O
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Figure 3.20: LED pattern for electronic device

6. A push-button switch is connected to a microcontroller port input, using an external pull-up
resistor. The supply voltage is 3.3 V.

(a) Sketch the circuit of this arrangement.

(b) As it is a power-conscious application, the current drawn when the switch is closed
should not be more than 20 LA. What is the minimum pull-up resistor value?

(c) The port input is known to have a worst-case input leakage current of 5 LA, flowing
into the input. What is the actual input voltage for the resistor value calculated above
when the switch is not pressed?

7. Four Port B bits of a 16LF84A are used as outputs; two will drive green LEDs and two
will drive red. Kingbright LEDs are to be used, with characteristics as shown in
Figure 3.8. The red LEDs are to be lit with a current of 5 mA when the associated port bit
is at Logic 1. The green are to be lit with a current of 12 mA when the bit is at Logic 0.
The power supply is 3 V. Calculate the values of the series resistors needed. Is there
a reason why the green LEDs are lit with a Logic O output?

8. Propose which oscillator type should be chosen for each of the 16F84A-based applications
listed below, giving reasons.

(a) Scientific instrument control system, requiring intensive calculations and precisely
timed outputs.

(b) Low-cost toy, timing not of high significance.
(c) Hand-held, battery-powered stopwatch.

(d) Human interface controller for mains-powered studio mixing desk; some precise
timing required, but speed requirements modest.

9. Draw a complete design for the hardware of a hand-held electronic die, based on
a PIC 16F84A. The output should be 7 LEDs, in the pattern shown in Figure 3.20. There
should be one push-button to initiate a die ‘roll’, and an on—off slide switch. Do not include
any programming interconnection.



Starting to program —
an introduction to Assembler

Embedded system design is made up of two main aspects, the hardware and the software. In
the early days of microprocessors, systems were built up laboriously using a large number of
integrated circuits (ICs). Memory was very limited, so only small programs could be written.
Slowly the available ICs became more and more sophisticated, and the designer had to do less
to get a working hardware system. Meanwhile memory was growing, so longer programs
could be written. Now we are in a situation where memory is plentiful and cheap and the
hardware is sophisticated and readily available. Complex hardware systems can be built up
with comparative ease, and in many projects software development is now the main creative
activity. In this chapter we start down the long but exciting road to developing good programs.
We start that road using the Assembler programming language, but later in the book continue it
using the high-level language C.

We have one problem if we are to start programming. What will the program run on? Ulti-
mately of course embedded systems programs are written to run on the target system hardware.
You may be working with an educational PIC hardware system, or you may have the electronic
ping-pong hardware. In many cases, however, we don’t want to be dependent on hardware to
try out a programming idea. What can really cause a study of programming to spring to life is
a simulator — a program running on a desktop computer that will run the program we have
developed. Therefore we make it a priority in this chapter to introduce the Microchip MPLAB
Integrated Development Environment, and the simulator in it. Once you have the skills to use
this, most program ideas can be tried out very quickly, and you should be able to make rapid
progress in the noble but tricky art of microcontroller programming!

In this chapter you will learn about:
e Some aspects of the underlying issues of computer programming.
o The essentials of Assembler programming, and how to write simple Assembler programs.

e Development environments for programming, and the Microchip MPLAB Integrated
Development Environment.

e The PIC 16 Series instruction set in overview.

Designing Embedded Systems with PIC Microcontrollers; ISBN: 9781856177504
Copyright © 2010 Tim Wilmshurst. All rights of reproduction, in any form, reserved.
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e The use of certain PIC 16 Series instructions.
e Simulating software, and the MPLAB software simulator MPSIM.
e Program download to a target system.

You will also, if you wish, be able to learn about:

o The details of how the PIC 16 Series instruction word is constructed.

4.1 The main idea — what programs do and how we develop them

The four main ideas of computer programming, according to this author, are listed here:
e A computer has an ‘instruction set’; it can recognise each instruction and ‘execute’ it.

e The program that the computer executes is a list of instructions drawn from its in-
struction set; it reads these in binary from its program memory. The program in this form
is called ‘machine code’.

e To execute, the computer works relentlessly through the instructions of the program
from the beginning, doing exactly what each instruction tells it to do — nothing more,
nothing less — except when temporarily diverted by an interrupt.

So far this is simple, but here is the difficult one:

e The programmer must find a means of breaking down and translating his/her ideas into
steps that the computer can undertake, where each step ultimately must be an instruction
from its instruction set.

4.1.1 The problem of programming and the Assembler compromise

The problem of programming is summarised in Figure 4.1. We as humans express our ideas in
complex and often loosely defined linguistic forms. A computer reads and ‘understands’
binary, and responds in a precise way to precise instructions. It is ruthlessly logical and does
exactly what it is told.

Given this linguistic divide, how can a programmer write programs for a computer? Three
ways of bridging the gap present themselves.

1. The human learns machine code. This is what programmers used to do sometimes in the
very early days, laboriously writing each instruction in the binary code of the computer,
directly as the computer then read it. This is incredibly slow, tedious and error-prone, but at
least the programmer relates directly to the needs and capabilities of the computer.
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Figure 4.1: The problem of programming

2. Use a high-level language (HLL). This is as if we go some way to asking the computer to
learn our language. In a HLL instructions are written in a form that relates in a recognisable
way to our own language, in the case of people reading this book probably English. An-
other computer program, either a compiler or an interpreter, then converts that program into
the machine code that the computer can comprehend. The programmer now has a much
easier time and can write very sophisticated programs. He/she is now, however, separated
from the resources of the computer and the program may be comparatively inefficient in
terms of its use of memory and in its execution speed.

3. Use Assembler. This is a compromise position. Every instruction is given a ‘mnemonic’.
This is usually a three- or four-letter word that can be used to represent directly one in-
struction from the instruction set. The programmer then writes the program using the in-
struction mnemonics. The programmer has to think at the level of the computer, as he/she is
working directly with its instructions, but at least the programmer has the mnemonics to
use, rather than actually working with the computer machine code. A special computer
program called a ‘Cross-Assembler’, usually these days run on a PC, converts the code
written in mnemonics to the machine code that the computer will see. Because there is
a computer doing the conversion from the Assembler code to machine code, a number of
other benefits can be built into the process. For example the Cross-Assembler can look after
most of the business of allocating memory space in program memory and it can accept
labels for numbers and memory locations, greatly easing the programmer’s task.

In the early days of computing, programmers used Assembler to program almost any type of
computer. These days, however, it is pretty much the preserve of embedded designers, partic-
ularly when using smaller 8-bit devices. For the embedded designer Assembler offers the huge
advantage that it allows him/her to work directly with the resources of the computer, and leads to
efficient code which executes quickly. Because it is so directly linked to the computer structure,
working in Assembler helps the user to learn the structure of the computer. Programming in
Assembler has the disadvantage that it is rather slow and error-prone, and does not always
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produce well-structured programs. This conundrum we will aim to resolve in later chapters. For
now, in order to write simple programs and understand the microcontroller more, we will learn
Assembler.

4.1.2 The process of writing in Assembler

The actual process of writing in Assembler is illustrated in Figure 4.2. The programmer writes in
the microprocessor or microcontroller Assembly language. This can be done using nothing
more than a text editor. We will soon recognise the two lines of Assembler program in Figure 4.2
as being from the PIC 16 Series instruction set. The computer that is being used for writing runs
the Cross-Assembler. The terminology Cross-Assembler implies that one computer is assem-
bling code for a computer of another type, not for itself. Usually, and somewhat confusingly,
Cross-Assembler is shortened simply to Assembler. The Cross-Assembler ‘assembles’ the
program, i.e. it converts it from Assembler mnemonics into machine code ready for

the microcontroller. In Figure 4.2 the Cross-Assembler is seen converting the two lines of as-
sembler code into the 14-bit machine code words of the PIC 16 Series. For most microcontrollers
there are then special programming tools which can download the program in machine code
from the main computer and program it into the microcontroller program memory.

4.1.3 The program development cycle

The process of writing in Assembler needs to be placed in the broader context of project
development. The possible stages in the development process for the program of a simple

| am writing in the
Assembler language
movilw 2a

movwf portb

| am running a program
called a Cross-Assembler
movilw 2a = 11 0000 0010 1010
movwf portb = 00 0000 1000 0110

| load the machine code
which the computer
sends me into the
microcontroller
program memory

Figure 4.2: Programming in Assembler
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Write Source Code
Assemble/compile

(Simulate)

v

Download

v

Test in hardware

Figure 4.3: Developing a simple project

embedded system project are shown in Figure 4.3. The programmer writes the program, called
the ‘Source Code’, in Assembler language. This is then assembled by the Cross-Assembler
running on the host computer. If the programmer has access to a simulator then he/she may
choose to test the program by simulation. This is likely to lead to program errors being dis-
covered, which will require alteration to the original source code. When satisfied with the
program, the developer will then download it to the program memory of the microcontroller
itself, using either a stand-alone ‘programmer’ linked to the host computer or a programming
facility designed into the embedded system itself. He/She will then test the program running in
the actual hardware. Again, this may lead to changes being required in the source code.

Clearly, to develop even a simple project, a selection of different software tools is beneficial.
These are usually bundled together into what is called an ‘Integrated Development Environ-
ment’ (IDE).

4.2 The PIC 16 Series instruction set, with a little more on the ALU

Before looking at the 16 Series instruction set, it is worth taking a more detailed look at its ALU
(Arithmetic Logic Unit). Understanding this will help in understanding the instruction set.

4.2.1 More on the PIC 16 Series ALU

Looking at the ALU, shown in Figure 4.4, we see that it can operate on data from fwo

sources. One is the W (or ‘Working’) register. The other is either a literal value, or a value
from a data memory (whose memory locations Microchip call ‘register files’). A literal value
is a byte of data that the programmer writes in the program and is associated with a particular
instruction. Thus we can expect to see some instructions that call on data memory, and others
that require literal data to be specified whenever they are used. Examples of all will follow!
The data that the instruction operates on, or uses, is called the ‘operand’. Operands can be
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Literal instructions

Figure 4.4: Block diagram of the PIC 16 Series ALU

data or addresses. We will see that some types of instruction always need an operand to be
specified with them; others do not.

Once an instruction has been executed, where is the result stored? For many instructions
Microchip offer a choice, whereby the result can either be held in the W register or stored back
in data memory. The one that is used is fixed by certain instructions; in others it is determined
by the state of a special d bit, which is specified within the instruction.

4.2.2 The PIC 16 Series instruction set — an introduction

Turn now to the PIC 16 Series instruction set, which can be found in Appendix 1. Take a long
hard look at it — we are aiming to get to know it extremely well! You can see that the table is
divided into six columns, and each of the 35 instructions gets one line. The first column gives
the actual mnemonic, together with the code specifying the type of operand it acts on. There
are four such operand codes:

f for file (i.e. memory location in RAM), a 7-bit number;

b for bit, to be found within a file also specified, a single bit;
d for destination, as described above, a single bit;

k for literal, an 8-bit number if data or 11-bit if an address.

The second column summarises what the instruction does. In some cases this gives adequate
information. A much fuller description of how each instruction works can also be found in the
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full microcontroller data [Ref. 2.1]. The third column shows how many cycles the instruction
takes to execute. With a RISC processor, we expect this to be a single cycle. This turns out to
be the case, apart from those instructions that cause a branch in the program. We discuss their
use in Chapter 5. The fourth column gives the actual 14-bit opcode of each instruction. This is
the code that the Cross-Assembler produces as it converts the original program in Assembler
language to machine code. It is interesting to see here how the operand codes, listed above,
become embedded within the opcode. The fifth column shows which bits in the Status register
(Figure 2.3) are affected by each instruction.

Let usimmediately look at six representative example instructions, to see how the information is
presented. As an aside, let us note now that Assembler programming does not have to be case-
sensitive, and that all the examples in this book are not case-sensitive. Therefore do not worry if
you see instruction mnemonics and operands appearing in either upper or lower case in different
references. In this book, for stylistic reasons, we choose to write Assembler programs in lower
case. Find now each of the instructions below in the Instruction Set table in the appendix.

clrw This clears the value in the W register to zero. There are no operands to specify.
Column 5 tells us that the Status register Z bit is affected by the instruction. As the result
of this instruction is always zero, the bit is always set to 1. No other Status register bits
are affected.

clrf £ This clears the value of a memory location, symbolised as f. It is up to the pro-
grammer to specify a value for f, which will need to be a valid memory address. Again,
because the result is zero, the Status register Z bit is affected.

addwf f,d This adds the contents of the W register to the contents of a memory location
symbolised by f. It is up to the programmer to specify a value for f. There is a choice of
where the result is placed, as discussed above. This is determined by the value of the
operand bit d. Because of the different values that the result can take, all three condition
code bits, i.e. Z, the Carry bit C, and the Digit Carry bit DC are affected by the instruction.

addlwk This instruction adds a ‘literal’, i.e. an 8-bit number written into the program and
represented by K, to the value held in the W register. Like the addwf instruction, The Z,
C and DC Status register bits can all be affected by the instruction.

bef f,b  This instruction clears a single bit in a memory location. Both the bit and the
location must be specified by the programmer. The memory location is symbolised by f.
The bit number b will take a value from O to 7 to identify any one of the 8 bits in
a memory location. No Status register flags are affected, even though it is possible to
imagine that the result of the instruction could be to set a memory location to zero.

goto k This instruction causes the program execution to jump to another point in the
program, whose address is given by the constant k. It is up to the programmer to give
a value for k. No Status bits are affected.
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4.3 Assemblers and Assembler format

4.3.1 Introducing Assemblers and the Microchip MPASM Assembler

For any microprocessor or microcontroller, there are a large number of (Cross-)Assemblers
available. Some are distributed free by the makers of the processors to encourage people to buy
their products. Others, usually more sophisticated, are written by specialist software houses
and sold commercially. Many these days come as part of an IDE, as mentioned in Section
4.1.3. This book uses MPASM, the Assembler offered by Microchip. It is usually used as part
of the MPLAB IDE, and both MPASM and MPLAB are introduced in some detail later in this
chapter and the next.

While many aspects of Assembler programming are common across all Cross-Assemblers,
some are specific to the particular Assembler that is in use.

4.3.2 Assembler format

Having taken a first look at the instruction set, we need now to understand how we can build
these instructions into a line of code and then into a program. Assembler programs have

a simple format, which must be understood and followed. This is shown in Program
Example 4.1.

| label | | mnemonic| |0perand| | comment|

start bsf status, 5 ;select memory bank 1
movlw B'00011000';config pattern for port A
movwf trisa

movlw 53

Program Example 4.1: Assembler format

There are four possible elements to an Assembler line of code:

o [Label. A label for a line is optional. When it is first specified, the label must start in the
left-most space of the line. The Assembler will interpret anything starting in this space as
a label. Once defined in this way, a label can be used as an operand. Labels must start
with an alphabetic character or underscore, but not a number. Labels can stand alone on
a line, in which case the label is adopted by the next line that contains an instruction.

o [nstruction mnemonic. This is drawn from the instruction set. It may be placed anywhere
on the line, except starting at the far left. It should be separated from any label by at least
one blank space.
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e Operand. These must conform exactly to the format specified in the instruction set. For
better intelligibility, labels are often used rather than numbers. If there is more than one
operand they are separated by a comma.

e Comment. This is optional, and is used to add information to the program and improve
its intelligibility to the human reader. A comment must always start with a semi-colon.
The Cross-Assembler ignores everything that follows a semi-colon in any line. Comments
can follow instructions on a line; alternatively a whole line can be used just for
commenting.

A line of an assembler program can contain an instruction, properly formatted as above.
Alternatively it can be a comment only, or it can be left completely blank — this sometimes
helps to improve layout and readability.

4.3.3 Assembler directives

While the Assembler program is written for the target microcontroller, it has to be processed
by the Assembler first. To aid this process and make it more powerful and flexible, a way

is needed of passing information and instructions to the Assembler such that it recognises them
as being for its attention only. These instructions are called ‘Assembler directives’. They are
used for very diverse applications, for example defining the target processor or specifying
where the program must be placed in memory. A few MPASM examples are shown in
Table 4.1. These are written in the code, and appear almost like mnemonics from the in-
struction set. Their very distinct role must, however, be recognised.

4.3.4 Number representation

One of the things about working close to the inner operations of a microcontroller is that
sometimes one is thinking in binary, sometimes in decimal, and sometimes in hexadecimal or

TABLE 4.1 Some common MPASM Assembler directives

Assembler directive Summary of action
list Implement a listing option*
#include Include another file within the source file;

the included file is embedded within the source file

org Set program origin; this defines the start address
where code which follows is placed in memory

equ Define an assembly constant; this allows us to
assign a value to a label

end End program block

“Listing options include setting of radix and microcontroller type.
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TABLE 4.2 Number representation in MPASM Assembler

Radix Example representation
Decimal D'255"

Hexadecimal H'8d’ or 0x8d
Octal 0'574"

Binary B*01011100"

ASCII ‘G’ or A'G’

even octal. Therefore it is helpful for the Assembler program to be able to recognise and
respond to different number bases. MPASM does this first by allowing a default to be set. Thus
for example if one wants to work only (or mainly) in hexadecimal, then all numbers can be
interpreted as such. Any number that the programmer wants to represent in an alternative radix
must be prefixed, as shown in Table 4.2. In Program Example 4.1, for example, the pro-
grammer is writing for a default radix of hexadecimal. In the second line of the example,
however, he wishes to specify a number in binary, so therefore uses the appropriate format
from Table 4.2. In the fourth line he is using the hexadecimal number 53 as an operand. As
hexadecimal is the default radix, its number base does not need to be explicitly specified.

Note that a hexadecimal number must not start with an alphabetic character; otherwise, it
might be interpreted as a label. Therefore any hexadecimal number starting with a, b, ¢, d, e
or f must be preceded with a zero. Thus for example the number b2y must be entered as Ob2, or
0xb2.

4.3.5 A very first program

Let’s now look at Program Example 4.2. This is a simple but complete program and contains
the key Assembler features which have just been described. It uses only instructions from
those introduced in Section 4.2.2 and directives from Table 4.1.

,-*************‘k**~k*******************************‘k***‘k‘k*‘k‘k‘k‘k*‘k***‘k*
;Very first program

;This program repeatedly adds a number to the Working Register.
;TJW 1.11.08 Tested 1.11.08

P R R R R R S
7
7

; use the org directive to force program start at reset vector

org 00
;program starts here
clrw ;jclear W register
loop addlw 08 ;add the number 8 to W register
goto loop
end ;show end of program with "end" directive

Program Example 4.2: A first program
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The program starts with a header made up of five comment lines, each starting with a semi-
colon. These give the program title, briefly describe what the program does, and give the date it
was written and its author. They are not essential, but become increasingly important as
program length grows.

Before the actual program starts the org directive must be used to define the start address. We
have no choice over this — it must be the Reset Vector address, as seen in Figure 2.4. If the
address is fixed, you may ask why it can’t be stored within MPLAB to save the trouble of
having to state it. In longer programs we may need to write program blocks at different
locations; hence the control over start address is left with the programmer.

The program which follows uses only three instructions. It first clears the W register. The
following instruction has been given the label loop. It adds the number 8, embedded into the
instruction as a ‘literal’ value, to the W register. The following goto instruction, using the label
loop as its operand, causes the program to return to the add instruction, which it does re-
peatedly. The W register therefore repeatedly increments by the value 8. The end of the
program is defined with an end directive.

This is a complete program and we will soon try assembling and simulating it. It has little
practical use of course, mainly because there is neither input nor output of data. That is what
we explore later in the chapter.

4.4 Adopting a development environment

4.4.1 Introducing MPLAB

MPLAB is an IDE that can be downloaded free from Microchip’s web site [Ref. 1.2]. There
is also a copy on the book’s companion website. It contains all the software tools necessary
to write a program in Assembler, assemble it, simulate it, and then download it to a pro-
grammer. The latter must be built, bought or designed into the target system. Further
software tools can be bought and then integrated with MPLAB, both from Microchip and
from other suppliers. This includes alternatives to what MPLAB already offers — e.g. as-
semblers or simulators, as well as tools which offer much greater development power, like
C compilers or emulator drivers.

MPLAB is a continuously evolving package, with its own manuals [Refs. 4.1 and 4.2] and
online help facility. Therefore this book does not aim to act as a full MPLAB manual. It
will, however, aim to give a clear introduction to its use so that you can begin to apply it
with confidence. Screen images from MPLAB Version 8.10 are used in this chapter and
the next.
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4.4.2 The elements of MPLAB

MPLAB is made up of a number of distinct elements which work together to give the overall
development environment. These are:

o Project Manager. The preferred way of developing programs in MPLAB is by creating
a project. An MPLAB project groups all the files together that relate to the project and
ensures that they interact with each other in an appropriate way and are updated as
needed.

e Text Editor. This allows entry of the source code. It behaves to some extent like
a simple text editor such as Notepad, but it can recognise the main elements of the
programming language that is being used. Thus in Assembler it codes instructions in
one colour, labels in another and comments in a third. In this way the programmer can
immediately see if there is a misconception in his placing or use of text within the
Assembler line.

o Assembler and Linker. The function of the Assembler has already been discussed. So far
we have assumed that there is a single source file. In advanced projects, however, the
code may be created from a number of different files. The role of the Linker is to put
these together, give each its correct location in memory, and ensure that branches and
calls from one file to the other are correctly established.

o Software Simulator and Debugger. A software simulator allows a program to be
tested by running it on a simulated CPU in the host computer. Inputs can also be
simulated and outputs and memory values can be observed. The debugger contains
the tools which allow program execution to be fully examined, for example by single
stepping through the program, running at slow speed, or halting at a particular
location.

4.4.3 The MPLAB file structure

Even with simple projects, a significant number of files are rapidly generated in MPLAB. Each
type is designated by the file extension used, of which examples are given in Table 4.3.
Whenever a project is set up, files of type .mcp and .mcw are created. When using Assembler,
the original source code is written in a file with the .asm extension. The source code may
include an .inc file, to be described in Chapter 5. When the source code is assembled
successfully, the output appears in .Ist, and .hex files. If there is an error, is placed in an .err file.

4.5 An introductory MPLAB tutorial

This tutorial takes you through the stages of creating a project, writing simple source
code and assembling it to create output files. To follow the tutorial, you should download
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TABLE 4.3 Some file extensions used in MPLAB IDE

.asm Assembly language source file
.err Error file

.hex Machine code in hex format file
.inc Assembly language Include File
lib Library file

st Absolute listing file

.0 Object file

.mcp Project information file

.mcw Workspace information file

and install the current version of MPLAB if it is not available in your place of work or
study.

Open the MPLAB IDE, which should appear as Figure 4.5. If a blank Output window also
opens, close it. The main screen is blank, apart from the Workspace window at the top left. It is
a good idea to leave this permanently open, as it will give essential information about the
project you are working on. If it does not appear, or if you close it, you can display it again by
clicking View > Project.

Checksum: BIIUZ

s bank

Figure 4.5: The MPLAB IDE screen
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Project Wizard...

New...

Open...

Close »
Set Active Project »

Quickbuild (no .asm file)

Build Configuration »
Build Options... 4
Remove File From Project »

Sek Language Tool Locations...
Version Control...

Figure 4.6: Project pull-down menu

4.5.1 Creating a project

Click the Project button on the toolbar to access the pull-down menu, as shown in Figure 4.6.

There are two ways to create a project, both accessible from this menu. One is by using the
Project Wizard, and the other is by selecting New... . Try following the Project Wizard route,
making the following selections as you work through the dialogue boxes:

Step One
Device: PIC16F84A
(click Next)
Step Two
Active Toolsuite: Microchip
MPASM Toolsuite
which will display:
MPASM Assembler
MPLINK Object Linker
MPLIB Librarian
as Toolsuite Contents
(click Next)
Step Three
Click Browse to select a folder, enter the name of the project you want,
and click Save
(click Next)
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Step Four
Do not add any further files
(click Next)
Summary
The essential project features which you have just chosen will be displayed.
(click Finish)

When you click Finish, the workspace window should be updated to show the filename you
have selected, as seen in Figure 4.7(a) for a project called fred. If the window does not display,
click View > Project.

a
[ Tmew
= [ fred. —
(& fredmcp ; = ] fred.mcp*

| Source Files = ;
[Z Header Files =1 Source Files
(2 Object Files ) fred.asm
(2 Library Files 1 Header Files
(3 inker Seript 1 Object Files
[ Other Files (0 Library Files

(21 Linker Script
(L Other Files

& FiIest ’Lt Symbols I

?# Symbols

For a newly created project For a project with source file added

Figure 4.7: Workspace window
4.5.2 Entering source code

Now open a new file by clicking File > New and start to enter into it the program of Program
Example 4.2. After a few lines save this using File > Save As.... Select file type Assembly
Source File and save as <your project name>.asm. Continue entering the code, and notice
now that MPLAB has identified this file as an Assembler Source File. It applies colour-coding
to labels, instruction mnemonics, numerical data, assembler directives and comments. When
complete, go to the Project menu again, click Add Files to Project... and select the one you
have just saved. Your workspace window should now appear as Figure 4.7(b), with of course
your own file names. You will now begin to appreciate how valuable this window is to become,
as it shows a complete picture of the files associated with your project.

4.5.3 Selecting the microcontroller and setting the Configuration Word

There are two important settings to be checked or made, which both appear under the
Configure tag on the toolbar at the top of the MPLAB screen. The first of these is device
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"

Device: Device Family:

[v] [aLL [v]
Microchip Toal Support

Programmers

@ PICSTART Plus (2) MPLABICD 2 @ PICkit2

{2} PROMATE Il @ PICKit1

{2 MPLAB PM3 @ MPLABREALICE

Language and Design Tools
{2) ASSEMBLER @ COMPILER @ VDI
¥3.90

Dehuggers
@ MPLAB SIM @ MPLABICD 2 @ PICkit2
@ MPLAB REALICE
MPLAB ICE 2000 MPLAB ICE 4000 ICE/ICD Headers
(D PCM1BXH1 @ No Module @ Mo Header
(DPCM16XH2
i QK ] [ Cancel i I Help J

Figure 4.8: Selecting the device

selection. Click Configure > Select Device to get the screen shown in Figure 4.8. If you set up
the project by using the Project Wizard, you will have already selected the microcontroller,
and at this point it should show the 16F84A. Also shown on the screen are the development
tools which are available to work with that device, indicated by green ‘LEDs’. If you didn’t
select the device through the Project Wizard, ensure that the correct microcontroller is se-
lected. It is always worth checking this setting, even if defined in the project set-up, as it is
possible for it to be changed accidentally. If the wrong device is selected there may be
problems with the assembly process.

Under the Configure pull-down menu you can also select Configuration Bits, as shown in
Figure 4.9. These are very important when you actually download to a microcontroller; they
are less so when just simulating. For our early program simulations, just ensure that the
Watchdog Timer is turned off, as shown in the figure.

4.5.4 Assembling the project

Now comes one of the testing moments in the development of any project. You have entered
new source code and you need to know if it assembles correctly. The Assembler subjects your
code to a series of checks. It returns errors if it finds incorrect use of Assembler format,
instruction mnemonics, labels, or a range of other things. Remember, however, that the
Assembler can effectively only check that your program is correct grammatically; it cannot
assure you that it is a viable program. Above all else, it has no knowledge of the target
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] Configuration Bits set in code.

Address Value Category Setting
2007 Oscillator RC
Watchdog Timer Off
Power Up Timer On
Code Protect Off

Figure 4.9: Setting the configuration bits

hardware, beyond the fact that the microcontroller has been specified. Correct assembly does
not guarantee correct program operation!

Check that the default radix is correctly set by clicking Project > Build Options > Project >
MPASM Assembler, and ensuring that Hexadecimal is selected in the dialog box. In the same
dialog box you can enable or disable case sensitivity for all the source codes. This is not
necessary if you have directly copied Program Example 4.2. You may need to use it in future,
however.

Invoke the MPASM Assembler by selecting Project > Build All. This also ensures all files are
updated as needed. The Output window will open, reporting on the progress of the build. In the
output window you will either get a BUILD SUCCEEDED or BUILD FAILED, message
together with a fleeting box showing a green bar (for success) or red (for errors).

If you get neither green nor red bar and the message in the Output window suggests that
the process has failed to start properly, then it is worth checking that the software tools

are properly selected and located. Select Project > Select Language Toolsuite, and

ensure Microchip MPASM Toolsuite is selected. If there are still problems, select Project >
Set Language Tool Locations, and ensure that the different elements of the MPASM Toolsuite
are shown as being in the locations where they are installed on your computer.

4.5.5 The list file and identifying errors

Whether your build has initially succeeded or failed, open the file <your project name> lst.
This should be in the directory you specified for the project. Use File > Open and ensure
you select All Files in the dialog box against Files of Type. The .1st file is very informative. Part
of the list file for Program Example 4.2 is shown as Program Example 4.3. The file gives first
the original source code; each line is numbered, beginning with number 00001. To the left of
this, once the actual instruction mnemonics appear, is the assembled machine code and

the memory location in which it is placed. Thus the clrw instruction is assembled to code 0103
and placed in memory location 0000. Because of the quantity of information displayed, there
is some line overflow in the figure. The number of errors and warnings that may have been
generated is shown below.
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LOC OBJECT CODE LINE SOURCE TEXT
VALUE

Q00O QL ;% % Kok k ok ok ok ok ok ok ok ok ok ok X ok % ok ok ok ok ok ok ok Kok ok K ok K ok ok K ok ok K ok Kk ok K ok ok K ok Kk ok K ok

00002 ;Very first program
00003 ;This program repeatedly adds a number to the Working

Register.
00004 ;TJw 1.11.08 Tested 1.11.08
00005 ;********************************************************
00006 ;
00007 ; use the org directive to force program start at reset
vector
0000 00008 org 00
00009 ;program starts here
0000 0103 00010 clrw ;clear W register
0001 3E08 00011 loop addlw 08 ;add the number 8 to W register
0002 2801 00012 goto loop
00013 end ;show end of program with "end" directive
Program Memory Words Used: 3

Program Memory Words Free: 1021

Errors : 0

Warnings : 0 reported, 0 suppressed
Messages : 0 reported, 0 suppressed
..... etc

Program Example 4.3: Part of the introductory program list file

Programming Exercise 4.1

Insert a deliberate error in this file by changing the goto loop line to goto loop1. Build
the project and look at the list file again. You will see that Error 113 has been invoked.
Click the MPLAB Help and follow Topics > MPASM Assembler > Index. Then select
Errors > Assembler. You will see all error numbers and their descriptions displayed.
Return to your program and correct the error.

In many cases errors are simply typographical and can easily be fixed by correcting the source
code and building again. A few may require careful study of the error description, and ex-
ploration of the underlying cause.

In general, once you have a source file which builds correctly, you are in a position either to
download to microcontroller memory or to simulate. For now we continue on the simulation
path. At the end of your development session, close the current project using Project >
Close.

4.6 An introduction to simulation

The following section introduces the MPLAB simulator, MPSIM, by means of a tutorial,
simulating Program Example 4.2.
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4.6.1 Getting started

In MPLAB, open your project for Program Example 4.2 by clicking Project > Open. Then
select the Simulator by invoking Debugger > Select Tool > MPLAB SIM. The simulator
menu, as seen in Figure 4.10, will now appear under Debugger.

4.6.2 Viewing microcontroller features

You can observe a number of microcontroller features during simulation, including program
memory, SFRs, data memory, and so on. It is possible to open a window for each of these,
using the View menu. If you do this, however, you will find that the screen very quickly be-
comes cluttered.

A Watch window allows you to make selections of only those variables you want to see, while
leaving out the others. Open a Watch window by clicking View > Watch. Items for the window
are then selected by using the pull-down menus at the top of the window. Using the Add SFR
menu, select WREG, PCL, and STATUS. The Watch window should appear as seen in
Figure 4.11, although you are likely to have arranged the windows differently. In this image we
see the source file in the centre, with the Watch window below it.

4.6.3 Resetting and running a program

When a microcontroller is powered up, it first enters a Reset state, as explained in Section 2.6.
This ensures that when the program starts running, it does so from the Reset Vector. Similarly,

Select Tool 4
Clear Memory »

Run F9
Animate

Step Into F7
Step Over F&
Step Out

Reset »

Breakpoints. ., F2

StopWatch

Complex Breakpoints
Stimulus 4
Profile 4

Refresh PM

Settings...

Figure 4.10: Simulator menu
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File Edit View Project Debugger Programmer Tools Configure Window Help

- iVery firs
= (L] abs_intro_prog.mcp ery first progrm
iThis program repeatedly adds a nuuber to the Uorking Register.
& = Th tedly add: maber te the Uorking Regist
= L Source Fiies Tasted 1.11.08
[2] abs_intro_grog.asm T T L Tt T T T TS
(1 Header Filas ;
(1 object Files ; use the org diractiva to force progran FLart &t reset vector
(L Library Files e . D: N
: sprogram starts here
clrw selear U register
(1 Linker Script 5 Eo
(2 other Files loop addlw 08 ;add the muber 8 vo U register
goto loop
B riee end sshow end of program with "end" directive

P[] (e R [v]

Address | Symbol Neme | Valus Hex

0z PCL 0x00 0x00
WREG 0x08 0x08
03 STATUS 0x18 0x18

Walch1 | Watch 2 | Watch 3| Watch 4

Figure 4.11: MPSIM set up to simulate Program Example 4.2

when using the simulator you need to start from Reset. You can reset the simulated CPU either
using the F6 button or by clicking Debugger > Reset. Using the latter, four Reset categories are
offered, reflecting the Reset capabilities of the PIC microcontroller (Section 2.7). Alternatively
(and more simply) you can use the Reset button of the Debugger toolbar (Figure 4.12). If this is
not displayed, invoke it by selecting View > Toolbars > Debug. The simulated CPU of
Figure 4.11 has just been reset, so the arrow representing the program counter is pointing to the
first instruction. This can be confirmed by checking the PCL value in the Watch window.

There are three ways to run the program. Each can be selected via the Debugger pull-down
menu or by clicking the buttons on the tool-bar. These are:

Run Animate Step Over | | Reset

N Y S

p b POHEO

VA A WA

Halt Step Into Step Out | | Breakpoints
(single step)

Figure 4.12: MPSIM software simulator Debugger toolbar
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o Single step. This allows you to step through the program one instruction at a time. This
version of MPLAB uses the terminology Step Into for this mode.

e Animate. This is like an automated single step. The program runs slowly but continu-
ously, with the screen being updated after each instruction.

e Run. This runs the program, but does not update on-screen windows as it runs. It does,
however, accept stimulus input.

It is also possible to Step Over a subroutine, or Step Out of one. Each of these also has a button
on the toolbar. These are especially useful for delay routines, which on a simulator may take an
unacceptably long time to simulate.

Now, by repeated pressing of the Step Into button, single-step through the program. As you do
this, you will see the PCL value being incremented in the Watch window, and the other
register values changing. Program execution then circles around the loop formed by the last
two instructions. Try now pressing the Animate button. Notice that the program runs con-
tinuously, updating the W register as it does so. Stop the animation with the Halt button.
Try changing the animation speed by clicking Debugger > Settings > Animation/Realtime
Updates, and modifying the Animate Step Time.

This is a useful moment to take a first look at the operation of the Status register (Figure 2.3),
which we have already placed in the Watch window. It is easier to read this if the value is
presented in binary, so right click on the Value button in the Watch window and then click on
Binary. Binary equivalents to the Hex data already displayed should now show in a further
column. Reset the program and start stepping through it using Step Into. Watch the least
significant three bits of the Status register, which are the Zero, Digit Carry and Carry bits.
Notice that when the W register value goes from 8 to 16p, and then on every alternate addition,
the Digit Carry bit is set. This is because there is a carry from the less significant digit (i.e. the
least significant 4 bits), to the more significant. Keep looping until the W register holds 248 p.
Make a further addition of 8, which should lead to a value of 256p. However, this is a 9-bit
number, and we have now overflowed the 8-bit range. Therefore the Carry bit (effectively

a ninth bit when adding) is set. The Zero and Digit Carry bits are also set, as the W register now
holds zero, and because there was a carry between digits.

4.7 A larger program - using data memory and moving data

The next example, Program Example 4.4, makes use of data memory, simple addition and data
move instructions. It generates a Fibonacci series, as described in the header.

To use data memory, the first thing to check is the memory map, as seen for the 16F84A in
Figure 2.5. In this program four memory locations are needed, three to hold the most recent
numbers in the series and one to hold temporary data. While there are a number of ways of
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allocating data memory, a simple and effective one is to reserve certain locations perma-
nently for certain variables. This is what is done here. The memory map shows that memory
locations in the address range 0Cy to 4Fy are available. In this program the locations from
20y to 23y have been arbitrarily chosen. Labels corresponding to memory location addresses
have been defined using the equ directive, for example:

fib0 equ 20 ; lowest number

The action of this line of code is only this: wherever the word fib0 is used after this line, it

will be replaced by the number 20y. It is worth observing here that we have now seen label
values being assigned in two different ways. Some, like porta or fib0, are assigned a specific
value by the programmer, using the equ directive as we have just seen. Others, like the label
forward, are inserted into the program, and the Assembler itself allocates them a value.

Aside from the instructions introduced in Section 4.2.2, this program makes use of these move
instructions:

movwf f This moves the contents of the W register to the memory location f.

movf f,d This instruction moves the contents of the memory location f to the W register,
ifthe d bit is set to 0; if it is set to 1 then the contents of f are just returned to f (but the Z
bit may still change).

movlw k  This instruction moves the literal value k, an 8-bit number which accompanies
the instruction, into the W register.

The program starts by preloading the three first numbers in the series, 0,1,1, into the reserved
memory locations. Location fib0 is simply cleared using a clrf instruction. The value 1 is
loaded into fib1 and fib2. To do this we need to specify a number and load it into a memory
location. There is, however, no way of doing this in just one instruction. The number must first
be moved into the W register with a movlw instruction, before being transferred to the memory
location with a movwf instruction. We will often see these two instructions working together
to make this sort of data transfer.

Starting at the label forward, the program starts calculating the next value in the series by
adding the two most recent numbers. The instruction set does not allow the direct addition
of two memory locations. One location therefore, fib1, is moved first to the W register. This
is done using a movf instruction, with the d bit set to 0. The W register is then added to
fib2. Because the d bit is set to 0 again, the result is saved in the W register. The next
instruction moves it to fibtemp. The program then shuffles the numbers held in the memory
locations, retaining the three most recent values and discarding the oldest. Using a goto
instruction, the program then loops back to forward, and starts to calculate a new member
of the series.
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,.*****************************‘k*************‘k*********************************
;Fibo _simple

;In a Fibonacci series each number is the sum of the two previous ones,

;e.g. 0,1,1,2,3,5,8,13,21....

;This program calculates Fibonacci numbers within an 8-bit range.

;Program intended for simulation only, hence no input/output.

;TJW 6.11.08 Tested by simulation 6.11.08

KKk ok Kk ok K ok ok ok ok Kk ok K ok kK ok kK ok K ok ok K ok ok K ok K ok ok K ok ok K ok ok K ok K ok K ok kK ok ok K ok K ok ok K ok ok K ok K ok ok K ok K ok ok kK K ok

;these memory locations hold the Fibonacci series

£ib0 equ 20 ;lowest number
fibl equ 21 ;middle number
fib2 equ 22 ;highest number

fibtemp equ 23 ;temporary location for newest number

org 00

;preload initial values

clrf fibO0 ;jclear location fibO

movlw 1 ;move value 1 to W register

movwf fibl ;move W register to fibl

movwf fib2 ;move W register to fib2
forward movf fibl,0 ;move the contents of fibl to W register

addwf £ib2,0 ;add W reg to fib2

movwf fibtemp ;move new number formed to fibtemp
;now shuffle numbers held, discarding the oldest (ie f£ib0)

movf £fibl, 0 ;move fibl to W register

movwf fib0 ;move W register to fibO

movf fib2,0 ;move fib2 to W register

movwf fibl ;move W register to fibl

movf fibtemp,0 ;move fibtemp to W register

movwf fib2 ;move W register to fib2

goto forward

end

Program Example 4.4: Generating a Fibonacci series

Programming Exercise 4.2

Create a project around this program, copying the source code from the book’s com-
panion website. Simulate it in a manner similar to that already described. In the Watch
window observe the W register, and fib0, fib1, fib2 and fibtemp. These can be selected
using the Add Symbol menu.

This is a useful program to illustrate certain instructions and also to simulate. Without
input and output it still does not have practical value. This we come to in the section that
follows.

4.8 Programming for a target piece of hardware - a simple data
transfer program

While the first two example programs we have seen are just written for simulation, in reality
we will be writing for a target piece of hardware. A number of things become important. The
configuration bits (see Figure 2.6) will need to be set. This can be done within the MPLAB
IDE, or actually in the program itself. In addition to this, as we will now be moving data in and
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out of the microcontroller, we will inevitably need to use one or more peripherals; these will
need to be set up in the program.

We now look at a program written for a target piece of hardware, in this case the electronic
ping-pong game (Appendix 2). The program appears as Program Example 4.5.

,-******************************************************************
;Ping-pong data move

;This program moves push button switch values from Port A to the
;leds on Port B

;TIW 21.2.05 Tested 22.2.05

,-******************************************************************
7

;Configuration Word: WDT off, power-up timer on,

; code protect off, RC oscillator

;specify SFERs

status equ 03

porta equ 05

trisa equ 05

portb equ 06

trisb equ 06
org 00

;Initialise

start bsf status, 5 ;select memory bank 1
movlw B'00011000"'
movwf trisa ;port A according to above pattern
movlw 00
movwf trisb ;all port B bits output
bcf status, 5 ;select bank 0

7

;The “main” program starts here

clrf porta ;jclear all bits in ports A
loop movf porta, 0 ;move port A to W register

movwf portb ;move W register to port B

goto loop

end

Program Example 4.5: A simple data transfer program

The program starts with a header made up of six comment lines, similar to the earlier pro-
grams. Information on the configuration setting, fundamental to the running of the micro-
controller, is then given. Following this approach, it is up to the programmer to set the
Configuration Word correctly in MPLAB, as described in Section 4.5.3.

A section follows which uses the equ directive to define the memory locations of the SFRs that
will be used. It comes as some surprise to many people that it is necessary to do this. Don’t we
‘tell’ the IDE what the processor is, so shouldn’t it ‘know’? The answer is that it doesn’t, so we
must supply this information. This program just uses the Status register, Ports A and B, and
their control registers TRISA and TRISB. Labels for these are therefore defined, taking
memory addresses directly from the memory map of Figure 2.5. Remember (from Section
2.4.2) that the Bank Select bit is held in the Status register. Once this is removed from the SFR
addresses shown in Figure 2.5, the labels porta and trisa, and portb and trisb, have the same
values. In the program it would make some sense to use just one label for each of these
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pairs, instead of the two. We choose not to do this in this program example for better clarity
when the different locations are used.

The actual program, following the org line, makes use of seven instructions. The two which
have not so far been used are:

bef f,b  This clears (i.e. sets to logic 0) the bit b in memory location f.

bsf f,b  This sets to logic 1 the bit b in memory location f.

The program starts with an initialisation section — we will see this as a pattern in all future
programs. This sets up the direction of each bit in the two ports that are used; it requires access
to the port control registers TRISA and TRISB. As these are placed in RAM memory bank 1,
it is necessary first of all to set bit 5 of the Status register to 1 (as explained in Section 2.4.2).
This is done in the first program line, labelled start, using the bsf instruction. The label status
can be used because it was defined earlier in the program. If this had not been done, then it
would have been necessary to write:

start bsf 3,5; select memory bank 1

which would have an identical effect but would have been somewhat less intelligible.

The port pin directions needed are derived from the circuit diagram, Figure A2.1. From this we
can see that the two push buttons connect to bits 3 and 4 of Port A, which must accordingly be
set up as inputs. The three other bits of Port A are all connected to LEDs, so must be set up as
outputs. As described in Section 3.4, to be an output a port pin must have a 0 in its corre-
sponding TRIS register bit. It must have a 1 for the bit to be an input. Therefore we must send
the word 00011000 to TRISA. Note that TRISA is an 8-bit location, even though Port A only
has 5 bits. It is therefore necessary to specify a complete 8-bit word to be sent, even for those
three bits that are not implemented. The binary radix is used (Table 4.2) instead of the default
hexadecimal. A similar process is followed for setting up Port B. A quick look at the circuit
diagram shows that all Port B pins are connected to LEDs, so all must be set as output.
Therefore the word sent to trisb is 00y. From here on the ports will be accessed; their locations
are in bank 0. The initialisation section therefore ends with memory bank O being selected in
the Status register.

Finally we reach the effective program itself, all four lines of it! The program continuously
reads the value of Port A and transfers it to Port B. By reading the value of the Port SFR, we are
actually directly reading the input state of the port pins for all pins set as inputs. If either push
button is pressed, this should be seen on the LEDs connected to bits 3 and 4 of Port B. When
Port A is read, all of its 5 bits are read, even though three are set as outputs. For these, the
values of the internal data latches (Figure 3.11) are read. All Port A bits are therefore initially
cleared to O in the program, using a clrf instruction.
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The actual data transfer part of the program uses a movf instruction to move the value of Port
A to the W register, followed by a movwf instruction to move the W register value to Port B.
A goto instruction creates a continuous loop, making use of the earlier defined label loop. As
before, the program must end with an end directive.

4.8.1 Tutorial: simulating Program Example 4.5

Create a new project for this example, copying code from the book’s companion website.
Assemble the project and open the simulator, as described for Program Example 4.2.

This program applies the ping-pong hardware, so to simulate we will need to create simulated
inputs for the two ping-pong paddles on Port A pins 3 and 4. Select Debugger > Stimulus >
New Workbook. The dialog box that appears is shown as part of Figure 4.13. Select Asynch —
this allows you to set up different types of inputs at the port pins, which are initiated by
pressing the Fire button at the appropriate moment. Under Pin/SFR, select RA3 and then RA4,
with Toggle under Action for each. When you close the project you are invited to save your
stimulus settings as an.sbs file. Open a Watch window and select PCL, TRISA, PORTA,
TRISB, and PORTB.

P uDHTPOE®

|| Stimulus - C:\...\data_move.3bs
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movlw € 0011300
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Figure 4.13: MPSIM set up to simulate Program Example 4.5
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You should now have a computer screen similar to that shown in Figure 4.13, although you are
likely to have arranged the windows differently. In the middle of this image we see the source
file, with the Watch window below it and the Stimulus controller top right. The arrow repre-
senting the program counter shows that the program has already been stepped through to the
movlw 00 instruction. This can be confirmed by checking the PCL value in the Watch window.

Now, by repeated pressing of the Step Into button, single-step through the program. As the
program moves through the initialisation, you will see the SFR values being changed in the
Watch window, and the PCL value being incremented. Program execution then circles around
the loop formed by the last three instructions. Now try ‘firing’ RA3 or RA4. Display windows
are not updated with the new value until the next instruction execution. Observe Port A and
Port B being updated as you continue to execute the program. Try now pressing the Animate
button. Notice that the program runs continuously but still responds to stimulus inputs.

4.9 Downloading to a microcontroller

Almost all microcontrollers these days have on-chip program memory, using Flash technol-
ogy. The process of programming requires data to be transferred into the chip in a precisely
timed way, applying certain programming voltages, usually higher than the normal supply
voltage. Certain microcontroller pins therefore have a secondary function, being used in
programming mode to transfer the program data into the chip, and transmit the programming
voltages.

In times past, the process of programming always required the IC carrying the memory (whether
a stand-alone device or memory in a microcontroller) to be placed in a ‘programmer’. This was
linked to a desktop computer for the programming process to be carried out. As memory
technology has improved, however, the process has become simpler, and it has become in-
creasingly easy to design the necessary programming circuitry into the target system. This
means that most microcontrollers can now be programmed in situ, i.e. within the target system.
We will expand on these techniques in later chapters. In this chapter we will introduce one
traditional programmer, the PICSTART Plus, and one in-circuit programmer, the PICKit 2.

4.9.1 Conventional programming — using the PICSTART Plus

A popular and low-cost programmer, supplied by Microchip, is the PICSTART Plus, shown in
Figure 4.14. There are many alternatives to this, including many designs intended for home-
build, which are available on the web. The PICSTART programmer is connected to the

host computer by a serial cable, and MPLAB has the software to communicate with it. To use it
the microcontroller must be removed from the target circuit and placed into the programmer.
The programmer can accept a wide range of dual-in-line microcontroller packages, from

8 to 40 pins. With adaptors it can program other package types.
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PICSTART Plus

DEVELOPMENT PROGRAMMER

MiCROCHIP

!
|
%

Figure 4.14: The PICSTART Plus programmer

The following steps take you through actually downloading code to the microcontroller, using
the PICSTART Plus programmer. If you have a programmer and the ping-pong hardware, you
can immediately download the program you have just created in the preceding tutorial.

You will need to power your PICSTART programmer and connect it to the serial port of your
computer (note that this therefore excludes most laptops). From within MPLAB IDE, select
Programmer > Select Programmer > PICSTART Plus. Then enable the programmer with
Programmer > Enable Programmer. A positive response should be given via the Output
window. If there is a problem, you may need to check Programmer > Settings > Commu-
nications. Ensure the programmer toolbar, Figure 4.15, is displayed. If not, find it with View >
Toolbars > Picstart.

|Blank Check | | Program | | Program Statistics |

/

‘ % B O3 B Ra[Pass: 0 Fail: 0 Total: 0 ||

| Read | | Verify | | Erase|

Figure 4.15: The MPLAB programmer toolbar
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Put the Zero Insertion Force (ZIF) socket on the PICSTART programmer in the Open position.
Place a 16F84A into it, ensuring from the legend that the chip is in the right place and is the
right way round. Then close the ZIF with the lever. With the project you want open on
MPLAB, you should now be able to apply the features available to you, as summarised in
Figure 4.15. The Output window in MPLAB will give you feedback on the success or oth-
erwise of all PICSTART actions undertaken, with a useful summary provided in the Program
Statistics of Figure 4.15.

4.9.2 In-circuit programming — using the PICkit 2

The PICKkit 2 is a very simple and low-cost programmer and debugger, which exploits the In
Circuit Serial Programming (ICSP) capability of many PIC microcontrollers. It is pictured in
Figure 4.16, alongside a ping-pong unit. The PICkit 2 connects to the target board using a
6-way connector. It also connects to the USB port of a host computer. The PICKkit 2 can be
driven from MPLAB itself or it can be driven from its own software control package.

The 16F84A and 16LF84A both have ICSP capability, and recent versions of the ping-pong
hardware design have interconnections to allow ICSP connection to the microcontroller.

The following description takes you through downloading a program to a target device using
the ping-pong, loaded with a 16LF84A microcontroller, as an example. It assumes that you

have already successfully assembled the code for a program suitable for download, such as

Program Example 4.5. The standalone PICKit 2 user interface, version 2.11, is used. For use in
other modes, and further details, consult Ref. 4.3.

Connect the PICkit pod to the ping-pong board and to your computer USB port. The PICkit 2
allows programming power to be supplied from the target board or from the USB via the
programmer pod. In this case the user can set a chosen voltage value. The ping-pong board
only has a 3 V supply, which is not adequate for some of the programming and erase processes.
Therefore leave the ping-pong supply switched off, as we will use power supplied from the
PICkit 2.

Figure 4.16: A ping-pong unit awaiting connection to a PICkit 2
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File  Device Family  Programmer  Tools  Help

Midrange Configuration

Device: PIC1EF844 Configuration:  3FF3
User IDs: FF FF FF FF

Checksum:  76BE

Reading device: \
Program Memory... EE... UserlDs... Config... Done. ® MI:RO:HIP

(iiEENENENERNANANNNNNNNNNNNNNANANANENNANANANRNNE) VDD PICkit 2 _
(] On 50 [
I Read J l Write ] l Yerify ] l Erase I | Blank Check | [] /MCLR ()

Program Memory
Enabled | Hex Only |v] Source: |Read from PICT16F844

000 2810 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF "‘
008 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF |
010 1683 3018 0035 3000 0036 1283 3004 00ss
018 3000 0086 1E0S 2816 1D&S5 2816 1E0S 2823
020 1D&S 2845 Z31E 3000 00835 3080 onsz 3020
028 0093 081z 0086 1F92 2830 1D85 2843 283B
030 1C12 2837 1D83 28435 1E0S 2844 28386 1EDS
038 2867 1D85 2843 2073 0B93 282B 1003 ocez
040 1803 2843 2827 286D 2867 3000 0085 3001
048 009z 3020 0093 ogla 0036 1Clz 2852 1E0S
0S50 2865 285D 1F92 2859 1EOS 2823 1D&S 2866
058 285D 1EDS 28635 1D335 2866 2073 0B93 2848 |v

Figure 4.17: Part of the PICkit 2 control screen

Start up the application software. You should see a screen similar to Figure 4.17. Notice that
the PICKkit has identified the microcontroller. It cannot distinguish between 16F84A and
16LF84A, so the former is shown. Notice also that the functionality on the push buttons is very
similar to that of Figure 4.15. In the case of Figure 4.17, a read has just been completed from
a microcontroller which has already been programmed.

To program the ping-pong hardware, you need to ‘import’ the correct hex file to the PICkit 2.
Depending on how the configuration bits have been set, however, it may be necessary first to
‘export’ the file from MPLAB. Do this in the MPLAB screen by selecting File > Export Hex.
Accept the defaults you are offered, and then select the file you wish to export (i.e. the one you
want to download to the ping-pong board). Return to the PICkit 2 window, select File > Import
Hex from the top left menu and select the Hex file you wish to import. You should get

a message to say that the file has been successfully imported. All that remains to be done now
is to click the Write button and watch the fleeting messages on the screen. These should lead
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Byte-oriented file register operations
13

8 7 6 0
f OPCODE | d| 1 (FILE #)

d = 0 for destination W
d =1 for destination {
f =7-bit file register address

Bit-oriented file register operations
13 109 76 0
OPCODE |b (BIT #)| f(FILE #)

it bit address

b=3-b
f = 7-bit fite register address

Literal and control operations

General
13 8 7 0
OPCODE k (literal)

k = 8-bitimmediate value

caLL and GOTO instructions only
13 1 10 0
| opcopE | K (literal) |

k = 11-bit immediate value

Figure 4.18: Instruction formats of the PIC mid-range microcontrollers

to a ‘Programming Successful’ message. The file import and programming can be run auto-
matically by clicking the Auto Import Hex + Write Device button.

4.10 Taking things further: the 16 Series instruction set format

It is interesting to take a little time here to understand further the way the instruction code
is made up of different component parts, as first discussed with the 12F508/9 in Chapter 1.
The PIC 16 Series has four possible instruction word formats, as shown in Figure 4.18. The
instruction word, which is transferred down the Program Bus (Figure 2.2), is made up of 14
bits. These appear as bits O to 13 in the figure. The opcode, the actual instruction part of the
instruction word, always occupies the highest bits of the instruction word. This is the part of
the instruction word that ends up in the ‘Instruction Decode and Control’ unit of Figure 2.2, but
it is not always the same length.

If the instruction is the type that contains a file address, then it is of the first format shown.
The most significant 6 bits hold the opcode, while the least significant 7 bits are used to hold
the address. These bits are transferred onto the ‘Direct Addr’ bus of Figure 2.2. In fact,
because the 'F84A only has a small memory, only the least significant 5 bits are used, as can be
seen from the ‘Direct Addr’ bus size indicated. Bit 7 holds the d bit. Different instruction word
patterns are used for the other instruction categories. These can be seen and understood by
reading the information in the figure.
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Summary

If you have followed the material of this chapter then you have taken an enormous step forward —
you are on your way to becoming a programmer of embedded systems! The key points are:

e Assembler is a programming language that is part of the toolset used in embedded
systems programming. It comes with its own distinct set of rules and techniques.

o It is essential to adopt and learn an IDE when developing programs. The MPLAB IDE is
an excellent tool for PIC microcontrollers, both for learners and professionals. And it
can’t be beaten on price!

e While some people are eager to get programs into the hardware immediately, it is ex-
tremely useful to learn the features of a simulator. The simulator in MPLAB allows the
user to test program features with great speed and is an invaluable learning tool.
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Building Assembler programs

In Chapter 4 the basic rules of Assembler programming were introduced, along with some of
the instructions from the PIC 16 Series instruction set. It’s as if we have now learned some
introductory skills in bricklaying. We need to develop those skills further, but we need to begin
to think about the structures that the bricks are going to be built into. Therefore we now need to
develop this introductory knowledge, so that we can actually build up programs that have
structure and are functional and reliable.

In this chapter you will learn:
e How to visualise a program and represent it diagrammatically.
e How to use program branching and subroutines.
e How to implement delays.
e How to use look-up tables.
e Logical instructions.
e How to simplify and optimise Assembler programming.

e More advanced features of software simulators.

5.1 The main idea - building structure into programs

When we actually design a program that is to do anything more than some minimal task, it is
important to think about and plan its structure, before starting to write the code. This is
especially true in Assembler — Chapter 4 warned that one of the problems of Assembler
programming was that it leads to unstructured ‘spaghetti’ programs. Therefore we must
consider means of representing the program diagrammatically. Let us consider how we might
do this, with two examples of commonplace domestic products.

Designing Embedded Systems with PIC Microcontrollers; ISBN: 9781856177504
Copyright © 2010 Tim Wilmshurst. All rights of reproduction, in any form, reserved.
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5.1.1 Flow diagrams

A well-established diagramming technique is the flow diagram. While this has many symbols
that can be used, we can develop good flow diagrams with just two! We will use rectangles for
processes or actions and diamonds for decisions.

Figure 5.1 is a simple flow diagram example, showing a refrigerator controller. The user has
a single control, an adjustable potentiometer that allows him/her to set a desired temperature.
Within the fridge there is a temperature sensor. Temperature is controlled by switching the
compressor on or off — the temperature will fall when it is running. The program reads both the
actual and demand temperatures and determines which is higher. If it is the actual temperature,
then the compressor is switched on. If the difference between the two is very great, then

an alarm will sound. The flow diagram shows this action, using just the two symbols men-
tioned above. Notice how each diamond decision symbol contains a question within it with
a yes/no answer. Its two exit points then correspond to the two possible answers. It can be

Read Actual
Temperature T,

A\

Read Demand
Temperature Ty

J

Yes No
A
Activate Switch off
Compressor Compressor
([}
No
Yes
Activate
Alarm

Figure 5.1: Flow diagram of simple refrigerator controller
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seen that this example program will loop indefinitely. This is a common embedded system
program structure and is sometimes called a ‘super loop’.

It is possible to draw flow diagrams with too much detail or too little. With care and
experience, however, it is possible to draw them at a level such that the diagram can be
converted to an Assembler program without too much difficulty. In some cases, an overview
flow diagram might be appropriate, with different sections within it then developed as
separate diagrams.

Flow diagramming is considered by some to be an old-fashioned technique as, somewhat like
Assembler itself, it does not encourage a structured program. Nevertheless, it is easy to learn
and use and it can clearly represent simple program ideas. Therefore for our purposes we will
make use of it.

5.1.2 State diagrams

The flow diagram views life as a series of actions or events which are rapidly passed through.
Many products, however, behave in a different sort of way. They tend to move from one
state to another, maybe spending a significant time in that state, and leaving it only when

a period is completed or a specific event occurs. These are best represented by a ‘state dia-
gram’, which forms an alternative to the flow diagram. As with flow diagrams, there is some
sophistication in using state diagrams in their full form. For our purposes, however, all we
need to do is to draw each state as a labelled circle and interconnect these with arrows.
These show under what condition(s) one state can move to another. Each arrow is labelled
with the condition that causes the state to change.

Figure 5.2 shows the function of a domestic washing machine represented as a simple state
diagram. When switched on, the machine first enters a Ready state. If the door is closed and the
user initiates a wash, then the machine first loads with water. A level sensor detects when this
is complete; however, the machine will also measure the time taken to fill. If it does not fill
within the allotted time then a fault is assumed. This may be due to inadequate water pressure
or a faulty valve mechanism. The use of timeout is a low-cost alternative to sensing the water
flow or pressure itself. The fill state is followed by a water-heating state. Again, a timeout
occurs if the water is not heated in an allotted time. The process continues as shown, each state
having a ‘successful’ exit condition as well as one which leads to the fault state.

From a programming point of view, state diagrams are more abstract than flow diagrams and
cannot so easily be translated directly into assembler code. In fact, it is often useful to convert
each state into its own flow diagram. To retain clarity of structure and ensure good pro-
gramming practice, each state should have very clearly defined entry and exit points. The use
of both flow diagrams and a state diagram to represent program structure is illustrated later in
this chapter with the electronic ping-pong program.
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Start!

\4 User initiates
Door closed
Ready
Function Full level

Timeout
complete Fault / detected

Timeout

cleared

Out of
balance

Heat
water

Motor
failure

: Func ion Motor

Q complete failure
//\ Function
Trr complete

Out of
balance

Required
temperature
reached

Figure 5.2: A washing machine control program - visualised as a state diagram

5.2 Conditional branching and working with bits

One of the most important features of any microprocessor or microcontroller program is its
ability to make ‘decisions’, i.e. to act differently according to the state of logical variables.
Microprocessors generally have within their instruction sets a number of instructions which
allow them to test a particular bit, and either continue program execution if a condition is not
met or branch to another part of the program if it is. This is illustrated in Figure 5.3. These
variables are often bit values in condition code or Status registers.

The PIC 16 Series microcontrollers are a little unusual when it comes to conditional branching
as they do not have branch instructions as such. They have instead four conditional ‘skip’
instructions. These test for a certain condition, skipping just one instruction if the condition is
met and continuing normal program execution if it is not. The most versatile and general-
purpose of these are the instructions:

btfsc f,b

btfss f,b
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Subtract A from B

No

Add Cto D

Y
Y

Figure 5.3: Conditional branching

The first of these tests bit b in memory location f and skips just one instruction if the bit is clear
(i.e. at Logic 0). The second does a similar thing but skips if the tested bit is set (i.e. at Logic 1).
Let us explore this in an example program.

5.2.1 Working with bits — the data transfer program

Suppose in Program Example 4.5 we don’t want to move the whole of Port B to Port A. Maybe
we wanted to transfer just one bit, or move a bit from one position in Port B to a different
position in Port A. Then we could use the ‘bit-oriented’ instructions of the 16 Series in-
struction set. There are four of these: the two mentioned directly above and two which we used
in Program Example 4.5, bsf and bcf.

The program fragment in Program Example 5.1 performs a similar function to that of
Program Example 4.5, but now applies the bit manipulation instructions. As just single bits
are manipulated, however, it does not affect any of the other bits in the port to which it is
writing. It lights an LED if the associated microswitch is pressed. Even this simple task
requires some thought, however — the instruction set does not allow us to move or invert
single bits, which would be so convenient here. As the port input goes low when the button is
pressed, the program needs to ‘set’ the output bit (to light the LED) if the input is low, and
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‘clear’ it if it is high. This implies a selection process — in a high-level language we might
call this an ‘if...else’ structure. The simple skip instruction is not able to do this on its own.
One way to do this is to ‘preset’ the output bit with one value and then change it if we find it
has been set wrong.

;The “main” program starts here
movlw 00 ;clear all bits in port A and B
movwf porta
movwf portb

loop  bcf portb, 3 ;preclear port B, bit 3
btfss porta, 3
bsf portb, 3 ;but set it if button pressed
bcf portb, 4 ;preclear port B, bit 4
btfss porta, 4
bsf portb, 4 ;but set it if button pressed
goto loop
end

Program Example 5.1: Testing and manipulating single bits

Programming Exercise 5.1

Open a new project under the suggested name Bit Set, or choose your own name. Copy
Program Example 4.5 into it as a source file but replace the main section of code with
Program Example 5.1. Build the project and simulate. With the Stimulus Controller
create input signals for Port A, pins 3 and 4, selecting Toggle for Action. Open a Watch
window with PCL, PORTA, PORTB and W register as observed variables. Step through
the program ‘firing’ the inputs at appropriate moments, noting the effect. Change the
program so that:

(1) Port B, bits 3 and 4, are ‘set’ if the respective buttons are pressed,;
(2) different bits in Port B are set when the buttons are pressed.

Download your revised program to the ping-pong hardware, if you have the means.

5.2.2 Branching on Status register bits

We saw when simulating Program Example 4.2 how the Status register bits Zero, Carry and
Digit Carry respond to certain arithmetic instructions. In many cases we will need to test these
and branch according to the result. Such tests often follow an arithmetic instruction.

The 16 Series instruction set has six arithmetic instructions: addwf, addlw, subwf, sublw,
incf and decf. Their use is central to any arithmetic processing that the microcontroller
may have to do. We have already made use of the first two of these. The Subtract in-
structions follow a similar pattern to the Add. The Carry bit now, however, acts as
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a Borrow, except the polarity is reversed (see the Status register, Figure 2.3). Therefore if
a subtract occurs and the result is positive, then the Carry bit is ‘set’. If the result is
negative, then the Carry bit is ‘clear’.

We return now to developing the Fibonacci program, which we first met as Program
Example 4.4. One problem with that program was that it overran the microcontroller’s
8-bit range without this being detected. Let us therefore develop the program so that it
remains within the 8-bit range and steps back down the series when that range has been
fully exploited.

The revised program is shown as Program Example 5.2. A counter has been included to
show how many numbers in the series have been calculated. The program tests for range
overflow by checking the Carry bit after each addition. When the 8-bit range is exceeded, it
reverses the series by subtracting. You will notice that ¢ and z are defined as labels in the
opening equates section. There is of course no problem in doing this, just as labels are used
for both SFR and memory location.

The program starts as before by preloading the first three numbers in the series into
the memory store. It starts moving up the series from the label forward. The two most
recent numbers are added and the Carry bit then checked. If it is set, the 8-bit range
has been exceeded and the program will need to reverse. Assuming Carry was not set,
the program then increments the counter and shuffles the numbers in the memory
store, discarding the oldest. The program then loops up to forward. If, however, the
Carry had been set, the program branches to reverse. Now it works down the series by
subtraction. It tests the counter number to determine when it should return to
forward.

Programming Exercise 5.2

Create a project in MPLAB called Fibonacci Full. Copy from the book’s companion
website the source file of Program Example 5.2 into it, and simulate. In the Watch
window display counter, fib0, fib1, fib2, fibtemp, WREG, and STATUS. Single-step
initially and watch the Fibonacci series develop, in fib0, fib1, and fib2. How many
numbers in the series fit into the 8-bit range? Watch the Carry bit being set as the range is
exceeded, and see the program reverse down the series. Notice now that the Carry bit
(now acting as |Borrow) is ‘set’ after each subtraction. Try halting the program at reverse
and forcing two values for fib0 and fib1 that will give a negative result. Single-step
through the subtraction, check the result in the W register, and notice that the Carry bit
is clear. See how the comparison of counter with the literal number 3 is achieved, and see
the program return to forward.
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;*****‘k********************************************************************
;Fibonacci_full

;In a Fibonacci series each number is the sum of the two previous

;ones, e.g. 0,1,1,2,3,5,8,13,21.....

;This program calculates Fibonacci numbers within an 8-bit range,

;first going up and then down.

;Program intended for simulation only, hence no input/output.

;The program demonstrates addition, subtraction, compare.

;TIJW 17.3.05. Tested by simulation 18.3.05

KKK R KKK kKK K ok kKK ok ok kK K ok kK K K kKK K ok kK K o ok kK K ok ok ok K K o ok ok kK K ok kK K K ok Rk K K Kk K

;jno i/o ports used
status equ 03

c equ 0
z equ 2
;these memory locations hold the three highest values of the Fibonacci series
fib0 equ 10 ;lowest number (oldest when going up,
;newest when reversing down)
fibl equ 11 ;middle number
fib2 equ 12 ;highest number
fibtemp equ 13 ;temporary location for newest number
counter equ 14 ;indicates value reached, opening value is 3
org 00
;preload initial values
movlw 0
movwf £ib0
movliw 1
movwf fibl
movwf fib2
movlw 3

movwf counter ;we have preloaded the first three numbers,
;so start count at 3

forward movf fibl,0
addwf fib2,0

btfsc status,c ;test if we have overflowed 8-bit range
goto reverse ;here if we have overflowed, hence reverse down
movwf fibtemp ;latest number now placed in fibtemp

incf counter,1
;now shuffle numbers held, discarding the oldest
movf fibl,0 ;first move middle number, to overwrite oldest
movwf £ib0
movf fib2,0
movwf fibl
movf fibtemp, 0
movwf fib2
goto forward
;when reversing down, subtract fib0 from fibl to form new fib0
reverse movf fib0,0
subwf fibl,0
movwf fibtemp ;latest number now placed in fibtemp
decf counter,1
;now shuffle numbers held, discarding the oldest
movf fibl,0 ;first move middle number, to overwrite oldest
movwf fib2
movf £ib0,0
movwf fibl
movf fibtemp, 0
movwf fibO0
;test if counter has reached 3, in which case return to forward
movf counter,0
sublw 3
btfsc status,z
goto forward
goto reverse

end

Program Example 5.2: A better Fibonacci program
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Main program

Do this

Do that

Do something else

Call SR1

Do that

Subroutine 1

SR1 | ......

Return

SR2

Subroutine 2

Return

Figure 5.4: Subroutine calling

5.3 Subroutines

As we develop bigger programs, we quickly find that there are program sections that are so useful
that we would like to use them in different places. Yet it is tedious, and space- and memory-
consuming, to write out the program section whenever it is needed. Enter the subroutine.

The subroutine is a program section structured in such a way that it can be called from
anywhere in the program. Once it has been executed the program continues to execute from
wherever it was before. The idea is illustrated in Figure 5.4. At some point in the main
program there is an instruction ‘Call SR1’. Program execution then switches to Subroutine 1,
identified by its label. The subroutine must end with a ‘Return from Subroutine’ instruction.
Program execution then continues from the instruction after the Call instruction. A little later
in the program another subroutine is called, followed a little later by another call to the
first routine.

The action of the Call instruction is two-fold. It saves the contents of the Program Counter onto
the Stack so that the CPU will know where to come back to after it has finished the subroutine.
It then loads the subroutine start address into the Program Counter. Program execution thus

continues at the subroutine. The return instruction complements the action of the Call. It loads
the Program Counter with the data held at the top of the Stack, which will be the address of the
instruction following the Call instruction. Program execution then continues at this address.

Subroutine Call and Return instructions must always work in pairs. Go through Programming
Exercise 5.3 to find out what happens if they don’t.
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The PIC 16 Series subroutine call and return instructions can be seen in Appendix 1, and are
simply called call and return. A special return instruction, retlw, is also available; we meet
this later in the chapter.

A subroutine called from within another subroutine is called a nested subroutine. In doing this, it
must be remembered that every time a subroutine is called one Stack location is taken up, which
becomes free again upon the subroutine return. If we call a subroutine from within another, then
two Stack locations are used up, or three if there is another nested call. As the 16 Series

microcontrollers only have an 8-level stack, care must taken that there is not ‘stack overflow’.

5.3.1 Adapting the Fibonacci program to use subroutines

Program Example 5.3 shows a very simple subroutine example. It rewrites the Fibonacci
program, now replacing two code sections with subroutines. The example program is written
just to illustrate the mechanics of subroutines. Because each is used only once the main benefit
of subroutines, the fact that they can be used repeatedly, is not realised. Comparison with
Program Example 5.2 shows that each subroutine has been created simply by taking out

a block of code from the main body of the program, labelling the first subroutine line, and
terminating the block with a return instruction. The label effectively becomes the name of the
subroutine. The subroutines have been grouped together and placed after the end of the main
program. Each subroutine is called at the appropriate place in the program, using the call
instruction and invoking the subroutine name.

Programming Exercise 5.3

Create a project with recommended name Fibonacci SRs, and use Program Example 5.3
as source code. Build and simulate the program. In the Watch window display PCL, fib0,
fib1, fib2, and fibtemp. Also Open the Hardware Stack window, as seen in Figure 5.5,
using View > Hardware Stack.

Step through the program and be sure you understand all features. Notice that when the
first call instruction is reached, the program counter shows 0Dy. On the following step it
has changed to 19. Meanwhile, the address of the instruction immediately following
the call, 0Dy, is loaded into the stack. The stack pointer (indicated by TOS - Top of
Stack) is incremented. These addresses can be checked by looking at the program list file.
Step to the end of the subroutine, and the program counter shows 1Fy as the return
instruction is reached. This is the moment shown in Figure 5.5. One further step invokes
the return instruction. The program counter is reloaded from the stack and program
execution continues from the instruction following the call.

A common beginner’s error is not to use call and return instructions correctly when using
subroutines. Try replacing the call shuffle up instruction with goto shuffle up, leavingall else
unchanged. Build, simulate and step through as before. Can you explain what is happening?
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;Fibonacci SRs
;This program rewrites the Full Fibonacci program to illustrate the use of

;subroutines.
;Program intended for simulation only, hence no input/output.
;TJW 17.11.08 Tested by simulation 17.11.08

,-****************************************************************************
(initial program sections omitted)
;

forward movf fibl,0
addwf fib2,0

btfsc status,c ;test if we have overflowed 8-bit range
goto reverse ;here if we have overflowed,

;hence reverse down the series
movwf fibtemp ;latest number now placed in fibtemp

incf counter,1
;now shuffle numbers held, discarding the oldest
call shuffle up
goto forward
;when reversing down, we will subtract fib0 from fibl to form new fib0
reverse movi £ib0,0
subwf fibl, 0
movwf fibtemp ;latest number now placed in fibtemp
decf counter,1
;now shuffle numbers held, discarding the oldest
call shuffle down
;test if counter has reached 3, in which case return to forward
movf counter,0
sublw 3
btfsc status,z
goto forward
goto reverse

3Kk kK ok Kok ok K ok ok K ok ok ok ok K ok K ok ok K ok Kk ok Kk ok K ok kK

;Subroutines
;**********************************
;Shuffles numbers in series, moving fibl to fib0, fib2 to fibl, fibtemp to fib2
shuffle up movf f£ibl,0 ;first move middle number, to overwrite oldest
movwf £ib0
movf fib2,0
movwf fibl
movf fibtemp, 0
movwf fib2

return
;Shuffles numbers in series, moving fibl to fib2, fib0 to fibl, fibtemp to fib(
shuffle down movf fibl,0 ;first move middle number, to overwrite oldest

movwf fib2
movf f£ib0,0
movwf fibl
movf fibtemp, 0
movwf £ib0
return

end

Program Example 5.3: Using subroutines in the Fibonacci program

5.4 Generating time delays and intervals

A recurring theme of embedded systems is how we deal with time — how systems respond in
a timely way to external events and how they can measure time and generate time delays. Even
with only a limited grasp of programming, we can begin to address the issue of timing by
developing program loops that give time delays of known and accurate duration.
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shuffle_up movf fibl,0 sfirst move middle number, to overwrite oldest
movwf £ib0
move £ibz,0
movwf fibl
move fibteup,0
movw £ib2
| | return
;Shuffles nubers in series, moving fibl to fibZ, £ib0 to fibl, fibtemp to fib0

|

|

|

! shuffle_down movf fibl,0 jfirst move middle number, to overwrite oldest
‘ mowwE £ib2
|

|

|

|

move £ib0,0
movwf fibl
move fibtemp,0
movwE fib0
return

end

[4ddSFR] [EEADR  [v| [AddSymbo [] TOS | Stack Level | Return hddress | Ia

Address [ Symbol Name [ Hex [ Decimal I = E E;E;‘Ey
02 PCL 0x1F 31 2 0000

10 £ib0 0x01 1 3 0000 1
11 fibl 0x01 1 4 0000
12 £ib2 0x02 z 5 0000
13 fibtemp ox02 2 6 0000

7 oooo [se]

Woatch 1 | walch 2 | Watch 3 | Watch 4 <] I [2]

Figure 5.5: Subroutine calling

The initial concept is simple. A memory location is set up to act as a counter, loaded with
a certain value and then decremented repeatedly in a loop until it reaches zero. The time
taken will depend on the number first placed in the counter and then the time taken for each
program loop.

To implement accurate delays the oscillator frequency needs to be accurate and stable and we
need to know what that frequency is. Here lies one advantage of using a crystal oscillator, as it
gives a frequency of excellent accuracy and stability. Approximate delays can of course be
implemented with other oscillator sources, as we do with the ping-pong program. With the PIC
microcontroller, we need to remind ourselves that each instruction cycle takes four oscillator
cycles, as described in Section 2.5.1.

A simple example of a delay loop, taken from the ping-pong program, is shown in Program
Example 5.4. It takes the form of a subroutine called delayS. The subroutine opens by
moving a number into a memory location which has been previously labelled delentrl. In
this case the number is 200p, although this can be varied to produce delays of different
lengths (up to a maximum, for an 8-bit location, of 255p). The actual delay loop is that
section of code starting with the label dell. Two nop instructions, which do nothing at all but
take up time, are used to extend the time taken for one loop iteration. The decfsz instruction
is then implemented. This decrements memory location delentrl. If the result of the dec-
rement is zero, then the instruction following is skipped and program execution moves on to
the return instruction. For 199 cycles, however, the decrement result will not be zero, there
will be no skip and program execution will go back to dell.
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;Delay of 5ms approx. Instruction cycle time is 5us.

delay5 movlw D'200" ;200 cycles called,each taking 5x5=25us
movwf delcntrl
dell nop inst. cycle

1
nop ;1 inst. cycle

decfsz delcntrl,1 ;1 inst. cycle, when no skip
goto dell ;2 inst. cycles

return

Program Example 5.4: A delay subroutine

The duration of this delay subroutine can be worked out with ease by considering the time
taken by each instruction in the loop (taken from the Instruction Set, Appendix 1). This is
shown in the program comments. While delentrl is counting down from its initial value, the
loop is made up of two nop instructions, a decfsz and a goto. As the decfsz instruction does not
skip, it takes only one cycle, whereas the goto always takes two. Therefore the total per loop is
five. The electronic ping-pong program has a clock frequency of 800 kHz approximately,
therefore an instruction cycle frequency of 200 kHz, or instruction cycle period of 5 [is.
Therefore each loop, with its five instruction cycles, takes 25 [ls. Two hundred loops are called;
hence the overall duration is 5 ms.

For a precise delay, it is necessary also to take into account the duration of the final cycle, and
the entry to and exit from the subroutine. On the final loop iteration, for example, the decfsz
causes a skip and hence takes two cycles. The goto is, however, missed.

The simple delay loop of Program Example 5.4 is useful for comparatively short delays, say up
to tens of milliseconds. There are many situations, however, when we want something much
longer. One way of extending it is to create a second subroutine which is similar to the first but
which calls the first from within its loop. An example is shown in Program Example 5.5. This
loop makes 100p, calls to the subroutine delayS, which we have just seen. The resultant delay
is therefore around 500 ms. It is of course essential to ensure that each loop has its own
dedicated counter: in this case delentrl and delentr2 are used; disaster otherwise ensues! A
further way of writing a longer delay loop, using a ‘loop within a loop’ within a single sub-
routine, appears in Program Example 5.6.

;500ms delay (approx) ;100 calls to delay5
delay500 movlw D'100"

movwf delcntr2
del2 call delay5

decfsz delcntr2,1

goto del2

return

Program Example 5.5: Nested subroutines for greater delay

Program Example 5.6 shows a simple application of a delay subroutine. It is written for
the ping-pong hardware and simply flashes the LEDs in two patterns, one after the other.
To give a suitable flashing effect, a delay of 500 ms is inserted between each change
of pattern.
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;*************************************************************
;Flashing LEDs 1.

;This program continuously outputs a series of LED patterns,
;using ping-pong hardware. LED patterns are listed within

;the program.

;TJW 9.11.08 Tested in simulation 9.11.08
;*************************************************************
;Clock is 800kHz

;Configuration Word: WDT off, power-up timer on,

; code protect off, RC oscillator

7

;specify SFRs

pcl equ 02

status equ 03

trisa equ 05

portb equ 06

trisb equ 06

delcntrl equ 11

delcntr2 equ 12
org 00
;Initialise
start bsf status, 5 ;select memory bank 1

movlw B'00011000' ;set port A right for hardware,
movwf trisa ;even tho not used in this program.

movlw 00
movwf trisb ;all port B bits output
bcf status, 5 ;select bank 0

;The “main” program starts here
loop movlw B'01010101'

movwf portb ;set up new output pattern

call delay

movlw B'10101010"'

movwf portb ;set up new output pattern

call delay

goto loop ;loop again
7
;*************************************************************
; Subroutine
,-*************************************************************
;Introduces delay of 500ms approx, for 800kHz clock
delay movlw D'100'

movwf delcntr2 ;will do the outer loop 100 times
outer movlw D'200'

movwf delcntrl ;will do the inner loop 200 times,

;at 5cycles = 25us, this is 5ms

inner nop ;1 cycle

nop ;1 cycle

decfsz delcntrl,l ;normally lcycle

goto inner ;2 cycles

decfsz delcntr2,1

goto outer

return

end

Program Example 5.6: Using a delay subroutine
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Programming Exercise 5.4

Create a project with recommended name Flashing LEDs 1. Use Program Example 5.6 as
source code. Build and simulate the program. Step through it and be sure you
understand all features. You will find that a disadvantage of simulating delay loops is
that unless they are very short you tend to get stuck in them. Therefore be ready to use
the Step Out (to step out of a subroutine) and Step Over (to skip a subroutine) buttons
in the debugger toolbar (Figure 4.12).

Download the program to the ping-pong hardware, if you have the means. Investigate
the effect of changing delay duration and LED pattern. Try introducing a third or fourth
pattern.

It should not be difficult to understand this program from knowledge already gained. As we
have already seen, the delay subroutine is called with a call instruction, using as operand the
label of the opening instruction of the subroutine. The subroutine is correctly terminated with
a return instruction.

Delay routines are very useful things and are widely used. However, they need to be
used with care as, when the delay routine is running, the CPU can do nothing else. A
delay routine is a bit like asking Einstein to sit and count beans — it’s just not very good
use of a powerful resource. In Chapter 6 we begin to meet other ways of creating time
delays.

5.5 More use of the MPLAB simulator

We have already seen the enormous value of the software simulator as a means of running
through a program and observing outputs. We did this just using the simple controls of single
step, animate or run. As programs grow, however, we need greater sophistication in the way we
can run them and how we observe their behaviour.

5.5.1 Breakpoints

Once programs become long, it becomes increasingly tedious to step through them when
simulating. We need a means of getting them to run through the code that we may not be
interested in, but stopping where we need to take a closer look at what is happening.
Breakpoints let this happen. In their simplest form, breakpoints allow you to run a program up
to a specified instruction. Program execution then stops and memory and register values can be
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inspected. In MPSIM you can set a breakpoint simply by double clicking on an instruction in
the program window, and remove it in the same way. The number of breakpoints is unlimited,
so they can be used freely.

Programming Exercise 5.5

The full Fibonacci program is perhaps the longest example we have looked at so far, and
it is annoying to have to step through it if we wish to see something happen deep inside
the program. Open the full Fibonacci project you created earlier (or create it for the first
time), and enable the MPLAB simulator using Debug > Select Tool > MPLAB SIM. Scroll
through the source file and double click on the line labelled reverse. A breakpoint symbol
should appear, as seen in Figure 5.6. Check that you can remove this by double-clicking
again. Reset the simulator, and run. See how the program stops at the breakpoint. You
can inspect all windows at this point and then proceed any way you wish, for example by
single-stepping. Try setting another breakpoint at the second place shown in Figure 5.6
and running to here.

i C:\My Documents\MPLAB Projects\fibol.asm =10 x]

reverse move fib0,0
subwf £fibl,0
movwf fibtemp slatest number now placed in fibtemp
decf counter,l
snow shuffle numbers held, discarding the oldest
movE fibkl, 0 ;first move middle mumber, to overwrite oldest
movwE fibZ
movE fik0O,0
movwE fibl
movE fibtenp,0

movwf fib0
;test if counter has reached 3, in which case return to forward
movf counter 0
sublw 3
btfsc status,z
e goto [forward

goto reverse -
I 4 I 1 ¥

Figure 5.6: Breakpoints inserted in Fibonacci program

5.5.2 Stopwatch

A weakness of the software simulator is that it does not run in real time, yet in embedded
systems we have a strong desire to understand the timing behaviour of our programs. The
Stopwatch facility of the simulator allows accurate time measurements to be simulated.
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It simply requires that the simulator ‘knows’ what the oscillator frequency is. As it can record
the number of instruction cycles executed, it can then calculate time taken.

In MPSIM the oscillator frequency is set through the Simulator Settings window, found using
Debugger > Settings > Osc/Trace and seen in Figure 5.7(a). The Stopwatch, seen in

Figure 5.7(b), is displayed using Debugger >

a

Stopwatch.

.
Simulator Settings E E

Trace Options

Trace All

| Code Coverage | Animation / Realime Updates |  Limitations |
Osc / Trace 1 Break Options I SCL Options |
Processor Frequency
Urits:
O MHz
500 (& KHz
OHz

Buffer Size (1K - 43770K)

Break on Trace Buffer Full B4 ® K lines
D |: O M lines
I 0K I [ Cancel ] Apply
b
I Stopwatch !Eln
Stopwatch Total Simulated
Instruction Cycles I 25 I 39
Zero | Time  (uSecs) | 39.000000

25.000000 |

Processor Frequency  (MHz)

| 4.000000

Figure 5.7: Using the stopwatch. (a) Simulator Settings window. (b) Stopwatch window
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Programming Exercise 5.6

Still with the full Fibonacci project open, set the processor frequency to 4 MHz. This
usefully gives an instruction cycle time of 1 ls. Leave the breakpoints as set in Pro-
gramming Exercise 5.5. Press Debugger > Stopwatch and Zero the Stopwatch. Reset the
simulator and run the program to the breakpoint. The Stopwatch should show 166 [is.
Can you account for this value?

Programming Exercise 5.7

The Stopwatch is an excellent way of measuring durations of delay subroutines. Open
the ‘Flashing LEDs 1’ project, i.e. Program Example 5.6. Place one breakpoint at the call
delay line and another at the line after. Set the processor frequency to 800 Hz, open the
Stopwatch and run to the first breakpoint. Now zero the time on the Stopwatch and run
to the second. The value displayed should be approximately 500 ms. Can you explain the
actual Stopwatch time you read? Can you adjust the subroutine to give a more accurate
delay?

5.5.3 Trace

The various windows available in MPSIM give a good picture of the state of the processor status
and memory locations at any time, but they do not tell us the history of program execution. Even
if program execution has halted at a breakpoint, there may have been a number of program paths
for it to go down to reach that point. The ‘Trace’ function is there to give a record of the recent
past of the program execution. In Trace memory the simulator keeps a continuous record of all
instructions that have been executed. This can be inspected when program execution stops.

MPLAB has a Trace function, with memory size of 32 767 lines. The Trace function is enabled
in the Simulator Settings window, seen in Figure 5.7(a), found by following Debugger >
Settings > Osc/Trace. Note that it slows down simulator speed somewhat if it is enabled. The
Trace window is viewed using View > Simulator Trace, as seen in Figure 5.8. Here the
columns are all self-explanatory, except for:

SA = Source Address — address or symbol of the source data
SD = Source Data — value of the source data
DA = Destination Address — address or symbol of the destination data

DD = Destination Data — value of the destination data.
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Figure 5.8: Trace window for a section of the Fibonacci program

Programming Exercise 5.8

invoked.

Return to the program and settings of Programming Exercise 5.6, i.e. the full Fibonacci
program. Ensure that Trace is enabled as described above, reset the simulator and run to
the breakpoint at label reverse. Now open the Trace window, which should appear as in
Figure 5.8. See thatitis a list of all the instructions recently executed, finishing (in line -1)
with the goto instruction which takes execution to the breakpoint line. Looking back
over the SD and DD columns, we see (in the numbers 59y, 90y, and E9 - the highest
numbers in the series that an 8-bit register can hold) the Fibonacci series being formed
and saved. The value of the Status register in line -2 is 19y, or 0001 1001g. This shows
that bit 0, the Carry flag, has been set, and the goto instruction has therefore been

5.6 Introducing logical instructions

So far we have seen a good selection of the 16 Series instructions, but have yet to see any
logical ones. These instructions, like andwf, andlw, iorwf, or xorwf, perform logical oper-
ations between the contents of the W register and either a literal value or a value held in
amemory location. They do it on a ‘bitwise’ basis. For example, if the andlw k instruction was
applied, then bit O of the literal value is ANDed with bit O of the W register, bit 1 is ANDed
with bit 1, and so on. These instructions are useful for actual logical operations. Commonly
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,-*************************************************************
;Flashing LEDs 2.

;This program continuously outputs a series of LED patterns,
;using ping-pong hardware. LED patterns are derived using
;logical instructions. These are placed in different
;subroutines, of which one should be chosen.

;TIW 9.11.08 Tested in HW and simulation 9.11.08
;*************************************************************
;Clock is 800kHz

;Configuration Word: WDT off, power-up timer on,

; code protect off, RC oscillator

;

;specify SFRs and bits

c equ 0
pcl equ 02
status equ 03
trisa equ 05

portb equ 06
trisb equ 06

delcntrl equ 11 ;used as counter in delay subroutine

delcntr2 equ 12 ;used as counter in delay subroutine
flags equ 13 ;bit 0 will be set once initial pattern is op
org 00
;Initialise
start bsf status, 5 ;select memory bank 1
movlw B'00011000"' ;set port A right for hardware,
movwf trisa ;even tho not used in this program.
movliw 00
movwf trisb ;all port B bits output
bcf status, 5 ;select bank 0

clrf flags
;The “main” program starts here
;insert below one of pattern XOR, pattern RRF, pattern IOR to be the
;target of this subroutine call
loop call pattern_IOR ;select SR to be called here

call delay

goto loop
;*k*k*k*k*k*k*k*k*********************************************
;Subroutines
;*************************k***********************************
;Changes led pattern, using XOR instruction
pattern XOR btfsc flags, 0

goto patt XOR1 ;here if first visit to SR

bsf flags, 0

movlw B'10101010"'

movwf portb ;set up initial output pattern
return
patt XOR1 movf portb,0 ;here if 2nd or later visit to SR

xorlw B'11111111"'
movwf portb
return

;Changes led pattern, using rrf instruction
pattern_RRF btfsc flags,0
goto patt RRF1 ;here if first visit to SR
bsf flags, 0
movlw B'10000000"'

movwf portb ;set up initial output pattern
return
;here if 2nd or later visit to SR
patt _RRF1 bcf status,c ;clear carry flag
rrf portb, 1
btfsc status,c ;has pattern reached carry flag?

Program Example 5.7: Applying logical instructions
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bsf, portb, 7 ;1f yes, reset msb
return

;Changes led pattern, using OR and rrf instructions
pattern IOR btfsc flags,0

goto patt TIOR1 ;here if first visit to SR
bsf flags, 0
clrf portb ;set up initial output pattern
return

patt IOR1 rrf portb,0 ;here if 2nd or later visit to SR
iorlw B'10000000"' ;add another 1 bit to pattern
btfsc status,c ;has pattern reached carry flag?
clrw ;if yes, clear W
movwf portb
return

;Introduces delay of 500ms approx, for 800kHz clock
(delay subroutine omitted)

end

Program Example 5.7 cont’d

also, and instructions are used for suppressing unwanted bits in a word, and or instructions are
used for setting individual bits in a word.

Program Example 5.7 shows the use of a number of logical instructions. It is based on
the ‘Flashing LEDs 1° program of Program Example 5.6, but instead of embedding the
LED patterns in the program it derives them using logical instructions. Patterns are
generated within subroutines, of which one should be inserted in the subroutine call (in
the line labelled loop) for any one build. Each pattern subroutine is divided into two
parts. The first part is only visited the very first time the subroutine is called; it sets up
an initial pattern. The program then sets a bit in the flags memory location, so that next
time this part of the routine is skipped. The second half of the routine then manipulates
the current pattern.

Programming Exercise 5.9

Create a project with recommended name Flashing LEDs 2. Use Program Example 5.7 as
source code. Try single-stepping through the program as it is, noting carefully how the W
register and Port B change in the pattern IOR subroutine. Try at the line labelled loop
replacing this subroutine with the other two, in turn. Again, step through and un-
derstand how the logical instructions determine the port output values.

Download the different version of the program to the ping-pong hardware, if you have
the means to do this.




128 Chapter 5

5.7 Look-up tables

The instruction movlw allows us to introduce within the program a byte of constant data. We
have already seen this in previous programs, for example with the instruction combination:

movlw D'100’
movwf delcntr2

This is fine for introducing single bytes of data into a program, or just a few. But suppose we
want to place in the program a whole list of numbers, maybe to generate a waveform or to
produce output patterns on a display. Suppose also that we want to be able to record where we
are in the list with some sort of marker. The movlw instruction is then not really up to the job,
and we need to apply a way of setting up and accessing a block of data. This is called a ‘look-
up table’.

5.7.1 Introducing the look-up table

A look-up table is a block of data that is held in the program memory and which can be
accessed by the program and used within it. In a Von Neumann structure (Figure 1.7(a)), with
its single address and data buses, it is rather easy to set up and use look-up tables, as all
memory locations are of equal size and all can be accessed with equal ease. In a Harvard
structure (Figure 1.7(b)) it is more difficult, as data must be moved from one distinct memory
map to another. The situation is made worse by the difference in memory location size that
usually exists between data and program memories. Therefore in a Harvard structure, like the
PIC’s, a special technique is used to create look-up tables. This introduces several important
new ideas.

The PIC 16 Series approach to look-up tables is shown in Figure 5.9. The table is formed as
a subroutine. Every byte of data in the table is accompanied by a special instruction,
retlw. This instruction is another ‘return from subroutine’ but with a difference — it requires
an 8-bit literal operand. As it implements the subroutine return, it picks up its operand and
puts it into the W register. The table is essentially a list of retlw instructions, each with its
byte of data.

What we need now is a technique which allows just one of those retlw instructions to be

selected from the list. We use something called ‘computed go to’. Look carefully at the very
first instruction in the subroutine, addwf pcl. The contents of the W register are added to pcl,
which is the lower byte of the program counter. This sounds like a pretty dangerous sort of
thing to do, and certainly it must be done with care. The effect, however, is that, once a number
has been added to the program counter, program execution jumps forward by whatever that
number was. If the number added is zero, then the next instruction is executed. In this example
the CPU executes the retlw instruction it lands on, and thus goes back to the main program.
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Look-up table, in
form of Subroutine

| am the W register.
| am carrying a code
from the main
program, which will
show which number |

table addwf pcl

must come back with retw 23
movf sample_no,0
retiw 3f
call table thw 47
movwf porth ) retw
retlw 7f
/ Now I'm bringing retiw 0a2
back the chosen retiw 1f
number from the
/ subroutine. retiw 03
retw 67

retiw 0c5
retw 32

Figure 5.9: Fetching data from a look-up table

Note carefully that however long the subroutine appears, on any one iteration only two in-
structions are executed, the addwf pcl and the chosen retlw. It is obviously up to the pro-
grammer to ensure that, as the subroutine is called, the W register is already loaded with the
offset that is needed.

Let’s see this at work in the example of Figure 5.9. Using the movf instruction, the main
program transfers into the W register the contents of a memory location called sample no. It
then calls the subroutine table. In this example it is assumed that sample no was holding the
number 5, which the W register then holds as the subroutine is entered. As the subroutine starts
program execution, the number 5 is added to pcl. Program execution therefore jumps forward
by 5, to instruction retlw 1f. This causes a return from the subroutine, with the number 1f now
placed in the W register. The main program immediately makes use of this number, in this case
transferring it to Port B.

In summary, the W register is like a messenger being sent to the subroutine. It goes to the
subroutine carrying a code (which acts as a pointer) showing which line in the table is wanted.
It comes back carrying the number stored in that line.

There is one possible problem with this approach — by manipulating only the lower byte
of the program counter we can only operate within the first 256 words of program
memory, or within any page following. If the lookup table is very long, or if it is situated
across a page boundary, then problems with the computed go to will occur. In this case it
is essential to calculate a fuller version of the computed go to (for how to do this, see
Ref. 5.1).
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;*************************************************************
;Flashing LEDs 3.

;This program continuously outputs a series of LED patterns,
;using simulation or ping-pong hardware.

;TIW 5.

3.05.

Tested in simulation 11.3.05.

3Kk K ok Kk ok K ok K ok kK ok K ok K ok kK ok ok ok ok K ok ok K ok ok K ok Kk ok K ok K ok ok K ok Kk ok K ok kK ok ok kK ok kK

;Clock is 800kHz
;Configuration Word: WDT off, power-up timer on,

;

;

;specify SFRs

pcl
status
porta
trisa
portb
trisb

equ
equ
equ
equ
equ
equ

pointer equ 10
delcntrl equ
delcntr2 equ

;

org

;Initialise

start

;

bsf
movlw
movwf
movlw
movwf
bcf

11
12

00

code protect off, RC oscillator

status, 5 ;select memory bank 1

B!
tr
00
tr

00011000
isa ;port A according to above pattern

isb ;all port B bits output

status, 5 ;select bank 0

;The “main” program starts here

loop

7

movlw
movwf
movwf
mov £
call
movwf
call
incf
btfsc
clrf
goto

00 ;clear all bits in port A

porta

pointer ;also clear pointer

pointer, 0 ;move pointer to W register

table

portb ;move W register, updated from table SR,
delay

pointer,1

pointer, 3 ;test if pointer has incremented to 8
pointer ;if it has, clear pointer to start over
loop

KKKk kK K ok Sk ok kK K ok Sk ok kK K ok ok ok K K o ok ok kK K ok ok ok K K ok ok ok kK K ok ok ok kK K ok ok ok K K ok ok kK K ko

;Subroutines

ckkkkkhkkhkkhkkhkhkhkhhkhhkhhkhkhkkhkhkkhkkhkkhkkhkkhkkhkkhkkhkkkkkkkkkkkkkkkkkkk*
7

;Introduces delay of 500ms approx, for 800kHz clock

(delay subroutine omitted)

;Holds Lookup Table
pcl

table

addwf
retlw
retlw
retlw
retlw
retlw
retlw
retlw
retlw

end

23
3f
47
7f

0a2

1f
03
67

Program Example 5.8: Using a look-up table

to port B
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5.7.2 Example program with look-up table

Program Example 5.8 demonstrates the use of a look-up table, applied to the ping-pong
hardware. It takes 8-bit values from a table and transfers them to the ping-pong LEDs with
a delay between each data transfer. The overall effect is a display of randomly flashing LEDs.
The opening sections are very similar to other programs written for the ping-pong hardware,
although now we need to specify the address for pcl; see Figure 2.5. Also specified is a RAM
location, called pointer, whose address is chosen to lie within the available range of OC to 4F
(also Figure 2.5).

The core of the program starts at the label loop. Just as in Figure 5.9, the value of
pointer is moved to the W register and a subroutine called table is called. Upon return
from the subroutine, the value held in the W register is transferred to Port B. This lights
a certain pattern of LEDs. The delay subroutine which follows is taken from Program
Example 5.6. The value of pointer is then incremented and tested to see whether it has
reached its maximum value. If so, it is reset to zero before continuing. The program
loops continuously.

Programming Exercise 5.10

People often find the concept of the PIC look-up table quite difficult to understand. It is
therefore a particularly good idea to simulate an example. Create a project called
Flashing LEDs 3, copy the source code of Program Example 5.8 from the book’s com-
panion website and include it in the project. Then simulate. Open a Watch window with
PCL, PORTB, WREG and pointer as observed variables. Step through the program and
see carefully how the value of the W register changes as the subroutine is entered and
left. Use ‘step over’ to avoid getting stuck in the delay subroutine. Ensure that you un-
derstand all stages of the program and the new instructions that have been used.

This is an entertaining program to download to the ping-pong hardware. Try changing
ouput patterns and the delay time.

5.7.3 Resetting the look-up table pointer with an AND instruction

As a further example of logical instructions, let’s look at an alternative way of resetting the
pointer in Program Example 5.8. Remember, every time the pointer increments to value 8
(0000 1000) it needs to be reset to 0. Instead of doing this, why not just suppress the higher five
bits of the word, which are of no use in this application?

The alternative, using logical instruction andlw, is shown in Program Example 5.9. Instead
of testing the value of pointer every time it is incremented, it is now ‘ANDed’ with the
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number 7, or 0000 0111g. Now when it increments to 0000 1000g, bit 3 (which has been set
to 1) is ANDed to 0, and the value of pointer returns to zero.

loop movE pointer, 0 ;move pointer to W register

call table

movwf portb ;move W register, updated from table SR, to port B
call delay

incf pointer, O ;increment pointer, place result in W reg

andlw 07

movwf pointer

goto loop

Program Example 5.9: Using an AND instruction to reset the pointer

5.8 Taming Assembler complexity

You are now beginning to see that even a simple Assembler program can become complex. We
need every means possible of keeping the program short and understandable. A few options
are now described.

5.8.1 Include Files

The Assembler directive #include allows any file to be embedded within a program, thereby
saving the trouble and space of pasting in large program sections which already exist else-
where. A file so included is called an ‘Include File’. Initially the most useful way to use this is
to replace all the microcontroller-specific memory definitions that occur at the start of a pro-
gram. Like other Assemblers, MPLAB contains Include Files for each microcontroller,
containing equ statements for all SFRs and their bits.

Use of an Include File is useful for a small microcontroller like the 16F84A, where the file is
several pages long. It becomes almost essential for larger processors, which have a huge array
of SFRs and hence very long Include Files. Once an Include File is used, it is of course es-
sential to ensure that the microcontroller-specific labels that are referenced in the program are
identical to the ones in the Include File. The advantage of an Include File, even for a very small
application, is illustrated in Program Example 5.10.

;specify SFRs

timer equ 01
status equ 03
porta equ 05 #include pl6f84A.inc
trisa equ 05
portb equ 06
trisb equ 06
intcon equ 0B

Program Example 5.10: Using Include Files
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5.8.2 Macros

We are finding in every program we see that program development for a RISC processor is

laborious, due to the limited function of each individual instruction. A CISC instruction set,
with its somewhat more powerful instructions, offers some modest advantage, but not much. Is
there a way we can get around the minimalist nature of the instruction set, while remaining in
the Assembler environment?

One answer to this problem is the use of ‘macros’. A macro is a grouping of instructions,
defined by the programmer and given a name. Once defined, the macro can be used in the
program at any time. In some ways a macro offers the convenience of a subroutine, but it is
used differently. When the source code is assembled, the macro is expanded out into the
original instructions that made it up. Therefore using macros is a form of shorthand in pro-
gramming, rather than a way of structuring the program.

Program Example 5.11 shows three macros inserted at the start of the ping-pong program
(Appendix 2). The macro itself is contained within the directives macro and endm.
‘Arguments’ are defined for the macro, which are data values that the macro can apply. The
macro movlf moves a data constant into a memory location. It applies two arguments, const
and address. The macros bfbset (branch if file bit set) and bfbclr (branch if file bit clear) are
similarly defined. All three macros are then applied within the first few lines of program,
each time saving one line of code. Thus the eight original lines of code in loop wait are
reduced to four.

;now ready for action
;macro to move a literal value to a file
movlf macro const,address

movlw const

movwf address

endm
;macro to branch if a specified bit is set
bfbset macro file,bit, target

btfsc file,bit

goto target

endm
;macro to branch if a specified bit is clear
bfbclr macro file,bit, target

btfss file,bit

goto target

endm
wait movlf 04,porta ;at rest, "out of play"
movlf 00,portb ;all play leds off

;both paddles must initially be clear before play allowed to commence
bfbclr porta,4,wait ;go to wait if right paddle pressed
bfbset porta,3,wait ;go to wait if left paddle pressed

7

Program Example 5.11: Applying macros to the ping-pong program
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Programming Exercise 5.11

Open a project for the ping-pong program, taking the source code from the book’s
companion website. Insert the code of Program Example 5.11 into the program, re-
moving the lines of code it replaces. Assemble the code and open the list file. Notice how
the original macro definition occupies no memory space and observe how the macro is
expanded out into its original form whenever it is invoked, thus replicating the original
ping-pong program. Continue through the program, applying these two macros wher-
ever you can. How many times can you do this and how many lines of code do you save?
Are there other macros that could usefully be defined?

5.8.3 MPLAB special instructions

Microchip further eases the problem of the limited RISC instruction set by defining a set of
‘special instructions’. These are recognised by the Assembler and expanded out to the

equivalent instructions shown. Examples are given in Table 5.1, while a full listing appears in
Appendix B.11 of Ref. 4.1. Most are operations using or manipulating the Z or C bits in the
Status register. Some, like be or bne, offer no saving in lines of code, but improve the clarity of
programming. Others, like addcf, create new and useful functions not originally available in
the instruction set, which are very similar to CISC instructions.

5.8.4 Using the LIST directive

Section 4.5.3 described how microcontroller choice can be done through Configure >
Select Device in MPLAB. Another way of doing this is by use of the LIST directive,

TABLE 5.1 Example MPASM ‘Special’ Instructions

Mnemonic Description Equivalent Status flags affected
addcf f,d Add Digit Carry to File btfsc 3,1 Zz
incf f,d
bc k Branch on Carry btfsc 3,0
goto k
bnc k Branch on No Carry btfss 3,0
goto k
clrc Clear Carry bef 3,0
movfw f Move File to W movf f,0
subcf f,d Subtract Carry from File btfsc 3,0
decf f,d
tstf Test File movf f,1 Zz
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seen in Table 4.1. When the List directive is used with the ‘p’ option, for example in the
line

list p=16F84A

it has a similar effect to the device selection just described. Use of the directive does not,
however, override the selection made in MPLAB, which remains the one applied. Hence this
directive is of limited use when working only within MPLAB. It is commonly seen, however,
and is a requirement when certain other Assembler environments are used, it is therefore worth
knowing about.

5.9 The ping-pong program

It is useful now to look at the full ping-pong program, as seen in Appendix 2. It is never simple
looking at Assembler code written by someone else (in fact it’s often difficult looking at your
own Assembler code!), so you should not feel worried if initially it appears difficult.

5.9.1 A Structure for the ping-pong program

Let us first of all try to get a feel for the overall structure. For this program a state diagram
gives a clear overall representation, which would be difficult to achieve with a flow diagram.
This is seen in Figure 5.10. The program starts in the ‘Initialise’ state. When this has com-
pleted it immediately enters a ‘Wait’ state, where it stays until play commences. If the left
player presses a paddle then a ‘left-to-right’ state is entered. In this the ‘ball’ begins at the left-
most position and starts moving towards the right. Exit from the state occurs either if there is
a rule violation (for which definitions are given) or if there is a successful return hit when the
ball has reached the right-most position. With no rule violation play continues, with the state
alternating between ‘left-to-right’ and ‘right-to-left’. When either player makes a mistake it is
classified as a rule violation and the game enters a ‘Score’ state. It leaves this when scoring is
complete, and returns to the ‘Wait’ state.

Having grasped the ping-pong state diagram, try to find each state in the Assembler listing. Three of
the five states, Initialise, Wait and Score, should by now be easy to follow. The two states where
play is actually in progress, left-to-right and right-to-left, are a little more difficult to grasp. Each is
a mirror image of the other, so when one is understood, the other immediately follows.

While the program overview is best represented as a state diagram, the actual left-to-right/right-
to-left states are essentially looping structures and are most easily represented as a flow diagram
(Figure 5.11). Here we are confronted, perhaps for the first time, with the detailed complexity
that such a program requires, even in a product that appears so simple. There are certainly
anumber of requirements to be met within the state. The ‘ball’ is to ‘move’ by lighting a series of
LEDs, each to be illuminated for a set period. The state of the paddles is to be continuously
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Start!
Initialise
Y on
completion
right paddle
left paddle pressed
pressed

successful successful
return hit return hit

<

left-to-right right-to-left

A

on

completion rule

violation

rule
violation

Rule violations Scoring
1. Attempting to hit the ball when You score when your opponent
it is not at your end violates a rule
2. Not hitting ball when it is at Successful return hit
your end Hitting the ball when it is at
your end
Note: Ball is at 'your end' when LED nearest you is lit.

Figure 5.10: The ping-pong program visualised as a state diagram

checked; at certain times a paddle press is a legal action, at others it represents a rule violation. If
timing were to be achieved simply by entering a timing loop, the function of input checking
could not be carried out. Hence each LED illumination duration is made up of a certain number
of loop iterations — within each the inputs are tested, followed by a short delay.

5.9.2 Exploring the ping-pong program code

As an aid to further understanding, certain sections of the ping-pong code are now described.

Opening section and memory allocation

In the opening comments the program gives detail on hardware allocation. This is followed
by a section on memory allocation. Here names are given to memory locations in the
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rto | | Define ball start position |

A 4

rtl_0

| Reset loop counter |

Y

| Output new ball position |

rtl_1 > y

Yes
Ball at start?

\ 4

Any rule
l 2 violation?
- Yes
Ball at end? »
N Any rule
° violation?
A ) \
(here if ball not at
rtl_3 beginning or end)
Any rule st
violation? v \4
No P Change State
< (to‘l_to_r’)

rtlend
Delay

| Decrement loop counter |

Change State
(to ‘Score’)

No

Loop counter

Derive new ball position

Yes

Any rule
violation?

\

<
<

Figure 5.11: Flow diagram of left-to-right/right-to-left states
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general-purpose RAM area. The names used, delentrl etc., are chosen by the programmer
and are placed as labels, i.e. starting fully left on the program line. The equ directive is used
and the memory location is chosen from the memory map of Figure 2.5, which shows that
available memory locations range from address OCy to address 4Fy.

The Wait state

Let’s explore this by looking at the opening part of the actual ping-pong program, which
follows the initialisation section.

In the first four lines the program switches on the ‘out of play’ LED and switches off all others.
It then tests the state of both paddles. Remember that, when pressed, the switch input bit goes
to logic 0. If neither is pressed program execution skips forward to waitl. However, if one or
both are pressed, program execution just returns to wait and loops until the button is released.
This is to stop a ‘false start’ to play, which would otherwise occur if a player switched on the
game while a paddle was pressed. As this is the point where play restarts after a score, it also
ensures that the previous round of play is completed before starting again. Note that the loop
execution includes the setting of the LEDs. This is not strictly necessary, but does no harm and
minimises the number of labels used.

Program execution then enters another loop, waitl. Both buttons have been cleared, so the
game can now start proper. Again both paddles are tested. This time, however, if a button is
pressed, instead of looping back play goes forward, to either1 to rorr to I

The main play states

Let us start by looking at the r to 1 section. This opens with the ‘out-of-play’ LED being
switched off and the opening LED position being defined. The larger loop then starts at the
line labelled rtl 0. Here the loop counter loop cntr is loaded with the number led durn.
This number was defined in the opening section of the program and represents the number of
times the inner loop is to be iterated. This inner loop starts at line rtl 1. Much of it is
concerned with checking for rule violation, the interpretation of which depends on the
position of the ball. The general structure is shown in the flow diagram, while the actual rule
interpretation can be determined from looking at the source code. Scoring occurs when any
rule violation is detected. At the end of the loop the 5 ms delay subroutine is called. The
loop counter is decremented. If zero, then a new ball position is set up by rotating the
led posn memory location. A score occurs if this causes the ball to go off the end of

the 8-bit number; this happens if there has not been a successful return hit while the ball was
at the end position.

The Score state is divided into two parts and is simple. It lights the appropriate score LED,
calls a half-second delay and switches off the LED. The state is then left, and execution returns
to the Wait state.
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5.10 Simulating the ping-pong program - tutorial

The ping-pong program is not exactly complex, but it is full of loops and delays and therefore
illustrates the problems of thoroughly testing a program with a simulator. The art lies in using
each feature where needed. Generally, for a program segment that is to be explored in detail,
you will single-step or animate. For the sections of code you want to get through quickly, you
will simply run through, heading for a breakpoint you have already inserted. The following is
a tutorial that guides you through the simulation of this program.

Ensure that you have created and built a project which contains a copy of the ping-pong
program. We will aim to set up the simulation environment indicated in Figure 5.12.

Setting up input stimulus

The ping-pong program has two digital inputs, the two player paddles, which need to be
simulated. Go to Debugger > Stimulus > New Workbook, and ensure the Asynch page is
selected in the window which opens. Under Pin select RA3, the left paddle. Note that when
either switch is pressed, the line it controls is set to logic 0; therefore under Action select Pulse
Low. Set the duration to 50 ms, which is representative of a fast switch push. Repeat this for
RA4. Can you work out from the program what is the maximum theoretical duration of

a player pressing a button? Create two more lines, for RA3 and RA4 again, this time with Set
High as the action for each.

W C:\MPLAB Projects\Chap 5\Pingpong.asm

prr v

iset up initial led patterns

State

hddress |  Symbol Newe | Binary | |~
0z PCL 00100111

wait moviw 04
movwf porta  ;switch on "out of play’ led

moviw 00
movwf  porth

os PORTA 00011000
06 PORTB 00000010
10 delcntrl 00000000 E |
12 led_pos=n 00000001 I.,

Watch1 | Watch 2| Watch 3 Watch 4

sall play leds off

icheck that both paddles are clear before allowing play to commence
btiss porta,4 ;right paddle pressed?
goto  wait iyes, so wait
btiss porta,3 ;lefc paddle pressed?

gote  wait  iyes, so wait

inow ready for action, now wait until paddle pressed
@ waicl btfss porta,4 ;right paddle pressed?
gote  r _to_l ;yes, so start play

3
4
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0

L
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9 btfss porta, ;left paddle pressed? Fe |Pin/SFR | Action Widh |Unis | Comments / Message
) gote 1 tor yes, so start play
L goto  waitl
= g

'3
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6

x

'8
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o

L

2

i3

4

s

6

7

3

<

T Right-to-Left” State™™

splay has started

r_to_l moviw 00 :switch off “out of play*
movwt  porta
movlw B0  ;define ball start posn.
movwf  led_posn

;100p to here every time led is to change
@) 1 0 moviw lea_aum

movwf  loop_cntr  ;preset length of led illumination
movf  led_posn,w ;oucpuc new ball posn

Inetruction Cycles 0| 456433
Time [uSecs]

Processor Frequency  (KHz)

rmowwf  porth
iloop to here n times for ewery led, where n = led_durn
iCheck for rule viclations. Special conditions apply if
sball is at starc or end.

rtl 1l btfss led posn,? :is ball av starc (ie posn 7)7
goto  rtl 2 ;no, so move on

Figure 5.12: Simulating the ping-pong program
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Setting up the Watch window

Click View > Watch to set up a Watch window. A useful selection of registers for display
is PCL (to track where you are in the program), PORTA and PORTB using the Add SFR
button, and led posn and delentrl using the Add Symbol button. Familiarise yourself
with the digital representation in the Watch window of the two paddles, and the various
LEDs, by looking at the circuit diagram of Figure A2.1.

Single-stepping

Reset the program counter on the simulator toolbar and then try single-stepping the ping-pong
program. You will be able to see registers changing under program instruction, with the
changes highlighted in red.

If one or both of the user paddles are set low (i.e. ‘pressed’), then the simulation will get
stuck in the first wait loop. (You can see the logic state by inspecting the Port A display in
the Watch window.) Set these lines high by pressing the Fire buttons on the Stimulus
window. You should see the change reflected in the Watch Window.

Now you should be able to single-step on to the waitl loop. Having looped round here once or
twice, fire the RA3 pulse. You should now exit the loop and move ontol to r. See the Port B
value change to 1 as the ball position is set up. You can continue stepping from here, and either
step over, or enter, the delay5 subroutine. Once in, you can step out of it at any time. Clearly it
would be tedious to single-step all the way through this subroutine. Even if we step over it, the
loop repetitions become endless and the limitations of single-stepping are revealed.

Run

If you select Run there does not seem to be much to watch as the 